Manual
# Stone Cut 2 Manual

## Table of Contents

- Restriction of Warranty .............................................................................................................1
- Trademark ..................................................................................................................................1
- Copyright ....................................................................................................................................2
- Stone Cut 2 uses the OpenCV ...............................................................................................3
- Stone Cut 2 uses NLog ..............................................................................................................4
- About This Manual ...................................................................................................................5
- Typographical Orientation Guides ..........................................................................................7
- 1 Preface ....................................................................................................................................7
- 2 Quickstart and Installation .....................................................................................................7
  - 2.1 Quickstart ........................................................................................................................11
    - 2.1.1 How to Install Stone Cut 2? ....................................................................................13
    - 2.1.2 Enter License Data (without Dongle) ....................................................................14
    - 2.1.3 Enter License Data (with Dongle) ........................................................................14
  - 2.2 The Cut Marks Toolbar ..................................................................................................14
    - 2.2.1 The Cut Marks Workflow .......................................................................................15
    - 2.2.2 The Cut Marks Toolbar in CorelDRAW X3-X8 and 2017-2019 ............................19
    - 2.2.3 The File Menu Entries in Illustrator CS3-CS6 and CC .........................................19
  - 2.3 Autoexport - Scripts .......................................................................................................20
    - 2.3.1 Corun Installer .........................................................................................................21
    - 2.3.2 Insert Stone Cut 2 Icon in CorelDRAW Toolbar ....................................................23
    - 2.3.3 Stone Cut 2 Script in Adobe Illustrator 8-10, CS-CS6, CC .................................23
  - 2.4 Selection of The Device Driver .......................................................................................23
- 3 How to work with Stone Cut 2 .............................................................................................23
  - 3.1 Desktop and Working Sheet .........................................................................................23
    - 3.1.1 I. Desktop ...............................................................................................................26
    - 3.1.2 II. Working Area .....................................................................................................27
  - 3.2 Job Preparation ..............................................................................................................30
    - 3.2.1 Import ....................................................................................................................31
  - 3.3 The Stone Cut 2 Layer dialog .........................................................................................31
  - 3.4 Tool Assignment Via Layer ...........................................................................................34
    - 3.4.1 Define Layer Assignment ......................................................................................35
    - 3.4.2 How the Tool Sequence Is Determined? ...............................................................35
  - 3.5 The Output ......................................................................................................................37
    - 3.5.1 Device Setting - Interface Setup (Local Device) ....................................................38
    - 3.5.2 Device Setting (Network Device) ..........................................................................46
    - 3.5.3 Start Output from the Stone Cut 2 Working Surface ..........................................46
  - 3.6 Generation of Rhinesstone Pattern Templates ...............................................................48
    - 3.6.1 Rhinestone Pattern Templates ...............................................................................50
  - 3.7 Export .............................................................................................................................51
    - 3.7.1 PDF Export ............................................................................................................51
  - 3.8 Excursion: Contour vs Outline vs Contour Line ............................................................52
    - 3.8.1 1. Contour ..............................................................................................................53
    - 3.8.2 2. Outline ..............................................................................................................55
    - 3.8.3 3. Contour Line ......................................................................................................55
# Table of Contents

## How to work with Stone Cut 2
3.9 Cutting - Milling - Creasing - Drawing ................................................................. 63
3.9.1 The Output Preview ....................................................................................... 63

## 3.10 Printing............................................................................................................. 71
3.10.1 Without RIP Software .................................................................................... 73
3.10.2 With Pjannto RIP software ............................................................................ 73

## Reference Part ....................................................................................................... 73
4.1 The File Menu......................................................................................................... 73
4.1.1 The New… Command.................................................................................... 73
4.1.2 The New from Template Command............................................................... 73
4.1.3 The Last Version Command........................................................................... 73
4.1.4 The Open… Command................................................................................... 74
4.1.5 The Save Command ...................................................................................... 74
4.1.6 The Save as… Command................................................................................. 74
4.1.7 The Save all Command................................................................................. 74
4.1.8 The Send by Email… Command..................................................................... 74
4.1.9 The Import… Command................................................................................. 74
4.1.10 The Export… Command.............................................................................. 74
4.1.11 The Print… Command.................................................................................. 75
4.1.12 The Output… Command............................................................................. 75
4.1.13 The Scan... Command................................................................................ 75
4.1.14 The Choose Scanner… Command ............................................................... 75
4.1.15 The Quit Command .................................................................................... 76
4.1.16 The Job History........................................................................................... 76

## The Edit Menu......................................................................................................... 76
4.2.1 The Undo Command....................................................................................... 76
4.2.2 The Undo Stack… Command.......................................................................... 76
4.2.3 The Redo Command....................................................................................... 76
4.2.4 The Redo Stack… Command.......................................................................... 77
4.2.5 The Cut Command......................................................................................... 77
4.2.6 The Copy Command....................................................................................... 77
4.2.7 The Paste Command...................................................................................... 77
4.2.8 The Paste Special... Command..................................................................... 77
4.2.9 The Select All Command.............................................................................. 77
4.2.10 The Reverse Selection Command.................................................................. 77
4.2.11 The Job Info… Command............................................................................ 78
4.2.12 The Color Layer… Command...................................................................... 79
4.2.13 The Multi Copy… Command....................................................................... 79

## The Design Menu.................................................................................................... 79
4.3.1 The Rotate Axis Command............................................................................ 79
4.3.2 The Rotate Axis With Page Command............................................................ 79
4.3.3 The Horizontal Mirror Command................................................................. 79
4.3.4 The Vertical Mirror Command...................................................................... 79
4.3.5 The Delete Command................................................................................... 79
4.3.6 The Mirror on the X Axis Command............................................................. 79
4.3.7 The Mirror on the Y Axis Command............................................................. 80
4.3.8 The Duplicate Command............................................................................. 80
4.3.9 The Clone Command................................................................................... 80
# Table of Contents

## 4 Reference Part

4.3.10 The Group Command................................................................. 80
4.3.11 The Break Group Command................................................................. 81
4.3.12 The Combine Command................................................................. 81
4.3.13 The Break Combination Command.................................................. 81
4.3.14 The Align... Command................................................................. 81
4.3.15 The Sort With Simulation... Command............................................. 81
4.3.16 The Close Contour Command......................................................... 82
4.3.17 The Open Contour Command.......................................................... 82
4.3.18 The Round Corners... Command...................................................... 82
4.3.19 The Reduce Nodes Command......................................................... 82
4.3.20 The Add to Clipart Group Command.............................................. 83
4.3.21 The Weeding Border Command...................................................... 83

## 4.4 The View Menu

4.4.1 The Zoom In Command................................................................. 83
4.4.2 The Zoom Out Command................................................................. 83
4.4.3 The Full Page Command................................................................. 83
4.4.4 The Show All Command................................................................. 83
4.4.5 The Show Selected Objects Command........................................... 84
4.4.6 The To Front Command................................................................. 84
4.4.7 The To Back Command................................................................. 84
4.4.8 The Forward One Command........................................................... 84
4.4.9 The Back One Command............................................................... 84
4.4.10 The Reverse Order Command......................................................... 84
4.4.11 The Change Order Command......................................................... 84
4.4.12 The Contour View Command......................................................... 85
4.4.13 The Enhanced View Command....................................................... 85
4.4.14 The Always on top Command....................................................... 86
4.4.15 The Refresh Screen Command....................................................... 86

## 4.5 The Tools Menu

4.5.1 The Contour Line... Function......................................................... 86
4.5.2 The PhotoCut... Function............................................................... 87
4.5.3 The Outline... Function................................................................. 88
4.5.4 The Welding Command................................................................. 88

## 4.6 The Plug-Ins Menu

4.6.1 The Object Replacer Command....................................................... 89

## 4.7 The Settings Menu

4.7.1 The Standard Settings Menu............................................................ 108
4.7.2 The Color Palette Command............................................................ 109
4.7.3 The Working Area... Command....................................................... 110
4.7.4 The Rulers... Function................................................................. 110
4.7.5 The Unit of Measurement Function................................................... 111
4.7.6 The Grid... Function................................................................. 114
4.7.7 The Origin Function................................................................. 114
4.7.8 The Undo / Redo Command........................................................... 114
4.7.9 The Cross-Hair Command............................................................. 115
4.7.10 The Guidelines... Function........................................................... 115
4.7.11 The Snap Mode Function.............................................................. 115
4.7.12 The Lock Guidelines Command.................................................... 116
Table of Contents

4 Reference Part
4.7.13 The Guidelines Visible Command...............................................................117
4.7.14 The Choose Language… Command..........................................................117
4.8 The Window Menu................................................................................................117
4.8.1 The New Window Command........................................................................117
4.8.2 The Tile Horizontally Command ....................................................................117
4.8.3 The Tile Vertically Command ........................................................................117
4.8.4 The Cascade Command...............................................................................117
4.8.5 The Close Command....................................................................................117
4.8.6 The Close All Command...............................................................................117
4.8.7 The Standard Command.............................................................................118
4.8.8 The Sidebar Command.................................................................................118
4.8.9 The Setup Command....................................................................................118
4.8.10 The Common Tools Command...................................................................118
4.8.11 The Object Tools Command.......................................................................118
4.8.12 The Object Parameters Command.............................................................118
4.8.13 The Status Bar Object Info Command........................................................118
4.8.14 The Status Bar Element Info Command.....................................................118
4.8.15 The Active Windows List.............................................................................119
4.8.16 The Further Windows… Command............................................................119
4.9 The Help Menu......................................................................................................119
4.9.1 The About … Command...............................................................................119
4.9.2 The Help… Command..................................................................................119
4.9.3 The Object Info… Command........................................................................120
4.9.4 The Install Autoimport Plug-Ins… Command................................................120
4.10 Context Menu Left Mouse Button........................................................................122
4.10.1 Context Menu Ruler....................................................................................122
4.11 Context Menus Right Mouse Button....................................................................125
4.11.1 Reference List of All Context Menu Commands.........................................126
4.11.2 Context Menu on Empty Working Area.......................................................133
4.11.3 Context Menus Node Editing......................................................................133

5 Reference Part Output Preview................................................................................133
5.1 The Output Menu.................................................................................................133
5.1.1 The Output Command..................................................................................133
5.2 The Options Menu..................................................................................................133
5.2.1 The Save As… Command.............................................................................133
5.2.2 The Rotate Axis Command...........................................................................133
5.2.3 The Horizontal Mirror Command...................................................................133
5.2.4 The Vertical Mirror Command......................................................................134
5.2.5 The Optimization… Command......................................................................134
5.2.6 The Sort With Simulation… Command.........................................................134
5.2.7 The Recalculate Command..........................................................................134
5.2.8 The Initial View Command............................................................................134
5.2.9 The Horizontal Weeding Lines Command....................................................135
5.2.10 The Vertical Weeding Lines Command.......................................................135
5.2.11 The Test Drive Command............................................................................135
5.3 The View Menu.....................................................................................................135
5.3.1 The Material Width Command....................................................................135
Table of Contents

5 Reference Part Output Preview
5.3.2 The All Objects Command ................................................................. 135
5.3.3 The Selected Objects Command ...................................................... 136
5.3.4 The Total Area Command ................................................................. 136
5.4 The Window Menu .................................................................................. 136
5.4.1 The New Window Command ............................................................ 136
5.4.2 The Tile Horizontally Command ..................................................... 136
5.4.3 The Tile Vertically Command ........................................................... 136
5.4.4 The Cascade Command ................................................................... 136
5.4.5 The Close Command ...................................................................... 136
5.4.6 The Close All Command .................................................................. 136
5.4.7 The Common Tools Command ......................................................... 137
5.4.8 The Object Parameters Command .................................................. 137
5.4.9 The Status Bar Object Info Command ............................................ 137
5.4.10 The Status Bar Element Info Command ......................................... 137
5.4.11 The Active Windows List ............................................................... 137
5.4.12 The Further Windows... Command ................................................ 137
5.5 The Help Menu ..................................................................................... 137
5.5.1 The About ... Command ................................................................ 137
5.5.2 The Help... Command ................................................................... 138
5.5.3 The Install Autoimport Plug-Ins... Command .................................. 138
5.6 Context Menu of The Right Mouse Button ......................................... 139
5.6.1 Context Menu Output Preview ....................................................... 139

6 Toolbars..................................................................................................... 139
6.1 The Standard Toolbar .......................................................................... 140
6.2 The Setup Toolbar ................................................................................ 144
6.3 The Node Toolbar ................................................................................ 146
6.3.1 Direct Input of Coordinates of Node Positions .............................. 147
6.4 The Object Tools Toolbar .................................................................. 147
6.5 The Object Parameter Toolbar ............................................................ 149
6.5.1 The Multi Copy Command ............................................................. 149
6.6 The Status Line Object Info ................................................................. 149
6.7 The Status Line Element Info ............................................................. 151
6.8 The Preview Tools Toolbar ................................................................. 153
6.9 The Preview Object Parameters Toolbar .......................................... 153

7 Tools......................................................................................................... 154
7.1 The Desktop ......................................................................................... 155
7.1.1 Cursor forms on the working area and their meaning .................... 158
7.2 The Outline Function ........................................................................ 160
7.3 The Undo Redo Stack ...................................................................... 161
7.4 The Alignment Function.................................................................... 161
7.5 The Sort with Simulation... Tool ........................................................ 163
7.5.1 Zone A1 - Object Position, Color Bar, ......................................... 163
7.5.2 Zone A2 - The Simulator .............................................................. 165
7.5.3 Zone A3 ....................................................................................... 168
7.5.4 Zone A4 - Sorting, Settings, ........................................................ 170
7.6 The Welding Tool................................................................................ 171
# Table of Contents

## 7 Tools
7.6.1 Mask............................................................................................................. 172  
7.6.2 Seams........................................................................................................... 175  
7.7 The Contour (Line) Function............................................................................. 178  
7.8 The Job Info...................................................................................................... 178  
7.9 The Plot Manager.............................................................................................. 178  
7.9.1 Creation And Modification of Device Configurations................................. 178  
7.9.2 Monitoring the Output Processes of the Jobs................................................. 178  
7.9.3 Output of Data to Local Ports......................................................................... 178  
7.9.4 Administration of Hotfolders......................................................................... 179  
7.9.5 Plot Server Function..................................................................................... 183  
7.9.6 Devices Folder.............................................................................................. 187  
7.9.7 Settings of the Plot Manager......................................................................... 187  
7.10 The PhotoCUT Function................................................................................... 195  
7.10.1 The PhotoCUT Dialog................................................................................. 195  

## 8 The Sidebar.................................................................................................................. 195  
8.1 Term Definition Sidebar..................................................................................... 197  
8.2 The Anchorage Control....................................................................................... 197  
8.3 The Layer Tab..................................................................................................... 197  
8.3.1 A) The Layer Area......................................................................................... 198  
8.3.2 B) The Layer Options.................................................................................... 200  
8.3.3 C) The Palettes Options................................................................................ 202  
8.3.4 Status Indicator Layer................................................................................... 203  
8.3.5 I. Layer Settings Output Setup....................................................................... 205  
8.3.6 II. Layer Settings Color Setup....................................................................... 206  
8.3.7 Hotkeys in the Layer Processing.................................................................... 206  
8.4 The Objects Tab.................................................................................................. 210  
8.4.1 The Object Manager..................................................................................... 211  
8.4.2 The Object Types Tab................................................................................... 212  
8.4.3 The Object Names Tab................................................................................... 215  
8.4.4 The Attributes Tab....................................................................................... 215  
8.5 The Cliparts Tab................................................................................................ 222  
8.5.1 Clipart Management...................................................................................... 224  
8.5.2 The Context Menus....................................................................................... 224  
8.6 The Macros Tab.................................................................................................. 227  
8.6.1 The Toolbar Area.......................................................................................... 229  
8.6.2 The Macro Player.......................................................................................... 239  
8.6.3 The Stone Cut 2 Macros............................................................................... 239  

## 9 Tips & Tricks - Trouble Shooting............................................................................... 239  
9.1 Code is not accepted with Windows 7, 8, 10 or Vista (No Dongle)....................... 239  
9.2 Buffer Overflow Serial Port............................................................................... 240  
9.3 Output Size Mimaki............................................................................................ 240  
9.4 Output Size Graphtec....................................................................................... 242  
9.5 Calibration of the Output Size.......................................................................... 243  
9.6 Computer without serial COM port.................................................................... 243  
9.7 Cutter Does Not Respond!.................................................................................. 243  
9.8 Buffer Overflow................................................................................................. 244
# Table of Contents

## 9 Tips & Tricks - Trouble Shooting

- 9.9 Data Import From Apple Computers ................................................................. 245
- 9.10 Typical Sources of Errors When Cutting .......................................................... 245
- 9.11 Plotter Via USB Is Not Working! ................................................................. 246
- 9.12 Summa Plotter Does Not Read Out! .............................................................. 246
- 9.13 The Values for Cutting Pressure And Speed Are Not Saved ......................... 247
- 9.14 Error Message While Output into File ............................................................. 247

## Annex

- A Driver List ............................................................................................................. 254
- B Dictionary of Technical Terms ............................................................................ 263
- C Glossary ............................................................................................................... 269

## Index ..................................................................................................................... 269
Copyright

Copyright © 2019 by Euro-Systems S.à.r.l. - All rights reserved.

Any duplication of this manual as well as the computer software Stone Cut 2 for Windows will be prosecuted.

The rights for the documentation to Stone Cut 2 lie with Euro-Systems S.à r.l., Villa Machera, 1 Rue Kummert, L-6743 Grevenmacher, Luxembourg

Typeset and composition: Peter Bettendorf
Text: Peter Bettendorf, Frank Thömmes

The legitimate acquisition via data carrier or download allows the use of the program, analogously to the use of a book. According to the impossibility that a book is read at the same time in different places by several persons the software program Stone Cut 2 may not be used at the same time from different persons in different places and on different devices. Copies may be created only for the purpose of data backup.

Stone Cut 2 uses the OpenCV

(Open Source Computer Vision Library)

IMPORTANT: READ BEFORE DOWNLOADING, COPYING, INSTALLING OR USING.

By downloading, copying, installing or using the software you agree to this license. If you do not agree to this license, do not download, install, copy or use the software.

Intel License Agreement

For Open Source Computer Vision Library

Copyright (C) 2000, 2001, Intel Corporation, all rights reserved.

Third party copyrights are property of their respective owners. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Intel Corporation may not be used to endorse or promote products derived from this software without specific prior written permission.
Stone Cut 2 uses the OpenCV

This software is provided by the copyright holders and contributors ‘as is’ and any express or implied warranties, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose are disclaimed.

In no event shall the Intel Corporation or contributors be liable for any direct, indirect, incidental, special, exemplary, or consequential damages (including, but not limited to, procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of the use of this software, even if advised of the possibility of such damage.

Stone Cut 2 uses NLog

NLog is a free logging platform for .NET, Silverlight and Windows Phone with rich log routing and management capabilities. It makes it easy to produce and manage high-quality logs for your application regardless of its size or complexity.

Copyright (c) 2004-2011 Jaroslaw Kowalski

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Jaroslaw Kowalski nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
About This Manual

With this manual you receive Stone Cut 2. This manual is divided in 8 chapters.

In chapter „Quickstart and Installation“ the installation of Stone Cut 2 on your Windows computer will be explained. Please follow the installation instruction carefully as the correct installation is the basic for the smooth usage of Stone Cut 2.

The chapter „How to work with Stone Cut 2?“ is an introduction in handling, tools and functions. The functional principle will be concretized by means of practical examples.

In chapter „Reference Part“ all menus and their menu items in their chronological order are explained. This chapter is thought of as reference book and should be used in case of doubts about the exact functioning of a command.

In chapter „Reference Part Output Preview“ all menus and their menu items in the display preview in their chronological order are explained. As chapter "Reference Part" it is thought of as reference book and should be used in case of doubts about the exact functioning of a command.

In the next chapter all „Toolbars“ are described. Toolbars contain important tools that are placed in a freely movable toolbar.

In the following chapter the functioning of the „Tools“ is described in detail.

In the chapter „The Sidebar“ the side toolbar with tabs (similar to the so-called dockers in CorelDRAW) is described in detail in its functioning. Summarized are layer editing, cliparts, object manager and file management. The selection of the various functional areas is implemented via so-called tabs.

In chapter „Tips and Tricks - Trouble Shooting“ we have explained a selection of daily problems from our hotline and support experience and give you information for dealing with technical problems.
Typographical Orientation Guides

<table>
<thead>
<tr>
<th>Display</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Headlines</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td><em>Indications, accentuations</em></td>
</tr>
<tr>
<td><strong>Bold, italic</strong></td>
<td>Menus, fields, options e.g. <em>new</em>-command</td>
</tr>
<tr>
<td><strong>CAPITAL LETTERS</strong></td>
<td>Name of keys on the keyboard e.g. INS, SRTG, ...</td>
</tr>
<tr>
<td><strong>KEY1+KEY2</strong></td>
<td>The plus (+) between the key names means that the first key must be kept pressed while pressing the second key. Afterwards, let go the two keys.</td>
</tr>
<tr>
<td><strong>KEY1,KEY2</strong></td>
<td>A comma (,) between the key names means that you press the keys one after the other and let them go.</td>
</tr>
<tr>
<td>...</td>
<td>Three dots after menu entries and commands always mean that, when activating, a dialog window will be opened.</td>
</tr>
</tbody>
</table>
1 Preface

Stone Cut 2 serves to the production of cutted Rhinestone templates and thus is a reasonably priced alternative to Rhinestone laying machines. Pattern templates can be: Vector cliparts, but also bitmap submittals, whose contours can be converted into vectors with Stone Cut 2’s contour line function. The necessary daten are loaded via autoimport function from Illustrator or CorelDRAW or alternatively using the program’s included import filters are loaded directly on the working sheet of Stone Cut 2. The macro for the placing of the rhinestones contains all professional tools for generating of hotfix rhinestone pattern templates: for object selection, for generating of clones and collision recognition. The pattern templates are re-usable and are prepared and produces with Stone Cut 2.

The rhinestones can be placed on the vector contour itself or can fill out a contour. Possible fill modes are: Raster, Hatch, or Random. Available object forms for selection are: Circles, squares, and clipboard objects, but as well drill holes as special objects.

The so generated jobs are given out on a suitable vinyl cutting plotter (cutter) which must be loaded with a special foil. The cutted pattern template is filled with rhinestones and the layout is transferred afterwards with a heat transfer press on a garment or heat resistant object. The entire process usually takes no more than 10 minutes to decorate a garment.
1 Preface
2 Quickstart and Installation

2.1 Quickstart

2.1.1 How to Install Stone Cut 2?

2.1.1.1 Step 1: Connection

Cutter control via USB

Install cutter USB drivers, which were delivered by the cutter manufacturer. Please use the instructions given by cutter manual.

Cutter control via COM port (serial)

Make sure, that cutter and serial Windows port are configured identically.

You´ll find this port configuration in the system Control Panel under: System/Hardware/Device Manager/Ports/Communications Port. Select via double click the respective port (e. g. COM1) and activate Port Settings.

Default settings are: Bits per second: 9600 or 19200, Data bits: 8, Parity: None, Stop bits: 1, Flow control: Hardware

Check also Resources: COM 1: I/O Range 03F8 and IRQ 4 and COM 2: I/O Range 02F8 and IRQ 3 respectively

2.1.1.2 Step 2: Installation

Insert the Stone Cut 2 installation CD. With the Autorun function switched on following dialog opens. If the Autorun function is deactivated open the Windows Explorer and start the file install.exe in the main directory of the CD. Select product Stone Cut 2 and start installation.
2.1.1 How to Install Stone Cut 2?

Fig. 2.1-1: Autorun window

Note: Installation process is done again for each selected application.

Fig. 2.1-2: EUROSYSTEMS Software License Agreement

In this dialog the installation folder for Stone Cut 2 is chosen. By default the folder C:\Program Files\Stone Cut\Stone Cut 2 is suggested.
2.1.1 How to Install Stone Cut 2?

If Stone Cut 2 should be installed to another folder, please click *Browse* button and select the desired destination folder.

*Hint: To install additional drivers select custom setup.*
2.1.1 How to Install Stone Cut 2?

Fig. 2.1-4: Selection of setup type

Default program folder in the start menu is EUROSYSTEMS\Stone Cut 2.
2.1.2.1 Use .ecf file: Recommended, if license data was sent via email.

In the eMail with license data you´ll find an attached file with the extension .ecf.

*A double click on this file will license your software automatically!*

2.1.2.2 Manually, if license data is printed on a sticker, which is located in the package (inner left hand side).

On this sticker you´ll find information about program version, serial number, user data and the code itself.

*Important! All license data must be entered exactly how printed!*
2.1.2 Enter License Data (without Dongle)

By clicking "License..." button following dialog is opened.

Fig. 2.1-6: Start window with invalid code

Fig. 2.1-7: Option for first installation of Stone Cut 2
Fig. 2.1-8: These fields have to be filled with license data

### 2.1.3 Enter License Data (with Dongle)

If copy protection is realized using a dongle (frequently in case of upgrades), don’t forget to connect the dongle with a port on your PC.

#### 2.1.3.1 Manually, if license data is printed on a sticker, which is located in the package (inner left hand side).

On this sticker you’ll find information about program version, serial number and the code itself.

*Important! All license data must be entered exactly how printed!*
2.2 The Cut Marks Toolbar

All object functions of the Cut Marks Toolbar act directly on the host program's (CorelDRAW or Illustrator) objects. This extends host program's functionality with these tools so that the whole Print & Cut workflow can be prepared and given out with CorelDRAW or Illustrator. Of course, Stone Cut 2 can be started without a host program. The described tools are also available in the standalone version.

*Important note: The functionality described here is only possible with CorelDRAW X3-X8 & 2017-2019 and Illustrator CS3-CS6 & CC!*

2.2.1 The Cut Marks Workflow

The following graphic illustrates the Print & Cut workflow (Cut Marks Workflow) inside the host program (CorelDRAW or Illustrator).

Starting point of the Cut Marks Workflow is a bitmap, which gets contoured as first step. In the second step multiple copies are generated. In the next step suitable register marks are placed around the copies. This Job must be printed on a suitable printer and is finished with a cutting plotter (cutter) equipped with an optical sensor. The so called registration - Cut Marks recognition - corrects the prints deviations and the job is cutted. The results of this process are exactly cutted copies in any number and size.

2.2.2 The Cut Marks Toolbar in CorelDRAW X3-X8 and 2017-2019

The buttons were so arranged from left to right that the Cut Marks Workflow can be performed perfectly.
2.2.3 The File Menu Entries in Illustrator CS3-CS6 and CC

The menu entries are arranged from top to bottom in a way that the Cut Marks Workflow can be performed perfectly.

2.2.3.1 Buttons of the Cut Marks Toolbar

Important note: The following descriptions are valid also for Illustrator!

1 The *Create Contour* Button

![Create Contour Icon](image)

Fig. 2.2-3: Create Contour Icon

please refer to 7.7: The *Contour (Line)* Function

2 The *Multi Copy* Button

![Multi Copy Icon](image)

Fig. 2.2-4: Multi Copy Icon

please refer to 6.5: The *Object Parameter* Toolbar

3 The *Set Jog Marks* Button

![Set Jog Marks Icon](image)

Fig. 2.2-5: Set Jog Marks Icon

4 The *Cut* Button

![Cut Icon](image)

Fig. 2.2-6: Cut Icon
2.2.3 The File Menu Entries in Illustrator CS3-CS6 and CC

please refer to 3.9: Cutting - Milling - Creasing - Drawing …

5 The Direct Cutting Button

Fig. 2.2-7: Direct cutting Icon

Activating this button ensures that no window appears before the data output. The output data is sent directly to the connected device.

6 The Export Button

Fig. 2.2-8: Export Icon

Activating this button ensures that the selected data is exported into the specified folder (see Settings dialog).

Note: In CorelDRAW, the data are saved in the CMX file format, otherwise in PDF format.

7 The Create Outline Button

Fig. 2.2-9: Create Outline Icon

please refer to 7.2: The Outline Function

8 The Create Outline Layer Button

Fig. 2.2-10: Create Outline Layer Icon

After activating this button the object attribute is changed and a spot color for the selected contour, which was not generated with the Stone Cut 2 button, is assigned.

9 The Welding Button

Fig. 2.2-11: Welding Icon

Activating this button welds the selected objects.
10 The *Settings* Button

Fig. 2.2-12: Settings Icon

A click on the *Settings* Button opens the *Settings* window.

### 2.2.3.2 The *Settings* Dialog

![Settings Window]

**Eurosystems Software Field**

Fig. 2.2-13: 2 Point Icon

A click on the 2 point button enables the selected program and allows changing of *Settings* parameters.

**Jog Marks Field**

Fig. 2.2-14: 2 Point Icon

A click on the 2 point button opens the *Setup - Jog Marks* dialog. It allows the selection of the appropriate cut marks for the plotter, in case your cutter has an optical sensor and its
driver supports this feature.

![Setup - Jog Marks dialog](image)

**Export Field**

Fig. 2.2-15: 2 Point Icon

A click on the 2-point button opens the *Search folder* dialog. It allows the selection of the export folder where the exported file should be saved.

**Name of Layer for Jog Marks Option**

This option enables the assignment of an individual layer name. Then this jog marks layer can be identified at any time and the jog marks can be selected. Preset is *Regmark*.

**Name of Layer for Outline Option**

This option enables the assignment of an individual layer name. Then this outline layer can be identified at any time and the outline(s) can be selected. Preset is *Outline*.

**The Output Parameters… Button**

Activating the *Output Parameters* button opens the cutting dialog and allows you to set individual settings when cutting.

**Show Always Contour and Outline Settings Option**

If this option is enabled then the dialogs which allow the parameter definition are always displayed, when the appropriate button was activated.
During the Cut Process only Transfer 'Regmark' and 'Outline' layer Option

If this option is activated then only the objects are transferred to Stone Cut 2 to which this two layers have been assigned: regardless of the current selection!

Create New File While Cutting Option

If this option is enabled then after pressing the Cut button a new window in Stone Cut 2 is opened and all or all selected objects are copied into the new window.

Open Output Dialog While Cutting Option

If this option is activated then after pressing the Cut button the Output dialog is opened.

2.3 Autoexport - Scripts

Autoexport means that data from external programs (CorelDRAW, CorelDesigner, Illustrator, Freehand, Inkscape, InDesign or AutoCAD) are imported automatically into Stone Cut 2 - quasi at the push of a button. To do this the scripts are either integrated into the external program's menu structure or toolbar.

2.3.1 Corun Installer

With the Corun Installer you can install Stone Cut 2 the plugins. In the Name column all host programs are listed, in which the plug-ins can be implemented. In the Plugin path column is displayed in which the folder the plug-in files are located after installation. In the Eurosystem software list all programs are listed that have a plug-in functionality. Select the appropriate program from the list. Activating the Install button starts the process.

Note: The Corun Installer is required if the host application was installed BEFORE the EUROSYSTEMS program or if plugins must be re-installed.
2.3.1 Corun Installer

![Corun Installer dialog window with detected host programs and path indicators.](image)

Fig. 2.3-1: Corun Installer dialog window with detected host programs and path indicators.

2.3.2 Insert Stone Cut 2 Icon in CorelDRAW Toolbar

2.3.2.1 CorelDRAW X3-X8 and 2017-2019

*Indication: CorelDRAW must be installed with the option “Visual Basic for Application”.*

This option can be installed as follows:
Insert CorelDRAW medium into the drive / start setup / select type of installation „Custom setup“. If already a CorelDRAW-version is installed on your computer, first select „user defined setup“ and then „Custom setup“.

In the dialog that opens now, double click on main applications or one click on the Plus-field. Here, double click on productivity support and activate the option „Visual Basic for Application“. After the installation of Stone Cut 2 you have to link the Stone Cut 2 Script with the toolbar.

- Select the menu Tools / Customization
- Select the option Workspace / Customization / Commands in the left option bar
- Right next to the option bar, click once on File and select Macros and drag Corun... or Cocut... to the toolbar of CorelDRAW.
- Activate the tab Appearance. Here, press the Import-button and select any symbol.
- Select the option Workspace/Customization/Command Bars in the left option bar.
- Change the name of the toolbar „New ToolBar 1” to Stone Cut 2.
- Click on OK.

If you now mark one or several objects and click on the thus created icon, the objects are passed on to Stone Cut 2 and can be plotted.

2.3.3 Stone Cut 2 Script in Adobe Illustrator 8-10, CS-CS6, CC

Stone Cut 2 is in the file menu underneath the menu item export.

How does the transfer of data from Illustrator 8, 9, 10, CS, CS2, CS3, CS4, CS5, CS6, CC to Stone Cut 2 take place?

Start Stone Cut 2 from the file menu. If the objects are marked, only the marked objects are passed on to Stone Cut 2. If also texts are passed on they will automatically be converted to curves.

Indication: If no objects are marked, Stone Cut 2 is not active!

Indication: Special process color fills are not passed on.

2.4 Selection of The Device Driver

Please, select first your output device from the list driver. In the field name of device the identical name for the selected device that is shown in the cutting dialog appears. This name can be changed individually in this field. After the selection of the driver please select - in the area type of connection - the device type with which the device is connected to the computer.

Tip: If the driver you search for is not in the list you can try another driver from the same manufacturer.
2.4 Selection of The Device Driver

Fig. 2.4-1: Dialog for the selection of the device driver
3 How to work with Stone Cut 2

3.1 Desktop and Working Sheet

3.1.1 I. Desktop

The so-called Desktop means the whole visible program window including Toolbars, Working Sheet and Desktop background.

Note: On the background can be placed any desired number of objects. The size of the background is limited only by the resources of your computer. Thus the layout can be done basically in 1:1 scale.

![Desktop with working sheet](image)

Fig. 3.1-1: Desktop with working sheet (here: gray), Background (here: white), Toolbars, Sidebar, Rulers, Statusbar

3.1.2 II. Working Area

The workspace is a subset of the Stone Cut 2 desktop. The workspace is usually in the format that will later be output on a machine. In addition to the known DIN formats, any formats can be applied, e.g. for different table sizes.
3.1.2 II. Working Area

Note: The working area is used primarily for guidance. The format of the working area has no influence on the output on a connected device. The output preview window displays what is given out. Please refer to 3.9: Cutting - Milling - Creasing - Drawing ...

![Fig. 3.1-2: The Working Area Dialog](image)

### 3.1.2.1 The Buttons

**The New Button**

The *New* button creates a new format. The values for width and height of the selected line are transferred to the new row.

**The Delete Button**

The *Delete* button removes the marked row.

**The Change Button**

This button saves all changed parameters and options.

**The Default* Button**

This button marks the name with a * (star). The star-marked format is used every time Stone Cut 2 is started.
The *Read from connected device* Button

By means of this button - if the read-out command of the driver is processed by the machine controller - the width value can be read from the connected device and inserted into the width field.

The *Change orientation* Button

This button changes the orientation of the working space from portrait to landscape and vice versa.

The *OK* Button

The OK button accepts the changed values and closes the dialog.

The *Cancel* Button

This button closes the dialog without saving any changes.

### 3.1.2.2 The Areas

**The Preview Area**

In this area, the worksheet, the desktop background, their colors, as well as the orientation are displayed proportionally reduced.

**The Format Area**

*Name*

The name of the format is entered in this field and the name of the selected one is displayed.

*Width*

In this field, the width of the format is determined.

*Height*

In this field, the height of the format is set.

**The Margins Area**

*Left, Right, Top, Unten*

These 4 fields define the distance of the borders from the edge of the working area.

*Note: Negative values are also allowed.*
3.1.2 II. Working Area

The Color Area

Foreground

Here, the color of the worksheet can be defined as RGB value.

Background

Here the color of the background desktop can be defined as RGB value.

3.1.2.3 The Options

The Fit to objects Option

This option captures the objects outside the working sheet and extends the sheet by the amount necessary to accommodate all the objects on the working sheet.

The Show margins Option

This option displays the defined borders as dashed lines in front of the working sheet.

The Select image Option

This option displays the selected bitmap in the preview and later on the working sheet. The ... button opens the file dialog for selecting the desired bitmap.

The Scale Objects too Option

If the height or width of the working sheet is changed, all objects on the working sheet are reduced or enlarged by the same amount.

The Rotate Objects too Option

This option determines whether the objects on the working sheet and on the desktop background will also be rotated when the orientation is changed.

The Accept working area dynamically from current device Option

This option ensures that the width and height values of the working area are read from the connected device and used. For each device, a format is created with the name of the device in the list.

3.2 Job Preparation
3.2.1 Import

With this command the graphics that have not been saved in the Stone Cut 2-job-format are transferred to the working surface.

The functionality of this dialog box corresponds to the open file command. Differences are only due to the possibility to change the size of the data to be imported by means of the parameter X- and Y-factor. The desired file is chosen respectively specified via the name of file, type of file and directories (search in).

Fig. 3.2-1: Import window with preview

With the preview window in the import dialog all following formats can be displayed.


*Indication: With text files (*.txt) the preview window is switched off.*

3.2.1.1 Import Presettings

For many import operations, constraints can be defined to be taken into account before, during or after importing the data. Constraints can effect the DXF or HPGL import or all import operations.

Also for export constraints are definable in this window. Thus, a special option on job files can be activated, for example, the PDF export. The constraints are extensively recorded
3.2.1 Import

in the following article. [Video please refer to 4.7.1.5: The Filter Setup]

3.2.1.2 PDF Import

3.2.1.2.1 Additional Options

Fig. 3.2-2: Options concerning import of data

Integrated Job File

The Extract Button

Enabling the Extract ... button ensures, that the import function loads the integrated job file on the desktop, while extracting the PDF file.

Note: A prerequisite for this is that when you export the appropriate option in the preferences (see above) was made.

Raster Options

Import as Bitmap Option
If the **Import as Bitmap** option is enabled, then all vectors will be rastered into a bitmap before the import.

**Resolution**

The value in dpi

**Element Selection**

*Ignore Images* Option

If the *Ignore Images* option is enabled, then no images will be imported.

*Ignore Text* Option

If the *Ignore Text* option is enabled, then no texts will be imported.

**Page Selection**

In the **input field** the page number can be entered, which should be imported.

*All Pages* Option

If the *All Pages* option is enabled, then all pages of the document will be imported.

**Search in**

In the row **Search in** the path can be set that shall be searched.

**File name**

If the file name is know it can be entered into this field

**Type of file**

Here, you have to choose the format of the file to be imported in order to activate the corresponding import filter

**Preview**

The activation of this option draws a preview of the file content to the left preview window

**Insert at Position (0,0)**

This option inserts the objects at the 0 (zero) position of the Stone Cut 2-working surface.

**X Factor, Y Factor**

With these two factors the data can be scaled (increased or decreased) during the import. The scale can be proportional or unproportional.
3.3 The Stone Cut 2 Layer dialog

In the layer-settings dialog the parameters necessary for the output are set and attributed to an object, a color respective a layer. The dialog opens by a right mouse click on the Stone Cut 2 layer-toolbar in the main window.

Fig. 3.3-1: Layer setup with adjustment of output parameters

In the **Information** field a name for the layer can be entered. This name is shown later in all dialogs in which the colors of the objects are needed.

In the **Mode / Tool** field the output tool can be selected from a list. The tools shown here depend on the used output driver.

In the **Material** field already saved material-configuration can be called up. The material-configuration can be created, saved or deleted with the button right of the selection box.

*Indication: By clicking with the left mouse button on another color the settings are saved and the values of another layer can be edited.*
3.4 Tool Assignment Via Layer

Tools which are provided from an output device are pre-defined in the device driver. The tool selection is done with the output dialog of the *Mode / Tool* list field.

![Output to device Device Driver](image)

Fig. 3.4-1: Tools and tools parameter which were defined in the device driver

3.4.1 Define Layer Assignment

What tool is located in which layer - that is necessary to define the order of execution - will be assigned in the *layer settings* window. A click with the *right mouse button* on the to edit layer opens the *layer settings* window. Tool assignment is not possible here.
3.4.1 Define Layer Assignment

3.4.1.1 The Output Button

If the Output button is enabled, the layer settings window switches in the following view:
Now, all from the respective driver provided tool modes are listed. When you select a tool, then the editable parameters and values appear in the list in the upper area of the output parameter window. Values can now be edited. A doubleclick in the desired field allows editing of its value. Repeat this operation for each layer and mode which is scheduled for output.

Note: When the red hook is visible, a tool assignment had been done. An additional control is possible via a tool tip in the layer box by placing the mouse cursor on the layer under investigation and is waiting for some time.

Depending on the output device, different tools and output modes are available. In the example below, for example, tools of a flatbed cutter are been used. Here it is important to determine the correct order in which the tools should work.

Fig. 3.4-3: Layer with tool nomination (left-hand) - tool assignment (Middle) - Layer with assigned tool (right-hand)

Fig. 3.4-4: Tool tip control for the "Cut Through Layer"
3.4.2 How the Tool Sequence Is Determined?

In principle, it should be noted that the processing of the **layer is done top down** and the logical sequence of different tools, is applied, so that for example, drawing is active ahead the cut tool. This sequence can be reordered individually.

![Layer sequence which should be reordered](image)

The change order function is enabled via the **layer order** menu item. In the **move layer** area you’ll find the buttons to change the layer order.

![Tool sequence reordered - Through Cut above Crease](image)
Conclusion: The tool assignment allows first, the definition of tools, second, the parameters for each tool, third, the selection of the color (layer) in which the to be processed objects lie and in the fourth place, the sequence in which the operation should be processed. Stone Cut 2 gives you the flexibility you need in dealing with different output scenarios and workflows.

3.5 The Output

3.5.1 Device Setting - Interface Setup (Local Device)

The Stone Cut 2 output

With this command you activate the module for cutting, milling, creasing and drawing of your data.

You activate this function via the button in the tools toolbar or via the file menu, menu entry output…

Fig. 3.5-1: The output button

When first opening another dialog will be opened before in which the driver of the device as well as the connection has to be defined.

Fig. 3.5-2: Driver and selection of the connection
3.5.1 Device Setting - Interface Setup (Local Device)

**General**

Under the part of the dialog named **General** you select the **driver of the device**.

In the right list all device **drivers** are listed that are available in Stone Cut 2. In the left list an individual name for the driver can be distributed. This name will be used in the output dialogs of Stone Cut 2.

**Enable as server**

*Requirements are at least 2 licenses of Stone Cut 2.*

If the option **enable as server** is activated the output device will be marked as **plot server** and can be used by another **Plot Manager** for the output.

The characteristic features of an output device are that a driver for the processing of the data has to be distributed to this output device. On the computer on which the Plot Manager is running the job data for the output are transformed into device data by means of a driver. The output of the device data can be done in several ways:

**Types of connection**

**Local interfaces**

**Local interfaces** are the interfaces (COM1, COM2, ..., LPT1, LPT2, ...) that are directly on your computer.

The activation of the **settings** button opens a dialog for the configuration of the interface. These settings that are done here apply for the whole system.

![COM1 Properties](image)

Fig. 3.5-3: Dialog for the setting of the interface parameters
**Indication:** When steering serially you have to pay attention that all settings on the side of the computer as well as on the side of the output device correspond. Otherwise there is no or faulty communication between them.

**USB / Firewire Devices**

Here, all momentarily connected *USB / Firewire devices* are listed.

**TCP / IP**

Here, you have to enter the TCP / IP address and the port number to which shall be output.

**Spooler**

Here, you can select a Windows printer driver.

When opening the *output* dialog again it will be opened *directly* with the previously set device driver.

### 3.5.2 Device Setting (Network Device)

When selecting the menu item *create network device* … following dialog will be opened:

![Fig. 3.5-4: Dialog for the configuration of a plot server](image)

---

37
3.5.3 Start Output from the Stone Cut 2 Working Surface

A network device enables the output of Stone Cut 2 jobs on a Plot Manager that runs on another computer. Contrary to a "normal device" the data are not locally transformed into device data but transferred unchanged to the plot server for the further processing.

Device name

In the entry line enter the name of the device.

Server selection

In the area named server selection enter the TCP/IP address if you use a TCP/IP connection or the name of the computer that is used.

Network

If a connection shall be done via a network the configuration file of the plot server, the plotman.ini, must be selected.

Devices (of server)

If the actualize button is pressed the devices of the server are read.

Indication: The device of the server can only be read if the server was selected as only then, the devices of the server are available.

Driver

In the field driver the device driver is entered that the server uses for this device.

Indication: This driver must also be created locally, which means as local device.

3.5.3 Start Output from the Stone Cut 2 Working Surface

The output is started using the plotter icon.

![Pen Thickness, Color Graduation](image)

Fig. 3.5-5: Pre-processing line weight and color gradient

If a Stone Cut 2 job contains objects with the attributes pen thickness and/or color graduation a preceding dialog appears. The object attributes can be transformed into
vectors so that they are taken into consideration at the output. After clicking on the OK button the object attributes are transformed into curves.

### 3.5.3.1 Output to Device

![Output dialog](image)

**Fig. 3.5-6: Output dialog**

**Output**

In the area named **output** of the **output to device** dialog you can control most of the parameters that are directly or indirectly in contact with the output device.

**Device**

In the **device** field the previously defined output device is shown.
3.5.3 Start Output from the Stone Cut 2 Working Surface

**Mode**

In the *mode* field the required output mode is preset.

**Output Profile**

In the field *output profile* the required profile with individual settings and values is selected.

**Manage Profiles Button**

Clicking on the *Manage Profiles* button opens the following popup menu:

```
Add...
Save profile
Profile defaults
Mode / Tool defaults
```

**Add**

Activating the *Add* menu item writes a new data record into the profile database.

**Save Profile**

Selecting the menu item *Save profile* the prior to this edited and changed values are written into the profile database.

**Profile Defaults**

Activating the menu item *Profile defaults* resets all *Values* to the default value. The profile values are reread.

**Mode / Tool Defaults**

Activating the menu item *Mode / Tool defaults* resets all *Parameters* to the internal driver values.
Number of Jobs

The value in the field *number of jobs* repeats the last output without the reading of the video marks with identical output parameters such as scaling, etc. Only layers with tools are given out. This variant protects against the fact that layers are output with no tool assignment. This means that there is no error output due to the use of the last active tool.

Copies per Job

In the field *copies per job* you define how often the selected objects shall be cut. After the cutting this value is automatically reset to 1.

Copy Spacing Y-Direction

The value in the field *Copy spacing y-direction* defines if the copies shall be stacked vertically and which space has to be kept between the copies. Pre-condition for the activation of this option is that the selected object can be cut more than one time on top of each other!

*Indication: In the preview the first object is shown „normally“. Each further object of the stack is shown dashed in blue.*

Copy Spacing X-Direction

The value in the field *Copy spacing x-direction* defines the space between the copies that were entered in the field *Copies per job*.

Weed Border Distance

With the option *Weed border distance* it is defined if and with which space a rectangle is cut around the plot that facilitates the weeding of the foil. In the output preview the frame - if activated - is shown dashed in blue.

Segment Spacing

The *segment spacing* defines the horizontal space between the single segments. Segments always occur if the job has to be sectioned which means divided.

Only Output Tool-Assigned Layers

By activating this option, only objects from a layer with an assigned tool are transferred to the Plot-Manager.

Send Design Relative to Origin

Via this option the zero point (0/0) of the cutter can be moved. If this option is not active Stone Cut 2 selects automatically the physical zero point as starting point for the cutting.
3.5.3 Start Output from the Stone Cut 2 Working Surface

If the Send design relative to origin option is active the physical zero point is moved relatively to the offset coordinate of the reference point. The coordinates of the reference point corresponds to the position of the down left corner of the object to be cut on the Stone Cut 2 working surface.

Plot to File

If the option plot to file is active all output data are directed to a file you have named and written onto the hard drive.

Enable Tool Tips

If this option is enabled, explanatory texts regarding parameters, values or options are displayed, if the mouse cursor is located directly above.

Pause after Feeding a Segment

Sectioning / Segmentation: If a job is too big for the output Stone Cut 2 separates the job automatically in so many parts (segments) that are necessary for the complete output of the job.

If the option Pause after feeding a segment is active the output is interrupted after each segment and the material can be re-adjusted if necessary.

Save Settings Button

By activating the Save settings button all values that have previously been entered in the output dialog are stored and assigned to the currently active output device.

3.5.3.2 Sort Options

Sort before Output

If the option Sort before output is activated all objects in the working surface are sorted 1. in head direction and 2. in transport direction.

Actual Setting

Fig. 3.5-7: Main direction icon

The icon shows which main direction is selected in the output to device dialog.

Always Prefer Job Order

This option ensures, that the sorting that was made before, is not changed through an alternative sortation.
The **Sort Options** Button

The **sort options** button opens the **output settings** dialog.

Please refer to 7.5.4.1: The **Sort Settings** Tab

**Accuracy**

The **Accuracy** field offers the following settings: **very low, low, normal, high** and **very high**. As default, the value **normal** is set.

The accuracy defines of how many vector parts an object should consist. This is only relevant with objects whose size range in ten thousands of a millimeter. Other object sizes are calculated **automatically** by Stone Cut 2.

**Feed / Origin**

Depending on the selected driver the field name is either **feed** or **origin**.

**Friction Feed Cutter**

With **origin** the options are **new origin** or **don't set**. If the option **new origin** is selected the device goes into X-direction at a fix set value behind the last cut object and this position is then the new origin. If **don't set** is activated the physical zero point is the new origin after the output.

**Flatbed Cutter**

With **feed** the options are **feed** or **no feed**. If the option **feed** is activated the material feed is carried out with the sectioning and with the output from the roll if the flatbed cutter has an automatic material feed.

**Objects**

The field **Objects** allows the selection of the objects to be output. Besides the modes **all objects** and **selected objects** Stone Cut 2 also allows the cutting of **color sequences** or of **single color layers**. The two last named are explained more in detail in the chapter „**color separation when cutting**“.

![List field objects with selection modes.](image)
3.5.3 Start Output from the Stone Cut 2 Working Surface

3.5.3.3 Parameter / Value Table

The table Parameter / Value allows the access to the parameters of device and driver. The area is divided in parameter and value. The width of the display can be changed by moving the vertical line between the areas with the mouse. Whenever Edit… is displayed in the value column a double-click opens the corresponding window for the setup of a group of parameters.

Fig. 3.5-9: Example for an opened parameter group

Info Line

In the Info Line information relating to the output process is displayed additionally, e. g. "Job will be sectioned".

Test Drive

If the test drive button is activated the connected device drives along the weeding frame with the tool head lifted. This also happens if the option weeding frame is not active.

Preview or Direct Output

The Preview button opens the output preview. Direct output suppresses the preview window. After pressing the output button, the plotter commands are transferred to the plotter together with the data.

Output

The Output button transfers the data directly to the Plot Manager and to the connected device.
Read Material Size

The Read material size button delivers back to all connected devices the height of the area to be plotted if an accordant command is intended in the firmware for the device. Devices that do not offer this option no value respective zero is delivered back.

3.5.3.4 Color Separation when Cutting

Each layer color used in the draft appears again in the objects list with the number that clearly defines each layer color. In addition, in this list field two horizontal color bars appear. After having transferred the data of a color layer, in the info area of the Windows status bar the Plot Manager icon ( ) appears.

Double clicking on this icon activates the Plot Manager job control. If the mouse cursor is positioned on the icon and the right mouse button is pressed, a pop up menu appears in which the Plot Manager can be closed or the program version can be shown. In the layer selection the color layers that have not been processed yet occur in the order in which they had been selected. The order in the stack can be changed at any time.

Fig. 3.5-10: Definition of the order in which the single layers shall be processed by up / down buttons

The order is defined via the up / down buttons. Layer colors that are not necessary are deleted from the list with the button.

Tip: For the color separated cutting use the register marks from the draw tool. Register marks are cut at the same place on the foil independently from the used color.
3.6 Generation of Rhinestones Pattern Templates

3.6.1 Rhinestone Pattern Templates

3.6.1.1 Manufacturing Process - Step by Step

The following instruction shows, how rhinestones are transferred onto a garment (here: T-Shirt). The layout is done in Stone Cut 2 and given out on an - suitable- cutting plotter. Suitability in this case means to have a sufficiently stable cutting head and to exert sufficient pressure on the material in order to generate (cut out) a perfect pattern template. With inadequate equipment “flooding” with rhinestones is very difficult or almost impossible.

Step 1: Loading and generating of a pattern template

Step 2: Process rhinestone macro here: Contour + fill and contour

Step 3: Load cutter with material

Step 4: Cutting the layout out of the special foil

Step 5: Removal of the template

Step 6: Place the template on a solid substrate
Step 7: "Flooding" of the template with rhinestones

Step 8: The rhinestones are spread into the hollows of the template using a special brush.

Step 9: Application of the transfer film on the flooded template

Step 10: Extraction of the rhinestones using the transfer foil

Step 11: Transfer the design onto the garment using a hot press

Step 12: Removing the transfer foil

3.6.1.2 Result:

T-Shirt with rhinestones (here: monochrome without preprint)
3.7 Export

If you want to use a job-file also in other programs the data must be made available in another format than the Stone Cut 2-job-format. This process is called „export“

*Indication: Exporting is done with the highest quality and lowest compression.*

![Stone Cut 2 Export window with file selection](image)

**Save**

With the icons next to the **Save-field** you choose the path in which the export-file shall be saved.

**File name**

In this field you enter the name of the export-file.

**Type of file**

Here, you select in which other format the data on the desktop is to be written.


*Indication: If objects are selected only those are exported, otherwise all of them.*
Selected objects

If this option is activated only the marked objects are written in the export-file.

All objects

If this option is activated all objects are written in the export-file.

Maintain worksheet

With this option the contour of the worksheet is written as object in the export-file.

Bitmap-Export

- 1 bit per pixel
- 3 bits per pixel
- 16 bits per pixel
- 24 bits per pixel
- Antialias

Hor. Res. (dpi): 300
Vert. Res. (dpi): 300

Fig. 3.7-2: Shade and resolution at Bitmap-export

Shade

The number in front of „Bit per pixel” indicates the exponent of the shade.

Example: 8 bits per pixel = \(2^8\) = 256 colors

Resolution

This value defines the amount of pixels per inch. The higher the value the finer becomes the resolution. The value dpi 300 for example is sufficient for the offset printing.

*Indication: Higher values are often not suggestive as the size of the file increases with higher dpi.*

Antialias

The export of a bitmap can also be done with antialiasing short: Antialias, which is a jaggies smoothing or edge smoothing.
3.7.1 PDF Export

3.7.1.1 Additional Options

3.7.1.2 Encrypt Document Option

Enabling the **Encrypt Document** option allows input of an individual password.

**Password**

In the input field any password for the document can be filed.

*Note: Please make sure that a secure password is used. It should be at least 8 characters long and made of numbers, letters, capital letters and special characters.*

3.7.1.3 Set Access Rights Option

Enabling **Set Access Rights** option allows you to enter an individual password.

**Password**

In the input field any password for the following access rights of the document can be filed.

*Note: Please make sure that a secure password is used. It should be at least 8 characters long and made of numbers, letters, capital letters and special characters.*

*PS: The Stone Cut 2 PDF export includes a double-stage password protection. The*
**first stage refers to the entire document and the second stage to a specific access rights of the document.**

### 3.7.1.4 Access Rights

**Printing not allowed Option**

When this option is enabled, printing of the document - **without knowing the password** - is not possible.

**Content cannot be extracted Option**

When this option is enabled, extracting of contents - **without knowing the password** - is not possible.

**Do not allow "Change Contents" Option**

When this option is enabled, editing of contents - **without knowing the password** - is not possible.

### 3.8 Excursion: Contour vs Outline vs Contour Line

Often, there is confusion among Stone Cut 2 users, because the differences between this terms are not clear and there can be seen no difference on the Stone Cut 2 working sheet, if the so-called full surface mode is enabled. Not until then the so-called contour mode - switch on or off using F9 key - differences can be seen. Obviously completely different functions are meant.

In the following the terms are examined for their similarities and differences.

#### 3.8.1 1. Contour

**Definition:**

Contour is a property, an attribute of a vector object or a type face, comparable with a color fill. This contour is given out on a laser or ink jet printer.

---

*Attention: A contour is not! given out on a cutter, unless the "Convert contours" function was executed before data transfer to the output module.*
3.8.1 1. Contour

If the option Convert contours is enabled, a vector combination in the thickness of the contour is generated. This combination is put in a layer with the same color.

Additionally the following dialog appears with a pre-selection of the correct welding method (here: Weld by Color).

Tip: For testing can be switched into the contour mode in order to control which objects will be given out.

3.8.2 2. Outline

Definition

Outline is a vector contour around another vector object oder a type face. In differenc to the term contour the generated contour is a real vector which can be outputted. Another difference is, that interior parts are contoured as well with a so-called Inline. Example:
Letters like a, e where the interior parts are also contoured (see fig. below)

**Note:** The Outline function is linked with the welding function, so that if contours are overlapping each other, an error-free output to vinyl gets possible.

![Outline dialog](image)

**Fig. 3.8-5: Outline dialog**

![Full surface mode](image)

**Fig. 3.8-6: Full surface mode**

![Contour mode](image)

**Fig. 3.8-7: Contour mode**

### 3.8.3 3. Contour Line

**Definition**

By a contour line is often referred in connection with the term: "print & cut". In "Print & Cut" bitmaps mostly logos - graphics without vectors - are contoured with a vector line, in order to produce decals, label, sticker on a cutter with OPOS sensor. The contour line is the line that is cut around each sticker. It is like the pen contour an outline around the entire object.

**Note:** In this case the thickness of an object cannot be defined; as default a so-called hairline (0.01 mm) is generated.
3.8.3 3. Contour Line

**Fig. 3.8-8: Contour line dialog**

**Conclusion:** The above examples should make clear that it is important to keep apart the notions. Although, there cannot be seen any difference on the screen when in the full surface mode, different tools and functions are involved. This example also shows how flexible the tools of Stone Cut 2 are.
3.9 Cutting - Milling - Creasing - Drawing …

3.9.1 The Output Preview

The output preview is automatically started if you press the preview button in the output dialog.

Closing the output preview and returning to the working surface of Stone Cut 2

![Output preview with toolbars, status line and output objects](image)

In the status line of the cutting preview the following information is shown: contour, filling, width and height, group or combination, the max. foil consumption in square meters and running meter (rnm) as well as selected object features. If the output menu is activated the data are transferred to the output device.

*Indication: If the job to be cut is left, underneath or above the material- or table preview and the output-menu is activated you will automatically be reminded that the objects to be cut are out of range of the output.*

Detailed description:

▶️ please refer to 6.8: The Preview Tools Toolbar
3.9.1 The Output Preview

please refer to 6.9: The Preview Object Parameters Toolbar

3.9.1.1 Foil optimization

The material consumption can be reduced by using the module *foil optimization*.

![Optimize Output dialog](image)

Fig. 3.9-2: Parameter dialog for the material optimization

The *foil optimization* takes care that all objects are arranged in a way that they take the least space on the material.

*Indication: Groups and combinations are each regarded as an optimization object. If this is not desired the grouping must be interrupted and the combination cancelled.*

Following options are available:

**Weed border distance**

In this field the desired distance between the optimization objects, the so called *weed border distance* can be set.

**Rotate objects to shorter side**

All objects are rotated so that the shorter side is downwards.

**Rotate as needed**

During the optimization all objects are rotated so that they can be arranged saving the most space.
Include bitmaps

If this option is activated, bitmaps and groups that contain bitmaps are also optimized.

Only selected objects

Only the selected objects are considered. With this option you can for example optimize according to layers (colors).

Maximum optimization

If this option is activated two more fields are shown in the foil optimization dialog. The option maximum optimization calculates all possible combinations the can arise from the fields end optimization up to maximum objects and permutation depth. The calculation can take much time depending on the size of the here set values as all possible combinations that arise from the two values are calculated and compared. Therefore, you should usually not set more than 20-30 objects with a permutation depth of max. 5.

Indication: An optimization always leads to the rotation of one or several objects.

3.9.1.2 Weeding lines

Weeding lines serve for the better procession of large jobs. Material length or width of several meters are difficult to handle, therefore, you can insert weeding lines during the foil cutting that divide the job into smaller parts that are more easy to handle.
3.9.1 The Output Preview

![Output job with weeding frame (dashed in blue) without weeding lines](image1)

Fig. 3.9-3: Output job with weeding frame (dashed in blue) without weeding lines

![Example with 3 horizontal and 3 vertical weeding lines (dashed in red)](image2)

Fig. 3.9-4: Example with 3 horizontal and 3 vertical weeding lines (dashed in red)
In the **output preview** there are 3 possibilities to insert horizontal and vertical weeding lines.

**Indication:** **Weeding lines can only be inserted if the option weeding frame has been activated in the output dialog.**

1. **Manually**

Position the mouse cursor on the weeding frame *dashed in blue* around the objects. The mouse cursor changes into a double-headed arrow. Now draw a horizontal or vertical weeding line to the position where it should be segmented. Repeat the process until all necessary weeding lines are inserted.

2. **Via the menu **options****

Open the menu **options** and activate the menu item **horizontal weeding line** or **vertical weeding line**.

The first weeding line is inserted in the middle of the objects to be cut. The second call up of the function bisects the two halves in two more halves and so on.

3. **Via the shortcuts h or v**

An „h“ or „v“ directly entered via the keyboard generates the respective weeding lines - as described in 2.

**Tip:** **Single objects can be provided additionally with a separate weeding frame via the right mouse menu.**
3.9.1.3 Job Sectioning

Sectioning is the division of a job in so many parts (sections) that are necessary for the complete output of the job.

If the job to be output is bigger than the set or the available output width (output dialog, field width of material) of the output device in the information area of the output dialog the indication „job will be sectioned“ is shown.

**Indication:** *The terms sectioning and segmentation are used as synonyms.*

The activation of the output menu then opens the following dialog before the transfer to the device:

![Sectioning dialog](image)

*Fig. 3.9-6: Sectioning dialog with overlapping of 3 mm*

**Optimize material (max. size + smallest at last)**

Optimize ... smallest at last) causes Stone Cut 2 to create segments in the maximum permitted size. The size of the last segment usually differs from the others.

**Optimize material (max. size + smallest at first)**

Only active with flatbed cutters. If the last segment was also cut as last the plate could not be processed until the end. Therefore, the remainder is cut as first so that the plate lies on the table until the end.

**Segment optimization (segments of equal size)**

If the option segment optimization is activated always segments of the same size are created.
Optimize segments by mark posiions

This option is activated as default with Stone Cut 2 if video markers exist in the Job. The above dialog is skipped and the preview of the dynamic segments is shown. The reason of this optimization is that always at least 3 video markers are necessary. Depending on the location of the video markers Stone Cut 2 "searches" up to 30% next to the segment line if there is a video marker. If yes, the respective segment is adjusted dynamically.

Preset segmentation

The last used setting is automatically saved. When loading the job again this sectioning can be accessed.

Reverse cutting

The option reverse cutting indicates that the objects are cut as „negative“ for example for the use as template for the screen printing.

X-overlap and Y-overlap

Segmentation with overlapping - In the fields X- and Y-Overlap you can define how much the segments shall overlap. The vectors are enlarged accordingly at the cutting points.

Fig. 3.9-7: Foil optimization in the sectioning preview with 8 segments and information on segment sizes
3.9.1 The Output Preview

**Selection and deselection of the segments**

Selection and deselection of the segments is done by clicking into the segment. The red checkmark indicates which segment is active and being output.

**Changing the suggested sectioning**

You can change the sectioning by clicking on the blue section lines and move them to the desired position with the mouse. If necessary Stone Cut 2 inserts automatically new sections.

In the status line of the segmentation preview the size of the job to be cut in X- and Y-direction and the number of segments are shown.
3.10 Printing

Fig. 3.10-1: The print button in the standard toolbar

3.10.1 Without RIP Software

The following chapters explain in detail the single functions of the Stone Cut 2 print dialog.

Open the Stone Cut 2 print... dialog by selecting the menu item print in the file menu, via the keyboard hotkey CTRL+P or by pressing the button in the toolbox.

In the down right part of the dialog you find the option tile and the adapt button and the 1:1 button under output. Depending on which option you have activated the appearance of the preview of the print-dialog changes.

**Indication:** If the print-dialog is opened the adapt button is automatically active because we do not assume formats that exceed the maximum output-size of the device to be accessed as standard for the printing of objects or graphics.
3.10.1 Without RIP Software

The adapt mode

The **adapt**-mode corresponds to the printable area. The values for the printable area are shown in the field **print area** which is in the upper right part of the print dialog.

The preview window in the **adapt** mode

The preview window offers the possibility to check your job before printing. The edges of the window are **magnetic** which means that if an object is approaching the edge of the sheet the object stays at the edge of the window. Thus, a faster positioning of the objects in the corners or at the edges of the sheets is obtained.

*Tip: If the magnetization of the edges shall be switched off, keep the SHIFT button pressed while positioning your objects.*

The **x**- and **y**-coordinates that are shown underneath the preview window express the location of the left upper edge of the object on the working surface.

Mouse-functions in the preview window (**adapt**-mode)

Clicking once with the **right** mouse button or activating the **preview** button increases the preview window to the maximum size of display.

Fig. 3.10-3: The print preview button

![Print preview button](image)

Fig. 3.10-4: Print preview in the complete picture mode

![Print preview in complete picture mode](image)
**Indication:** The size of display depends on the set screen resolution (800*600, 1024*768, ...). Clicking again with the right mouse button resets the original status.

**Indication:** If the left mouse button is pressed and kept pressed, a dashed black frame appears around the objects to be printed. This frame covers all objects that are on the working surface and corresponds to the printing area.

### Printable area and object

The fields **Printable area** and **object** are in the upper right part of the **print** dialog.

<table>
<thead>
<tr>
<th>Width in mm</th>
<th>Printable area</th>
<th>Object Width</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>210</td>
<td>87.77</td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td>297</td>
<td>99.16</td>
<td>100.00</td>
<td></td>
</tr>
</tbody>
</table>

Fig. 3.10-5: Section field printing area and object

### Printable area

In this field, the specified printing area with height and width values is shown.

### Object

In this field the object/s to be printed with height and width values is/are are shown.

**Indication:** The fields for the percental enlargement of the objects are not active in the adapt-mode.

One field below on the right side of the **print** dialog is the field **printer**.

![Printer selection and Setup](image)

Fig. 3.10-6: Printer selection and Setup

If you open the list you will get a list of all printers that are installed on your system. Select the printer that you want to use. In order to do more settings for the printing activate the **setup** button. The dialog that now opens corresponds to the menu item properties of the respective printer file menu.

**Indication:** The print dialog that is opened by pressing the setup button depends on the loaded printer driver and is therefore not further explained.

Right next to the **setup**-button the orientation of the sheet (portrait / landscape) can be set.

### What is printed?

In the area named print mode are two combo-boxes in which you can define what shall be printed. In the first list you can choose between the options **objects, objects with worksheet, job-info**.
3.10.1 Without RIP Software

**Objects**

All objects on the worksheet are printed.

**Objects with worksheet**

All objects and the worksheet (black frame) are printed. Underneath the black frame the company’s name, the dimensions of the working surface and the proportion in which it shall be output are also automatically printed.

**Job-info**

If this option is activated all information that have been entered in the job-info are output as well as all objects in the below right area of the sheet are printed downsized.

**All objects**

All objects that are on the working surface are printed.

**Selected objects**

Only objects are printed that have been marked on the working surface.

**Ratio**

Here, you have the possibility to enter the printing proportion as numeric or percentage values.

*Indication: Both fields are coequal which means that if a numeric value is entered the corresponding percentage value is entered automatically in the dedicated field and vice versa.*

![Fig. 3.10-7: Field for the entry of the size proportion](image)

**Examples for the indications of proportion with the corresponding percentages:**

- Proportion 1 : 1 corresponds to 100.00 %
- Proportion 1 : 2 corresponds to 50.00 %
- Proportion 1 : 3 corresponds to 33.33 %
- Proportion 1 : 4 corresponds to 25.00 %

**Centered**

If this option is activated all objects on the working surface are centered.
Tiling

If this option is chosen the print-dialog appears in the tile mode.

Number of copies

In this field the number (max. 9999) of the exemplars to be printed can be defined. The buttons adapt and tile enable switching between the two modi with the same name.

1:1

If this button is activated all objects on the working surface are displayed in their original size in the preview window and output.

Adapt

If this button is activated all objects on the working surface are downsized so that they can be shown completely in the preview window.

Options

Output to file - Print to file

If this option activated, print data is redirected to a file.

Contour mode

With this option activated all objects are printed like shown in contour mode - without filling.

Also print colored worksheet

When selecting this option the background color defined for the working surface is also printed.

Print subsidiary lines

If the job to be printed contains subsidiary lines they are also printed.

Always print black

This option becomes automatically active if in the first list all objects and in the second list color separated printing (after the layer order) or print single colors (after single layers) was selected.

Indication: If you want to print the objects on the working surface in color the option always print black must be deactivated.
3.10.1 Without RIP Software

**Register-/ Jog-Marks**

This option becomes automatically active if in the first list all objects and in the second list color separated printing (after layer order) or print single colors (after single layers) was selected.

*Indication: If you do not want to also print register and jog marks this option must be deactivated.*

**3.10.1.1 The Tile Mode**

If you switch from the adapt mode to the tile mode the preview window appears as follows:

![Print... dialog box](image)

Fig. 3.10-8: The preview window in tile-mode

In the tile mode all tiles are shown. A tile is that part of the object that can be output on the device to be accessed.

The option **pause after** indicates after which tile (enter amount of tile) the output shall be interrupted. The fields **overlapping (mm)** serve for the entry of the desired horizontal and vertical overlapping of the objects to be printed.
When printing to roll (option Roll), whole lanes can be printed without having spaces between the single tiles.

**Indication:** Only the print of a whole lane can be interrupted and not the printing of a single tile. The entry of an overlapping in feed direction (print direction) has no influence on the roll which can also be seen at the display of the size of the tile.

After the tiling the dialog is not closed automatically as it is an advantage to directly compare the print and the preview. In addition, thus you can directly repeat the print of a specific tile.

**Mouse function in the preview window (tile mode)**

One click with the right mouse button on the tile preview increases the tile display. This can also be done by clicking on the + button in the upper left area of the window. Clicking once again with the right mouse button resets the original status.

If you double click with the left mouse button on a tile this one will be deactivated which means it will not be printed.

Double clicking with the left mouse button while pressing the SHIFT button leads to the inversion of the tiles which means that the tiles that have been deactivated before become now active (printed) and the tiles that have been active become deactivated (not printed).

The objects within the preview window can be shifted by means of the mouse. The window edges are magnetic which means that when the object is approaching the edge of the sheet the object remains clinged. When pressing the SHIFT button the magnetization is released.

**Example for the printing in the tile mode**

The following example explains the single functions, shortcuts,... in the tile mode in detail.

The tile mode offers the possibility to print in any size which means each graphic, independent of the size can be printed on the connected output device. For the print of your graphic you do not need a printer with which DIN A2-, A1-, A0- or even large size can be output.

**How?**

The graphic to be printed is divided in so many segments (tiles) that are necessary to be able to output the graphic on the connected output device. The amount of necessary tiles depends on the size of the graphic to be output and the pre-defined output format (DIN A3, A2, ...). The setting of the output format is done via the set button Stone Cut 2 print dialog and depends on the connected output device.

Load any graphic in Stone Cut 2 and open the print dialog, either via the file menu by selecting the menu item print..., via the keyboard with the key combination CTRL+P or via the button in the standard toolbar.
3.10.1 Without RIP Software

The Stone Cut 2 print dialog is opened in the adapt mode. Activate the tile mode by activating the thus named button.

The print dialog appears as follows:

![Print dialog in the tile mode](image)

Fig. 3.10-9: The print dialog in the tile mode

In the upper right corner of the dialog you find the two fields tile and object.

The field tile corresponds to the field print area in the adapt mode. The other fields in the right part of the print dialog are the same as in the adapt mode.

![Preview with settings in the tile mode](image)

Fig. 3.10-10: Preview with settings in the tile mode
Activated and deactivated tiles

An active tile is a tile that is not marked with a red „X“. Deactivated tiles on the other hand are marked with a red „X“.

![Activated and deactivated tiles](image)

Fig. 3.10-11: Bottom row: Tiles deactivated

The deactivation or activation of a tile is done by double clicking with the left mouse button which means when double clicking on an active tile it becomes deactivated. Another double click on the same tile activates it again.

In the previous figure you can see that the lower row of tiles is marked with a red „X“. These tiles were deactivated and will not be printed.

In the tile mode you do not only have the possibility to activate / deactivate single tiles.

*Tip: Keep the CTRL button pressed while double clicking with the left mouse button on the desired tile and all tiles where the mouse cursor is are deactivated.*

3.10.2 With Pjannto RIP software

![Pjannto RIP button](image)

Fig. 3.10-12: The Pjannto RIP button in the standard toolbar

Indication: Pjannto RIP is a professional PostScript-RIP that is not a part of Stone Cut 2. If a license was purchased from Pjannto RIP and the software is installed on the same computer the Pjannto RIP button is automatically embedded in the standard toolbar of Stone Cut 2 and the file menu enlarged with the entry Pjannto RIP... .
3.10.2 With Pjannto RIP software
4 Reference Part

The menu items in chronological order:

4.1 The File Menu

4.1.1 The New… Command

With the New command a new job is opened. 

4.1.2 The New from Template Command

This command is for saving jobs as template (file extension JTP). These templates can be loaded again via file / open or file / new. As JOB name „untitled“ is shown.

4.1.3 The Last Version Command

When loading a job a safety copy named AUTOSAVE.BAK is created in the Stone Cut 2 directory.

With this command the version of the job that was available before the loading of the job can be restored.

4.1.4 The Open… Command

With this command the files that were stored on your hard drive or another data carrier in the Stone Cut 2 JOB file format are brought onto the current screen / desktop. You can further edit this file. Jobs can be deleted after a safety query. 

4.1.5 The Save Command

With this command you save the current job. If the respective job has already been stored before, the given file name and the directory are kept. The older version of the job is overwritten so that the old version can not be restored any more.

If you have created a new job that has not been saved before, the program, if you have clicked the save command in the file menu, goes automatically to the command save as… .

First, the job info dialog is opened where you can enter more information about the job. Then, the real dialog for saving your job is opened and you are asked to enter the file name and select the directory.
4.1.6 The Save as… Command

With this command you save a new job under a file name chosen by you in a directory to be selected. This command is also for changing the file name and / or directory of already existing files. If for example you want to save a job that is build up on an older one without losing the old version then you select the command save as ... and you can save the new job under another name in a new directory if you wish to.

The command save as... is also to be selected if you want to save the current job onto another data carrier. To do so, select the appropriate disk drive.

4.1.7 The Save all Command

With this command you save all open Stone Cut 2 jobs. If among them, there is a newly created job it can be saved under a file name chosen by you in a directory to be selected.

4.1.8 The Send by Email… Command

This command opens the standard email client and links the current job as attachment to the email. The job must be saved before.

4.1.9 The Import… Command

With this command files are imported into Stone Cut 2. Known file formats are shown in a list.

4.1.10 The Export… Command

If you want to use a job also in another program the job file must be converted into a suitable format which means exported.

4.1.11 The Print… Command

With this command you print the current file in any size (tiles) on the standard printer.

4.1.12 The Output… Command

With this command you call the output module (Plot Manager) for cutting, drawing or milling.
4.1.13 The **Scan...** Command

This function activates your scanner via a so-called TWAIN interface. If your scanner possesses such an interface (program) you can directly access it via this menu entry.

If for your scanner this software is not available then insert the scanner software via the menu `tools / insert program` into the menu structure.

4.1.14 The **Choose Scanner...** Command

This command allows you to select a scanner.

4.1.15 The **Quit** Command

With this you terminate Stone Cut 2 and return to the Windows desktop. If you have not saved the job that is currently being edited, you will be asked if you want to do so.

4.1.16 The **Job History**

The **Job History** function facilitates the loading of the 4 last jobs without having to pass via the directory tree. At the end of the menu list of the `file` menu the names of the 4 last edited jobs appear. Click with the mouse button on the desired job name. Then, the selected file will be loaded on the working surface.
4.2 The Edit Menu

4.2.1 The Undo Command

With this command it is possible to undo the last done operations and functions. The default setting is 5 steps. This default value can be changed via the settings menu, menu entry standard settings / miscellaneous and here undo levels. The maximum value is 100 steps.

*Indication: This setting can only be changed with a new file (file menu, menu item new)!*

4.2.2 The Undo Stack… Command

This command opens a window with the last used commands. Most intermediate states are previewed. By clicking on the respective command this state is restored.

*Note: This menu entry is only displayed, if restorable commands are used.*

4.2.3 The Redo Command

This command is the reverse command to undo. It restores the status that was there before the undoing.

4.2.4 The Redo Stack… Command

This command opens a window with the last commands, which were made undone. Most intermediate states are previewed. By clicking on the respective command this state is restored.

*Note: This menu entry is only displayed, when commands were undone.*

4.2.5 The Cut Command

With this command objects are copied to the Windows clipboard and deleted from the working surface. Via the clipboard objects can be inserted at another place or in another program.

*Indication: For the transport of your data you can also use the export command. This is always necessary if your data shall be transferred to another computer.*
4.2.6 The *Copy* Command

With this command marked objects are copied to the clipboard without deleting them from the working surface.  

```
CTRL+C
```

4.2.7 The *Paste* Command

This command inserts graphics and objects from the clipboard to your job. The mouse cursor changes to a right angle in which *insert* is written.

```
CTRL+V
```

Now point the tip of the right angle to the point on your working surface where the graphic or the object shall be inserted.

4.2.8 The *Paste Special...* Command

Via this menu item "pictures" can be imported from the clipboard to Stone Cut 2.

*Indication: If in Stone Cut 2 objects are copied this menu item is not active.*

4.2.9 The *Select All* Command

With this command all objects of the active job which means all objects on the working surface and also outside the working surface are marked. The selected objects can then be grouped, combined or moved.

```
CTRL+A
```

4.2.10 The *Reverse Selection* Command

With this command all non-selected objects are selected. Already selected objects will be unselected.

```
SHIFT+E
```

4.2.11 The *Job Info...* Command

With the job info you have the possibility to save additional information with every job. You can print this information and use them for invoicing or as accompanying working sheet.

Next to this information as for example *order number* and *company address* the job-info also gives information about the used material. In the *memo*-field additional comments in note form can be stored.

4.2.12 The *Color Layer...* Command

This command starts the *layer settings* dialog in which objects are colored, foil colors are defined, device tools are assigned, objects of the same color are selected and layers can be made invisible or blocked.
4.2.13 The Multi Copy… Command

This command serves the generation of any number of object copies (duplicates) on the working sheet. Number, Offset and more can be set in a dialog.

Detailed description: please refer to 6.5: The Object Parameter Toolbar
4.3 The *Design* Menu

4.3.1 The *Rotate Axis* Command

This command rotates the marked objects at 90° counter-clockwise.
This option is always necessary if you want to adjust your objects fast to the rolling direction of the foil without having to go via the *rotate* function.

4.3.2 The *Rotate Axis With Page* Command

This command rotates the marked objects with page at 90° counter-clockwise.

4.3.3 The *Horizontal Mirror* Command

The selected object is mirrored at its horizontal through its center point. If several objects are marked, the center point of the virtual checkbox whose edge is limited by the 8 black dots with the corresponding horizontal is taken as axis of reflection. If no objects are marked all objects are mirrored.

4.3.4 The *Vertical Mirror* Command

The selected object is mirrored at the vertical through its center point. If several objects are selected the center point of the checkbox with its corresponding vertical is used as axis of reflection. If no objects are marked all objects are mirrored.

4.3.5 The *Delete* Command

Pressing the DEL key executes the *delete* command. In order to delete particular objects from your graphic they must be marked.

4.3.6 The *Mirror on the X Axis* Command

All selected objects will be mirrored at the *visible X-coordinate axis*.

4.3.7 The *Mirror on the Y Axis* Command

All selected objects will be mirrored at the *visible Y-coordinate axis*.

4.3.8 The *Duplicate* Command

In order to use this command the object to be duplicated must be marked before. Now click with your left mouse button on the *duplicate* command or activate it via the hotkey. The marked objects are now doubled.
4.3.8 The Duplicate Command

The positioning is done according to the values that you have entered in the settings menu, menu item standard settings / miscellaneous.

**Indication:** You can also duplicate an object by first marking it, moving it with the left mouse button kept pressed and then press the right mouse button once at the position where the duplicate shall be created. The displacing values are entered automatically with this procedure.

4.3.9 The **Clone** Command

If you clone an object you create a copy linked to the object. Modifications at the original (the initial object) are automatically done at the clone (the copy).

If a clone is modified in its size or form, an other "original" is created.

4.3.10 The **Group** Command

This command allows combining several objects to a group in order to edit them together. This can be wise if for example you want to move several objects without changing their position to each other. To do this, first mark all objects that you want to move together, select the group command and then move the newly created group to the desired place. Now, it is not possible any more to change the single objects that form the group independently from each other.

In order to make this possible again the grouping must be broken with the break group command.

**Indication:** Grouped objects cannot be treated with the node editing tool. The grouping must be broken before. In order to differentiate between the grouped and ungrouped objects they are shown dashed in blue.

4.3.11 The **Break Group** Command

This command is used to divide a group of objects again into single object. Each object can then be edited individually.

4.3.12 The **Combine** Command

This command combines like the grouping several objects to one. The difference to the group command is that the selected objects are not regarded as single isolated objects lying next to another anymore.

Let us explain this fact with an example.

You have created two squares with different sizes, the smaller one lying completely within the bigger one. In order to obtain that in the
full-color-mode the area of the smaller square is transparent you combine the two squares after having marked them before. The size of the bigger square is now interpreted as outer edge and the smaller one as inner edge. The area between the two edges is filled with the color selected in the layer box. In the middle, a hole with the size of the smaller square remains.

### 4.3.13 The **Break Combination** Command

With this command you cancel a combination. Now, the program treats the combination objects as single objects again.

### 4.3.14 The **Align…** Command

With this function marked objects are aligned. You can align the objects horizontally or vertically. The objects are arranged in that way that they are either centered or aligned at the desired side.

In addition, the objects can be aligned with the same distance so that a steady appearance is obtained. It is also possible to center all objects horizontally or vertically on the working surface.

*Indication: This option can only be activated if you have marked at least 2 objects.*

### 4.3.15 The **Sort With Simulation…** Command

This command opens the object sort function with which the output order and direction of rotation of the objects can be defined. The sort can be done dependent or independent of layers. Also, the preferential direction of the sort can be defined.

In a preview the output of the object is simulated graphically; here, the traverse path of the tool head can be sketched. The simulation can be repeated unlimited without changing the original objects.

### 4.3.16 The **Close Contour** Command

With this command open objects can be closed. You can see in the status line if an object represents an open track or not. To close it you mark the object and use that command.

### 4.3.17 The **Open Contour** Command

With this command closed objects can be opened.

*Indication: The menu item open contour corresponds to the separate function in the node tool.*
4.3.18 The Round Corners… Command

The *round corners* command rounds down nodal points with a freely defined radius. The rounding can be done inwards or outwards. The rounding can also affect the whole object or just single nodes.

*Indication: This function can also be used for the rounding of font characters.*

4.3.19 The Reduce Nodes Command

This command eliminates nodes of an object that are unnecessary or lying on top of each other. With straight lines, nodes that lie on the straight line and between the endpoints of the straight line are removed automatically. The reduction of nodes decreases the complexity of objects.

4.3.20 The Add to Clipart Group Command

The command inserts a marked object in the momentarily active clipart group of the clipart tab.

4.3.21 The Weeding Border Command

This command generates a so-called weeding border or frame around one or more selected objects. A weeding border facilitates weeding of the vinyl from the carrier.
4.4 The View Menu

4.4.1 The Zoom In Command

If you select this function the mouse cursor changes into a lens with a plus inside. You can now select an area that shall be zoomed by keeping pressed the left mouse button. The selected area will then be shown increased to the maximum in the program window.

*Indication: A beep of the computer loudspeaker informs you that the maximum zoom is reached.*

4.4.2 The Zoom Out Command

This function decreases the working surface gradually. If it had been zoomed repeatedly before, the single zoom steps are carried out backwards.

4.4.3 The Full Page Command

Select the function so that the whole available working surface is shown.

4.4.4 The Show All Command

This function changes the display of the vector drawing in this way that all objects can be seen in the program window. The section is chosen in that way that it is the biggest possible display of the graphic showing all objects.

*Indication: If you keep pressed the SHIFT key while doing this command only the marked objects are zoomed to maximum.*

4.4.5 The Show Selected Objects Command

If this command is activated only the objects marked on the working surface are displayed as big as possible.

4.4.6 The To Front Command

If you have arranged several objects on top of each other the following commands enable you to modify the location of the objects to each other. With the *to front* command the marked object is set on the top place above the others.
4.4.7 The To Back Command

With this command you set the marked object underneath respective behind all other objects.

4.4.8 The Forward One Command

This command sets the marked objects further front in the display.

4.4.9 The Back One Command

With this command you set the marked object further down and thus further back in the display.

4.4.10 The Reverse Order Command

The order of the objects in the stack is reversed. What was lying on top then lies at the bottom and vice versa. This also applies for all objects in-between.

4.4.11 The Change Order Command

With this command you can change the order of the objects in the display interactively by clicking the object contours one after another in the desired order.

*Note: If all contours are to be taken into account, the grouping of the objects must be broken or the combination of the objects must be broken as well.*

4.4.12 The Contour View Command

This command switches the display of the working surface to the contour mode which means that only the contours of the objects are shown.

4.4.13 The Enhanced View Command

With this command you can obtain the best possible display of the objects (smoothened contours).

*Indication: It slows down the speed of processing and should therefore only be used for the last check or presentation.*
4.4.14 The *Always on top* Command

The Stone Cut 2 window remains always in the foreground.

*Indication: This menu item is only active if the Stone Cut 2 window is in the window mode.*

4.4.15 The *Refresh Screen* Command

With this function the content of the visible window is build up again without changing the size or the selected section.

*Indication: Use this command if objects on the screen are visible that cannot be accessed by the arrow tool or if display errors of another kind occur.*
4.5 The Tools Menu

4.5.1 The Contour Line… Function

With the contour line function the outer edge of arbitrary many objects is calculated and provided with a contour. Contrary to the outline with this tool also bitmaps can be contoured. In addition, not every single object is contoured but it is tried to find only one contour that comprises all selected objects. Therefore, this function is especially suitable for the creation of intersection lines around labels. The objects of the label can be arranged arbitrarily. Afterwards, with the tool described here the contour of the label in the desired distance is calculated. The thus created contour can be used later for cutting the printed label.

Detailed: please refer to 3.8: Excursion: Contour vs Outline vs Contour Line

4.5.2 The PhotoCut… Function

The function creates vectors from bitmaps. PhotoCut calculates from Windows Bitmap files (*.BMP, *.PCX, *.TIF) grids or patterns that can be output with a cutting plotter or a similar device. The picture is divided into logical pixels and the average gray value calculated for each of these logical pixels. So, a picture is created that has less pixels than the original. Out of this picture horizontal or vertical stripes, circles, squares, ... are created whose width is proportional to the gray value at the respective position.

please refer to 7.10: The PhotoCUT Function

4.5.3 The Outline… Function

This function creates a contour with a distance around a vector object to be freely selected and is mostly used for contouring text objects. The color of the target layer can be pre-selected. Inline, the reverse function creates a contour lying inwards. „Outline & Inline” combined creates a closed contour in the pre-selected strength.

Indication: Contrary to the contour with combined objects simultaneously an inner contour is created. This function is not to be confused with a contour pen that only is a drawing attribute and no vector object.
4.5.4 The *Welding Command*

The merge functions *manually, automatically, trimming, open trimming, fill, by color, full area* and *screen printing* take care that overlaying object parts what would cut the foil are eliminated and connected.

![please refer to 7.6: The Welding Tool]
4.6 The Plug-Ins Menu

4.6 The *Plug-Ins* Menu

4.6.1 The *Object Replacer Command*

4.6.1.1 Replace Objects With Selected Type

All marked objects on the working surface are replaced by the selected type of object.

Detailed: [please refer to 8.6.3.4: The *Replace Objects* Function]
4.7 The *Settings* Menu

4.7.1 The *Standard Settings* Menu

![Default Settings dialog - here: Miscellaneous tab is active](image)

**Fig. 4.7-1**

4.7.1.1 The *Miscellaneous... Setup*

**4.7.1.1 Duplicate values**

- **X offset**

  Indicates the value that remains between the original and the duplicate (in X-orientation) after the creation of a duplicate.

- **Y offset**

  Indicates the value that remains between the original and the duplicate (in Y-orientation) after the creation of a duplicate.

- **Dynamic adaptation Option**

  This option takes care of the switching on or off of a function that automatically enters and uses the duplication values as X- or Y- orientation when duplicating with the right mouse button.

**4.7.1.2 Move objects**
4.7.1 The Standard Settings Menu

- **X increment**

Indicates the value how much the marked objects are moved or displaced when pressing the arrow keys on the keyboard.

- **Y increment**

Indicates the value in Y-orientation how much the marked objects are moved or displaced when pressing the arrow keys on the keyboard.

**Indication:** If you keep pressed the SHIFT key during the movement, the value of the displacement is reduced to a tenth part. If you keep pressed the SHIFT + CTRL key the displacement is a hundredth of the set step size.

4.7.1.1.3 Undo function

- **Max. undo levels**

Refers to the undo function in the **edit** menu.

**Indication:** This option can only be set if no job is loaded.

- **No undo / redo for bitmaps larger than ... MB**

For bitmaps that are bigger than the value set in this field the undo/redo-function is automatically **switched off** which means that the operations on this bitmap cannot be made undone.

**Advantage:** saving of time.

**Reason:** The expenditure of time (computational expenditure) for bitmaps from a specific size onwards becomes too big as for every undo / redo step a copy of the original (initial state) must be created. The value that is entered in this field should be between 5-10% of the RAM available in the computer.

4.7.1.1.4 Program start

- **Info window**

When the program is started, an information window is displayed in front of the workspace, which informs about news, updates, etc., if there is a connection to the Internet.

The 3 options are: **Display always, Do not show again, Only display when new.**

**Recommendation:** With „Only display when new” you do not miss any important information regarding Stone Cut 2.
4.7.1.2 The *Mouse*... Setup

4.7.1.2.1 Mouse action

- **<Ctrl> + right mouse button assigned with:**

Here, you can define the assignment of the right mouse button. To do this, open the selection list and select the command that shall be carried out when clicking once with the right mouse button.

- **Click Delay**

This option increases the accuracy when selecting objects. The default value is 100; the unit is millisecond. The higher this selected value the longer it takes until the object follows the mouse cursor. An accidental displacement of the objects is thus decreased.

*Note: Users that are not so sure with the handling of the mouse should increase this value.*

- **Scroll window automatically Option**

This option is switched on by default and takes care that whenever an object is moved above the edge of the working surface with the mouse, the working surface automatically is moved, scrolled.

4.7.1.2.2 Mouse Wheel

These options ease the navigation on the Stone Cut 2 desktop with computer mice, which are equipped with a mid-wheel button.

- **<Shift> toggles these modes**

Two modes are possible: **Zoom** or **Vert. Scroll**.

**Zoom**

This option - starting from the cursor position - increases or decreases the working area when turning the mouse wheel: according to the direction of rotation.

**Scroll vert.(ical)**

This option - starting from the cursor position - moves the working area horizontally (Wheel + CTRL key) or vertically when turning the mouse wheel. According to the direction of rotation the movement is done to the left, top or bottom or to the right, top or bottom.
4.7.1 The Standard Settings Menu

- Resolution

The sensitivity of the wheel can be adapted to individual requirements. The range is from 1 (coarse) to 10 (fine).

4.7.1.3 The Weed Border Setup

This command creates a frame around one or more selected objects. An additional frame facilitates the release of the cut objects from the carrier material (Weeding).

4.7.1.3.1 Manual Weed Border

Manual, because by selection is determined, around which which objects a frame is placed.

- Uniformly Page Distance

Here, a uniform distance from all 4 object sides to the weed border is established.

- Different Page Distance

Here, a non-uniform distance from all 4 object sides to the weed border is established.

- One Frame For Each Used Layer

In each layer in which objects are located, a weed border around all objects therein is placed.

4.7.1.4 The Output Devices... Setup

This category of the basic settings allows the definition of important parameters for the output on the output device. The default settings correlate with the information in the output dialog before the output of the job data to the connected device.

Current output device

All currently connected output devices can be selected in this window. The driver name, file name, and the port interface are displayed. Mode and material from the material database can be determined.

The ... button enables the creation, modification and deletion of the settings.

Port

Indicates with which computer interface the output device is connected.
Default Settings

Keep reference point

This option takes care that no new origin is set after the output of a job. The next output is done at the same coordinates as the previous.

Stack processing

This option enables an uninterruptible output without an interaction of the Plot Manager.

Wait after segment

Waiting after segment indicates if the cutter shall remain at this position after the output of a cut segment. This option is typically needed with flatbed devices without integrated automatic foil transportation.

Segment thus indicates the maximum addressable area that can be processed in one piece.

After the segment the foil is forwarded by hand to the correct position.

Sort before output

Sort means that all inner objects are processed before the outer objects and that a sortation is done in x-axis-orientation. This switch takes care that the foil is moved as little as possible in order to maintain the repeat accuracy as high as possible. This option is especially necessary with cutters with friction roll drive or when milling. The output speed is slightly reduced with this setting.

Plot to file

This option does not lead the output of the data to the connected device but opens a dialog in which the path and the name of an output file can be given that will be saved to the hard disk.

Read out automatically

This option can be activated if a device is connected and "online" and a read out command for this device exists in the driver.

Output only tool-assigned layers

This option takes care that only objects are output where a tool assignment to a layer was done.
Weeding border

This option defines if and with which distance a weeding frame is cut around the output objects. This option facilitates the weeding of foil.

Overlap

It defines the overlapping of two segments. This value takes for example care of the compensation for the shrinking that occurs with foils.

Copy spacing

Copy distance defines the distance of copies on the output medium.

Segment spacing

Segment distance defines the distance between single segments of a job.

Stack spacing

Stack distance defines if copies shall be stacked vertically. Requirement for the activation of this option is that the selected object can be output more than once on top of each other.

*Indication:* In the output-preview the first object is shown “normally”. Each further object of the stack is shown with a black square filled with an X.

No tooltips

This option takes care that no tooltips that were entered in the device driver are shown in the output dialog.

Enable output for objects larger than page size

This option causes objects to be passed to the output module that are larger than the dimensions of the working area.

4.7.1.5 The Filter Setup

The [setup import dialog](#) is used to preset all import filters implemented in Stone Cut 2. The settings are divided into 4 categories for the sake of clarity. Settings made in the [General tab](#) apply to all import filter file formats listed in the left column. [Default settings](#) are already activated. Settings other than the standard can be activated by clicking on the respective file format tab. The [filter-specific settings](#) can be activated or deactivated as required.
4.7.1 The Standard Settings Menu

Fig. 4.7-2: Import dialog with closed category structure and import filter file formats

Fig. 4.7-3: Plus sign control

Fig. 4.7-4: Minus sign control

Fig. 4.7-5: Check control

A click on the plus sign control opens the desired category. A click on the minus sign control closes the desired category. Clicking on the check control activates or deactivates the corresponding option.
4.7.1 The Standard Settings Menu

4.7.1.5.1 The Settings

4.7.1.5.1.1 Job preparation

- **Assume file name as job name**

  This option takes the name of the import file for the job file. This makes it easier to assign source file to job file.

- **Create new job**

  (Default: set) - When importing foreign data, the data is imported into a job without a name (untitled.job).

and

- **Close active job**

  The active job is closed during import. This prevents the job history becoming very large and confusing when importing many files.

- **Load following palette:**

  Enabling this option allows you to load a color palette with the *.PAL file extension.

- **Load following job template:**

  Enabling this option allows you to load a template with the file extension *.JTP.
- Run the following macro before importing:

This option lists all available macros. This option allows data operations to be performed before importing, such as 90° rotation, sorting with simulation, etc.

4.7.1.5.1.2 Conversions

- Separate layers by name

When importing external data, it may happen that several layers have an identical color value. If they are assigned different names, Stone Cut 2 can separate them during import and place the corresponding objects in separate layers.

- Insert objects at position

If this option is activated, it is possible to determine the position in X and Y in which the data is stored on the work surface.

- Combine objects in the same layers

If this option is activated, all closed objects that are in the same layer are combined during the import.

- Group all objects

If this option is activated, all objects are grouped during import. Advantage: The position of the objects remains unchanged when the objects are moved because only one group object is moved.

- Rotate objects by the following angle:

The value specifies the angle at which the objects are rotated when they are imported. Negative values are allowed.

- Scale objects by the following factor:

The value specifies the extent to which the objects are scaled, i.e. enlarged or reduced, during import. Negative values are allowed.

- Mirror objects as follows:

This option allows the objects to be mirrored when they are imported: Possible settings are: horizontal axis, vertical axis, both axes.

- Drag'n Drop objects rotate at the following angle:

If objects are dragged to the Stone Cut 2 work surface, they are rotated by the entered value when released.

- Search / replace alignment marks in the following layers:
4.7.1 The Standard Settings Menu

This option searches in the selected layer for vector objects that have the size of the alignment marks (see Standard Settings / Register / Crop Marks / Size) and convert them into alignment mark objects, that is, these objects get the object attribute: **alignment mark**.

- Resume video marks from the following layers:

(Default: set) This option takes the objects from the layers with the layer name, e.g. **Regmark; Regmarks; Register; Reg**; and regards them as video marks, that is, these objects get the **object attribute video mark**.

4.7.1.5.1.3 Object properties

- Assign "Fixed object size"

If this option is activated, all imported objects are marked with the **object attribute "fixed object size"**; Thus size change is deactivated

- Assign "Fixed object size at the output"

If this option is activated, all imported objects are marked with the **object attribute "fixed object size at the output"**. If this option is active, then no size compensation takes place during output. The objects are placed and rotated only after the marks have been imported.

- Assign "Do not move"

If this option is activated, all imported objects are marked with the **object attribute "Do not move". The Do not move option prevents the selected object from being moved. The position is locked.**

- Keep object sorting

If this option is active, the object sorting is not changed during the import. The sequence of objects will remain.

4.7.1.5.1.4 Edit objects

- Reduce nodes

Enabling this option removes all superfluous nodes. The vector object is reduced by those nodes whose removal does not influence the curve trajectory.

- Remove duplicate lines with the following tolerance automatically:

If this option is activated, all identical, overlapping lines are automatically removed.

- Automatically close objects with the following tolerance:

If this option is activated, all vector objects are automatically closed or connected during import, whose distance from the start and end point is within the closing tolerance.
- Run the following macro after import:

This option lists all possible macros. This option allows operations to be performed after importing, such as 90° rotation, sorting with simulation, etc.

4.7.1.5.2 The Settings

4.7.1.5.2.1 AI/EPS

![Settings Configuration Window]

**Default filename extensions**

here: *.AI, *.EPS

**Additional filename extensions**

For the standard endings, individual file extensions can be specified. The import filter is configured as in the standard version.

**Use Ghostscript**

If this option is activated, the open-source interpreter application named Ghostscript is used for the data preview and the import process.

4.7.1.5.2.2 CUT
Default filename extensions

here *.CUT

Additional filename extensions

For the standard endings, individual file extensions can be specified. The import filter is configured as in the standard version.

Units

Here you define in which unit the data is imported: automatic, metric or english.

4.7.1.5.2.3 CDR/CMX
Default filename extensions

here *.CMX, *.CDR, *.CDT

Additional filename extensions

For the standard endings, individual file extensions can be specified. The import filter is configured as in the standard version.
4.7.1 The Standard Settings Menu

4.7.1.5.2.4 DXF

Default filename extensions
here *.DXF

Additional filename extensions
For the standard endings, individual file extensions can be specified. The import filter is configured as in the standard version.

Substitute font when importing text
Here you can select which font is used during the text import. The selection lists all fonts installed on the import computer.

Units
Here you define in which unit the data is imported: automatic, metric or english.

4.7.1.5.2.5 ACM, Gerber, GTP, HPGL, JOB, OXX, ONYX, OXF
see CDR/CMX

4.7.1.5.2.6 PDF
**Default filename extensions**

here *.PDF

**Additional filename extensions**

For the standard endings, individual file extensions can be specified. The import filter is configured as in the standard version.

**No page selection dialog**

Activating this option suppresses the page selection dialog.

**Import as bitmap**

Enabling this option will not import the vector data contained in the PDF file, but the bitmapped image also included.

**Ignore images**

This option ensures that any existing photos are not imported.

**Ignore text**

This option ensures that any existing texts are not imported.

**Import all pages**

This option ensures that all page breaks are ignored and that the document is imported as a whole.
4.7.1.6 The Profile... Setup

The Profile... setup serves the customization of the desktop. The user or administrator can adapt the Stone Cut 2 interface to fit his needs or restrict it to its necessary amount. The so defined user profile can be exported or be transferred - provided with a password protection - onto other licensed client computers.

4.7.1.6.1 Presentation

The following options are possible: **Original, XP, Icy, Office (colored)**. Changes are executed directly.

4.7.1.6.2 Color

The following options are possible: **Blue, Silver, Olive, and Red**. Changes are executed directly.
4.7.1.6.3 Menu Icons

Possible sizes are: Small, Medium and Large. A preview in the left hand area of the dialog shows, what effect the changes have.

4.7.1.6.4 Toolbar Icons

Possible sizes are: Small, Medium and Large. A preview in the left hand area of the dialog shows, what effect the changes have.

4.7.1.6.5 Lock Dialog with Following Password Option

If here a password is assigned, this password is queried while the activation of the Profile Menu Item. Changing the view is only possible with the known password.
4.7.1 The Standard Settings Menu

4.7.1.6.6 Export Profile Button

Enabling of the Export Profile button allows saving of customize Stone Cut 2 profiles. The used file extension is *.EC7. As default *.EC7 files are saved in the folder, where the program data are located.

Note: If all menus or the settings menu were accidentally disabled, then access on the profile resp. profile file is possible using the system menu. The system menu is enabled with a click on the program logo, which you'll find left from the program name in the program bar.
4.7.1.6.7 Status Area

In the status area messages and infos are displayed that explain the program's operation.

4.7.2 The Color Palette Command

With this command new color palettes can be created, loaded or saved.

Layer Numbers

If this option is active layer numbers are shown in the layer-toolbar.

Layer Info…

Opens the dialog for the setup of the layer toolbar. Here, you can define which information is shown if the mouse cursor is positioned above a layer color.

Possible information is: color-number, RGB values, CMYK values, material name, mode/tool, material and amount objects. In addition, the amount of visible layers and the width of the window can be set.

An „I“-button opens a window with shortcuts of the layer toolbar.

Layer Order…

This option opens a dialog for the modification of the layer order respective the output order.

Only Sel. Layer Visible

If this option is activated only the objects lying in the selected layer are shown on the working surface.

Delete Sel. Layer

Deletes the selected layer from the layer list.

Delete Unused Layers

This option removes all unused layers, all layers without objects and without device connection.

New Palette

All color layers that have layer numbers bigger than 6 are removed. You use this command if you want to define a new color palette individually. The selection of the layer color is done by just selecting the desired color with your mouse cursor and then activating the OK button.
4.7.2 The Color Palette Command

Load Palette…

The previously defined palettes can be loaded.

Save Palette

With this command you save a newly defined or a modified standard palette on your hard disk. If this new or modified palette is saved as default palette it will be used at every new start of Stone Cut 2.

Save Palette As…

This command allows the new allocation of a palette name.

Default

This command loads the color palette that is delivered as standard with Stone Cut 2. It is a Mactac foil color chart that was defined as default palette by means of the color fan.

Palette History

This function facilitates the loading of the last 4 color palettes without the detour via the file directory tree. At the end of the menu list of the color palette menu the names of the last 4 edited color palettes appear. Click with the mouse cursor on the desired palette name and thus open the selected palette.

4.7.3 The Working Area… Command
Here, you can newly define the size and color of your working area. The working area is displayed as a paper frame with a gray shade on the right and bottom next to the frame (see figure above). The color of the working area is freely definable; this guarantees an optimal layout control on the screen.

Pre-defined are for example DIN-A-sizes. Besides the fix defined measures you can define any number of user-defined working area. One can be defined as standard. It will then be pre-set at every "file new". This option is a very helpful function for everybody who has e. g. a milling or an engraving machine as the new entry in each case of the usable area can be omitted.

*Indication: A double click on the shade right next and below the working area also opens this dialog.*

**4.7.4 The Rulers… Function**

With this function you define the positions where the rulers shall be placed. Due to lack of space the display of the rulers can be abandoned. With diametric display each 5th step is drawn longer and with non-diametric each 2nd and each 4th once again.
4.7.5 The Unit of Measurement Function

This instruction switches the measuring unit to the preferred unit (mm, cm or inch).

*Indication: The metric can also be changed directly via a button that is in the angle of both rulers.*

4.7.6 The Grid... Function

This option shows either the grid itself or only the cross points of the gridlines (raster) on the working surface. This function facilitates the orientation and positioning of objects on the working surface. The distance of the gridlines and the offset in X-/Y-orientation can be freely defined. Reference point thereby is the left down corner of the working surface. This point represents the 0/0-position to which the offset is added up. A positioning assistance with "magnetic" influence takes care of the accurate justification of the objects.

4.7.6.1 Distance and Start Position

- **Spacing X**
  
  This value defines the distance of the grid from the edge of the working surface related to the X axis.

- **Spacing Y**
  
  This value defines the distance of the grid from the edge of the working surface related to the Y axis.

- **Offset X**
  
  This value determines the distance of the grid from the zero point of the working surface in relation to the X axis.

- **Offset Y**
  
  This value determines the distance of the grid from the zero point of the working surface in relation to the Y axis.

*Note: Negative values are allowed.*

4.7.6.2 Settings

- **Snap to grid Option**
  
  This option turns the magnetic function of the grid lines on / off.
- **Grid on / off Option**

This option makes the grid visible or invisible.

- **Grid lines or Grid**

This option switches between grid and grid lines view.

- **Select color**

This option allows you to specify the color of the grid. It is used to optically separate the grid from the objects.

### 4.7.7 The *Origin* Function

This function shows a zero point (origin) in the lower left corner or the lower right corner of the working area. It is used for orientation on the working area. Which view is preferred depends mostly on the zero point of the connected machine. The view on the working area then corresponds to the real conditions.

![Fig. 4.7-10: Here: Origin bottom left](image)

#### 4.7.7.1 The *Settings Origin* Menu

![Fig. 4.7-11: The Origin Options](image)
4.7.7 The Origin Function

4.7.7.1.1 Setup...

![The origin dialog box]

Fig. 4.7-12: The origin dialog box

**New Position (X / Y)**

This option allows you to set the zero point using specific values.

**X Field + Measuring Unit**

In the X field, the absolute coordinate of the zero point on the X-axis can be specified.

*Note: The unit depends on the setting of the ruler.*

**Y Field + Measuring Unit**

In the Y field, the absolute coordinate of the zero point on the Y-axis can be specified.

*Note: The unit depends on the setting of the ruler.*

**Display as Cross Option**

If this option is activated, the origin point is represented by a dashed coordinate cross. If the option is deactivated, the position of the zero point is only taken into account in the rulers.

**Bottom Left Option**

This option places the zero point in the lower left corner of the working area.
**Bottom Right Option**

This option places the zero point in the lower right corner of the working area.

**4.7.7.1.2 Move**

This command serves to move the ruler origin. The Move option activates a crosshair as a mouse cursor. With the help of this, the zero point can be moved to any individual position.

**4.7.7.1.3 Reset**

The Reset option returns the zero point to the original position (lower left or lower right).

**4.7.7.1.4 Center to page**

This command serves to move the origin point to the center of the working area (center of page).

**4.7.7.1.5 Center to selection**

The Center to selection option sets the zero point to the position of the middle handle located at the center of a selected object.

*Note: This command is selectable only, if one or more objects are selected on the desktop.*

**4.7.7.1.6 To selected node**

The To selected node option sets the zero point to the position of a marked (selected) node.

*Note: This command is selectable only, if one or more objects are selected on the desktop.*

**4.7.7.1.7 Display**

This option displays the zero point or makes it invisible.

*Note: Only visible, if the Display as Cross-Option is active.*

**4.7.7.1.8 Fix**

This option makes the zero point moveable or fixes it at the current position.
4.7.8 The Undo / Redo Command

With this instruction the undo / redo function can be switched on or off.  

Advantages when undo / redo switched off:

With big or many objects the node processing is faster. The testing phase (initial state -> edition -> temporary final state) with several processing steps can be made undone as follows:
1. Switch off undo/redo, 2. edit objects and 3. switch on undo / redo

The selection of the undo function in the edit menu reestablishes the state before point 1.

4.7.9 The Cross-Hair Command

If you activate this option the cursor becomes a cross that reaches across the whole width and length of the Stone Cut 2 desktop. As soon as you move the mouse cursor beyond the desktop (for example in order to select a tool), it becomes an arrow again.

4.7.10 The Guidelines… Function

Guidelines (subsidiary lines) are blue dashed orientation lines that you can use as support for the construction. In addition, they facilitate the positioning of graphic objects and text blocks on the working surface. Red dashed lines are activated guidelines; They can be moved or rotated. Double-clicking on a help line opens the guidelines dialog. The current working area width and height are displayed for orientation and calculation.

Indication: If the positioning support is activated the help lines have a "magnetic" effect on the objects coming close-by and allow the most accurate positioning.

Type Area

In this area, 3 types of guide lines can be selected: horizontal, vertical and diagonal.

Note: The guideline can be rotated using one of the nodes located at the ends of the help line. The mouse cursor changes to a round arrow. The rotation center can be moved as desired by mouse. The <CTRL> key restricts the rotation to 15 ° increments.

Depending on the selected type, the Distance to lower edge of page, the Distance to left edge of page and / or the Pivot position is additionally queried. Negative values are allowed
**The List Box**

The Coordinates and Angles of all defined help lines are displayed in a list box.

**Copy Sel. Guideline**

This option is used to quickly create a grid pattern. A guideline is selected in the list box. The desired value is then entered in the Distance field. The Copy button creates a new help line and adds it to the list.

**Inserting Guidelines**

Clicking on the Insert button adds a guide line at the X, Y value and / or Angle. The coordinates and the degrees are added to the list box. The dialog remains open until the OK button is clicked.

**Modifying Guidelines**

Clicking on the Change button changes the values of the selected guide line to the value entered into the X, Y and / or Angle field.

**Deleting Guidelines**

A click on the Delete button deletes the selected guideline. Clicking the Delete all button deletes all the guidelines that appear in the list box.

*Note: Guidelines can also be deleted directly on the desktop by selecting them and removing them with the <DEL> key. They can also be pushed back into the ruler using the mouse.*

**4.7.11 The Snap Mode Function**

The snap mode facilitates the creation of objects at the subsidiary lines. This option activates the "magnetic" effect on graphic objects and text blocks.

**4.7.12 The Lock Guidelines Command**

With this option you can block all subsidiary lines so that they cannot be marked or displaced anymore. Only by clicking once again on this menu instruction the subsidiary lines are unlocked and can be displaced again.

**4.7.13 The Guidelines Visible Command**

With this option you can make all subsidiary lines invisible. Only by clicking once again on this menu instruction the subsidiary lines become visible again.
4.7.14 The Choose Language… Command

This option sets the language for user interface and help file.

4.7.14.1 Program Language

The user interface language is set here.

4.7.14.2 Language for the Help File

The language for the help is determined here.
4.8 The **Window Menu**

4.8.1 The **New Window Command**

Activating this instruction opens a new Stone Cut 2 window.

4.8.2 The **Tile Horizontally Command**

The activation of this instruction places all open windows diminished - one above the other - horizontally.

4.8.3 The **Tile Vertically Command**

The activation of this instruction positions all opened windows diminished - side by side - vertically.

4.8.4 The **Cascade Command**

The confirmation of this instruction displays all windows diminished and cascaded (diagonally displaced).

4.8.5 The **Close Command**

Clicking this instruction closes the momentarily active window after prior safety query.

4.8.6 The **Close All Command**

Clicking this instruction closes all open windows after prior safety query.

4.8.7 The **Standard Command**

This command switches the *tool*-toolbar on the desktop or makes it disappear.  

4.8.8 The **Sidebar Command**

This instruction switches the so-called **Sidebar** on or off. The **Sidebar** contains several tabs (e. g. layer) and is normally displayed at the right border.
4.8.9 The Setup Command

This instruction switches the \textit{setup} toolbar on the desktop or makes it disappear. \textbf{CTRL+3}

4.8.10 The Common Tools Command

This instruction switches the \textit{common tools} toolbar on the desktop or makes it disappear. \textbf{CTRL+4}

4.8.11 The Object Tools Command

This instruction switches the \textit{object tools} toolbar on the desktop or makes it disappear. \textbf{CTRL+6}

4.8.12 The Object Parameters Command

This instruction switches the \textit{object parameters} toolbar on the desktop or makes it disappear. \textbf{CTRL+7}

4.8.13 The Status Bar Object Info Command

This instruction switches the \textit{status bar object info} toolbar on the desktop or makes it disappear. \textbf{CTRL+8}

4.8.14 The Status Bar Element Info Command

This instruction switches the \textit{status bar element info} on the desktop or makes it disappear. \textbf{CTRL+9}

4.8.15 The Active Windows List

At the below part of the \textit{window} menu instruction list all active jobs are listed.

\textit{Indication: If more than 9 jobs are active it will be indicated by the menu item: further windows.}

4.8.16 The Further Windows… Command

This instruction is only visible if more than 9 windows are active. A window with a list of all active windows is opened. A click switches to the wanted window.
4.9 The Help Menu

4.9.1 The About … Command

The selection of this menu entry opens an info window in which various information is shown. On the left part of the dialog among others the serial number, version number, free disk space, co-processor, or type of processor are shown. On the right down part of the dialog is a scroll window in which all the application files of the respective application version are listed. This file list can be printed via the print button.

Indication: If there should be problems with your Stone Cut 2 version you can fix them the fastest, if this list is made available to our support staff.

4.9.2 The Help… Command

This option starts the Stone Cut 2 help.

F1

4.9.3 The Object Info… Command

The activation of this instruction opens an info window that contains information about the objects on the desktop. These are among others the number of objects, number of selections, vector objects, text blocks, all groups and combinations or all bitmaps.

The selection button opens the object manager.

F10

4.9.4 The Install Autoimport Plug-Ins… Command

Enabling this command opens the Corun Installer window, that lists for which programs plug-ins are available. Programs which were automatically found are marked already. Select the target program for the intended data exchange in the Eurosystems Software list field.

Pressing the Install button starts the installation.

Please refer to 2.3.1: Corun Installer
4.10 Context Menu Left Mouse Button

4.10.1 Context Menu Ruler

4.10.1.1 The *Unit* Button

A click on the *Unit button* activates one of the following context menus:

*Note: Which of the two is enabled, depends on whether objects are selected on the working area and what zero point setting is active.*

<table>
<thead>
<tr>
<th>mm</th>
<th>cm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin...</td>
<td></td>
</tr>
<tr>
<td>Move Origin</td>
<td></td>
</tr>
<tr>
<td>Reset Origin</td>
<td></td>
</tr>
<tr>
<td>Set Origin to Center of Page</td>
<td></td>
</tr>
<tr>
<td>Set Origin to Center of Selection</td>
<td></td>
</tr>
<tr>
<td>Hide Origin</td>
<td></td>
</tr>
<tr>
<td>Release Origin</td>
<td></td>
</tr>
</tbody>
</table>

or

<table>
<thead>
<tr>
<th>mm</th>
<th>cm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin...</td>
<td></td>
</tr>
<tr>
<td>Move Origin</td>
<td></td>
</tr>
<tr>
<td>Reset Origin</td>
<td></td>
</tr>
<tr>
<td>Set Origin to Center of Page</td>
<td></td>
</tr>
<tr>
<td>Set Origin to Center of Selection</td>
<td></td>
</tr>
<tr>
<td>Show Origin</td>
<td></td>
</tr>
<tr>
<td>Fix Origin</td>
<td></td>
</tr>
</tbody>
</table>

4.10.1.1.1 Origin...

*Please refer to 4.7.7: The Origin Function*

4.10.1.1.2 Move Origin

This command serves to move the ruler origin to any position on the desktop.

4.10.1.1.3 Reset Origin

This command serves to move the origin point into the lower left corner of the working area.

4.10.1.1.4 Set Origin to Center of Page

This command serves to move the origin point to the center of the working area (center of page).

4.10.1.1.5 Set Origin to Center of Selection

This command serves to mirror or place objects at the coordinate axis.

*Note: This command is only visible, if one or more objects are selected on the working area.*
4.10.1.1.6 Hide Origin

This command serves to switch the ruler zero point to invisible.

4.10.1.1.7 Release Origin

This command serves to release the fixation of the ruler origin in order to move it with the mouse.

4.10.1.1.8 Show Origin

This command serves to switch the ruler zero point to visible.

4.10.1.1.9 Fix Origin

This command serves to anchor the ruler zero point at a definite point.
4.11 Context Menus Right Mouse Button

4.11.1 Reference List of All Context Menu Commands

Context menus are called context menus as its structure adapts and changes depending on number and type of the selected objects (context). Context menus are always activated via the right mouse button. They serve for the fast access to important functions and tools, also to those that cannot be activated via the main menus.

Following menu entries displayed bold can appear in a context menu by clicking with the right mouse button.

Draw modes "line, curve, digitize mode, freehand"

- in the mode “line”: arc, digi mode, freehand
- in the mode “curve”: line, digi mode, freehand
- in the mode “freehand drawing”: line, arc, digi mode
- in the mode „digitize“: line, arc, freehand

In addition, if the object has more than 3 nodes: - close

Clones

- Select clone original
- Select clone objects

In the output preview:

- Material optimization (if no demo and more than 1 object)
- Change axis, - hor. mirror, - vert. mirror, - recalculate (when segmenting), - segment size (when segmenting), - horizontal weeding lines (if weeding frame), - vertical weeding lines (if weeding frame), - weed border (if no copies)

If objects are not locked: - ungroup (if selection contains group), - group (if more than 1 object selected and no clone is selected)

Node editing if no locked objects are selected:

- Insert (if node selected), - delete (if node selected) - break (if 1 node selected and another one is behind), - join (if 2 nodes selected (start/start or start/end or end/end)) - line (if curve node selected), curve (if line node selected), - new starting point (if 1 node selected and object closed)

If more than 1 node selected: - sharpen edge, - round, - join with line, - join with curve
If 2 nodes are selected within an object or a combination: - **hor. object alignment**, - **vert. object alignment**, - **reduce nodes**

If less than 2 nodes selected: - **reduce nodes**, - **round...**, - **set origin to sel. node**

**Hatch module is installed:**

If it was clicked within a closed object on selected or between 2 selected nodes: - **start tool path inside**, - **start tool path outside**

If 1 node selected & another is behind: - **insert bridge (xy mm)**

If more than 1 node selected: - **create regmark at sel. nodes**

If properties exist (job not protected by password): - **properties**

If plugin-version: - **contour line**

At application versions with text editor:

If not clicked on object, PhraseWriter exists and no node editing mode: - **text components**

If text object selected or text in selected group or combination: and if sel. text can be edited (no attribute „not edible“): - **edit text**, - **textbox**, - **circular text...**

If sel. text not locked: - **cancel circular text** (if text with circle set), - **text to curves**, - **text to lines** (if text has several lines), - **remove text attributes** (if existing)

If ONE not locked bitmap is selected: - **reduce colors**, - **posterize**, - **vectorize**, - **revectorize** (if possible), - **contour**

If ONE not locked closed vector-, combination- or text-object with bitmap-filling is selected: - **remove mask** or one of these object types lies above a bitmap: - **mask bitmap**, - **cut region**

If clone-original selected: - **select clone objects** otherwise if ONE clone selected: - **select clone original**

If no rulers, not clicked on an object and not in the output-preview: - **guidelines...**

If guidelines are fixed: - **release guidelines** otherwise - **fix guidelines**

If guidelines are hidden: - **show guidelines** otherwise - **hide guidelines**, - **delete all guidelines**, - **insert guidelines to center of page**, - **origin...**, - **move origin**, - **reset origin**, - **set origin to center of page**

If origin is displayed: - **origin** otherwise - **show origin**

If origin is fixed: - **release origin** otherwise - **fix origin**
4.11.1 Reference List of All Context Menu Commands

If not clicked on object: - refresh screen, - import, - insert, - job-info, - job-calculation, -
dimensions on selection, - hor. dimension, - vert. dimension, - hor. and vert. dimensions, - left border distance, - bottom border distance, - left and bottom border distance

If undo-buffer not empty: - Undo: <last action>

If redo-buffer not empty: - Redo: <last action>

If objects exist: - copy, - cut, - reverse selection

If export filter and exportable objects exist: - export

If Pjannto RIP is installed: - Pjannto RIP...

If PosterPrint is installed: - Posterprint-RIP...

If Posterjet is installed: - Posterjet...

If not locked objects exist: - add print marks

If nesting-DLL exists and sel. objects nested: - Nesting...

If group(s) selected: - ungroup

If more than one object and no clone-original selected: - group

If combination(s) were selected: - break combination

If combination has interior elements: - delete inner parts of combination

If more than one object and no bitmap or clone-original selected: - combine

If regmarks exist and if ONE mark and another object were selected: - center regmark onto object

If several objects were selected: - search and replace regmarks

If only ONE object was selected: - search and replace regmarks due to sel. size

If objects selected but no group and no locked and not only ONE bitmap: - fill, - none, -
color graduation..., - bitmap..., - layer color

If Ini-entry „defaults“ / „transparency“ on 1: - transparency...

If more than one object or an object with filling was selected: - outline, - none, -
hairstyle, - attributes..., - layer color

If more than one object or an object with wire frame was selected: - layer color or at least one not blocked object selected and Ini-entry „defaults“ / „transparency“ on 1:-
transparency...
If exportable objects are selected and the clipart window is opened: - add to clipart category

### 4.11.2 Context Menu on Empty Working Area

[Image of menu]

Fig. 4.11-1: This menu appears if no objects lie on the desktop

**Job Properties...**

This command opens the following *Job properties dialog*:

[Image of job properties dialog]

Fig. 4.11-2: Job properties dialog with job infos

**Do not sort during output**

This option prevents, if activated, the objects being sorted before or during output. In other words, the original object sorting is retained.

*Note: If this option is activated, the "Do not sort during output" option located in the output dialog is automatically deactivated.*

**Refresh screen**

This instruction refreshes the active window.
4.11.3 Context Menus Node Editing

Import…

This menu entry opens the import dialog for the import of external file formats.

Insert

This menu entry inserts contents from the Windows clipboard to the Stone Cut 2 working area.

Working area

This menu entry opens the dialog for the pre-setting of the parameters of the working area.

Fit Page to Objects

This option scales the working area proportionally in relation to the object size.

4.11.3 Context Menus Node Editing

Systematics of the menu structure:

If no locked objects are selected: - insert (if node selected), - delete (if node selected) - break (if 1 node selected and another one is behind), - join (if 2 nodes selected (start/start or start/end or end/end)) - line (if curves-node selected), - curve (if line-node selected), - new starting point (if 1 node selected and object closed)

If more than 1 node was selected: - sharpen edges, - round edges, - join with line, - join with curve

If 2 nodes within an object or a combination are selected: - hor. object alignment, - vert. object alignment, - reduce nodes

If less than 2 nodes are selected: - reduce nodes, - round..., set origin to sel. node

The menus in the graphical display
4.11.3 Context Menus Node Editing

Start tool path inside or start tool path outside

A start tool path is used in the milling, graving and laser processing. The immersion point of the tool is moved from the original starting point from inwards or outwards. The advantage is that at the later output object no "immersion traces" are visible. Depending on the turning direction and arrangement of the object the start tool path is set inwards or outwards. The parameters for the start tool paths are set in the *tools* menu.

Create regmark at sel. nodes

This option takes care that a regmark is created at the selected node.
4.11.3 Context Menus Node Editing

**Sharpen edge**

This function combines two nodes with two „smooth“ lines. Nodes that lie between the two marked nodes are deleted!

![Fig. 4.11-5: Example for sharpen edge - filled with black the marked nodes](image)

*Indication: If one of the selected nodes lies at an edge the original angle is kept.*

**Round edge**

![Fig. 4.11-6: Example for round edge - filled in black the marked nodes](image)

In the above illustration you can see that the „G“ in the outer left area must be revised. To do this, the nodes above and below the “error” are marked. If now the **round edge**-function is activated the nodes that lie between the marked nodes are deleted and the two dots are connected with a curve.
Join with line

CTRL+G

The two selected nodes are connected with a line. Nodes that lie between the marked nodes are deleted.

Fig. 4.11-7: Example *Connect with line*

Join with curve

CTRL+K

The two selected nodes are connected with a curve. Nodes that lie between the marked nodes are deleted.

Fig. 4.11-8: Example *connect with curve*

Hor. and vert. object alignment

CTRL+H
or CTRL+V

The object in which the nodes are selected are aligned at the horizontal respective vertical.

Fig. 4.11-9: Example for aligning object horizontally relative to the selected (filled with black) nodes
4.11.3 Context Menus Node Editing

![Diagram of a geometric figure with nodes and lines]

Fig. 4.11-10: Example for aligning object vertically relative to the selected (filled with black) nodes

Reduce nodes …

The parameter reduce nodes dialog appears in which following settings can be done:

![Parameter dialog for node reduction]

Fig. 4.11-11: Dialog for the settings of the accuracy of the node reduction

**Precision**

This value influences the conversion of lines to Bezier-curves. The higher the discrepancy the less curve instructions are needed in order to clone the initial line of curves.

**Create curves when angle greater than ... °**

If at a node the angle of the lines is smaller than this limiting value the line of curves is interrupted at this node.

**Create line if difference smaller than ... °**

If a curve is created who"s bending lies within the tolerance value it is converted to a line.
**Node selection**

Select next node

Select next node *additionally*

Select previous node

Deselect last selected node

**Interactively round edges respectively sharpen edges**

If you click with the mouse on a line of curves with the CTRL-button pressed on one, the node will be inserted at this position. This node serves for marking the rounding position. If the second node is selected you can sharpen, round or any other node edition function can be carried out.
4.11.3 Context Menus Node Editing
5 Reference Part Output Preview

5.1 The *Output* Menu

5.1.1 The *Output* Command

Starts the *output* on the connected device with the settings of the *output to device* dialog.

5.2 The *Options* Menu

5.2.1 The *Save As…* Command

The *save as…* command in the *output* preview ... saves the job with all changes that were done in the preview. When returning to the working surface all these settings would be lost, therefore, the job can here be saved under another name.

▶️ please refer to 4.1.6: The *Save as…* Command

5.2.2 The *Rotate Axis* Command

This command rotates the marked objects at 90° counter-clockwise.

▶️ please refer to 4.3.1: The *Rotate Axis* Command

5.2.3 The *Horizontal Mirror* Command

The selected object is mirrored at the horizontal through its center-point.

▶️ please refer to 4.3.3: The *Horizontal Mirror* Command

5.2.4 The *Vertical Mirror* Command

The selected object is mirrored at the vertical through its center-point.

▶️ please refer to 4.3.4: The *Vertical Mirror* Command

5.2.5 The *Optimization…* Command

The foil optimization takes care that all objects are arranged in a way that they take the least space on the foil. By rotation or no rotation of objects it is taken care of, that the material waste can be decreased.
5.2.5 The Optimization… Command

please refer to 3.9.1.1: Foil optimization

5.2.6 The Sort With Simulation… Command

This command opens the sort objects function with which the output order and the direction of rotation can be defined. The sortation can be done dependent or independent on layer. Also, the preferred direction of the sortation can be defined.

In a preview window the output of the objects is simulated graphically; here, the traverse paths of the tool head can also be drafted. The simulation can be done unlimited without changing the original objects.

please refer to 4.3.15: The Sort With Simulation… Command

In detail: please refer to 7.5: The Sort with Simulation… Tool

5.2.7 The Recalculate Command

The recalculate command enables the modification of the output-parameters or of the driver settings without leaving the output routine.

This command switches back from the output preview to the output dialog.

5.2.8 The Initial View Command

Puts back the output preview to the status before having pressed the preview button in the output dialog. All changes are made undone.

5.2.9 The Horizontal Weeding Lines Command

Weeding lines serve for the better processing of big jobs. Material lengths of several meters in length or width are difficult to handle, therefore you can insert weeding lines during the foil cutting that divide the job into smaller parts that are easier to handle.

The horizontal weeding lines are set with the hotkey "h" or drawn with the arrow from the weeding frame dashed in blue.

please refer to 3.9.1.2: Weeding lines

5.2.10 The Vertical Weeding Lines Command

Weeding lines serve for the better processing of big jobs. Material lengths of several meters in length or width are difficult to handle, therefore you can insert weeding lines during the foil cutting that divide the job into smaller
parts that are easier to handle.

The **vertical weeding lines** are set with the hot key "v" or drawn with the arrow from the weeding frame dashed in blue.

▶️ please refer to 3.9.1.2: Weeding lines

### 5.2.11 The Test Drive Command

If the **test drive** command is activated the connected device goes with lifted tool head along the weeding frame. This also happens if the option "weeding frame" was not activated.

Compare **test drive** button in the **output** dialog ▶️ please refer to 3.5.3: Start Output from the Stone Cut 2 Working Surface

### 5.3 The View Menu

#### 5.3.1 The Material Width Command

When activating this command the section is adjusted to the values for the **material width** defined in the driver or set in the **output** dialog.

#### 5.3.2 The All Objects Command

This function changes the display in that way that all objects can be seen on the screen. The section is selected so that it is the biggest possible display showing all objects.

If the SHIFT key is pressed while activating this command, only the selected objects are zoomed to maximum.

#### 5.3.3 The Selected Objects Command

If this command is activated only the **selected objects** from the **output** preview are displayed as large as possible.

#### 5.3.4 The Total Area Command

If this menu item is activated the preview of the whole material surface is shown.

The size of the shown surface depends on the so called frame size (foil height x foil width) of the output device to be accessed.

If in the **output** dialog a driver for a friction feed cutter was selected, in the preview always a material length of 30m (32.81 yd) is shown.

If in the cutting dialog a driver for a flatbed cutter was selected, the maximum width of the flatbed cutter is shown as material length.
5.4 The Window Menu

5.4.1 The New Window Command

Activating this instruction opens a new Stone Cut 2 window.

5.4.2 The Tile Horizontally Command

The activation of this instruction places all open windows diminished - one above the other - horizontally.

5.4.3 The Tile Vertically Command

The activation of this instruction positions all opened windows diminished - side by side - vertically.

5.4.4 The Cascade Command

The confirmation of this instruction displays all windows diminished and cascaded (diagonally displaced).

5.4.5 The Close Command

Clicking this instruction closes the momentarily active window after prior safety query.

5.4.6 The Close All Command

Clicking this instruction closes all open windows after prior safety query.

5.4.7 The Common Tools Command

This instruction switches the Common Tools toolbar on or off. 

CTRL+4

5.4.8 The Object Parameters Command

This instruction switches the object parameters toolbar on the desktop or makes it disappear.

STRG+7

5.4.9 The Status Bar Object Info Command

This instruction switches the status bar object info toolbar on the desktop or makes it disappear.

CTRL+8
5.4.10 The **Status Bar Element Info Command**

This instruction switches the status bar element-info on the desktop or makes it disappear.

5.4.11 The **Active Windows List**

At the below part of the *window* menu instruction list all active jobs are listed.

*Indication: If more than 9 jobs are active it will be indicated by the menu item: further windows.*

5.4.12 The **Further Windows… Command**

This instruction is only visible if more than 9 windows are active. A window with a list of all active windows is opened. A click switches to the wanted window.

5.5 The **Help Menu**

5.5.1 The **About … Command**

The selection of this menu entry opens an info window in which various information is shown. On the left part of the dialog among others the *serial number*, *version number*, *free disk space*, *co-processor*, or *type of processor* are shown. On the right down part of the dialog is a scroll window in which all the application files of the respective application version are listed. This file list can be printed via the *print* button.

*Indication: If there should be problems with your Stone Cut 2 version you can fix them the fastest, if this list is made available to our support staff.*

5.5.2 The **Help… Command**

This option starts the Stone Cut 2 help.

5.5.3 The **Install Autoimport Plug-Ins… Command**

Enabling this command opens the *Corun Installer* window, that lists for which programs plug-ins are available. Programs which were automatically found are marked already. Select the *target* program for the intended data exchange in the *Eurosystems Software* list field.

Pressing the *Install* button starts the installation.
5.5.3 The Install Autoimport Plug-Ins… Command

please refer to 2.3.1: Corun Installer

5.6 Context Menu of The Right Mouse Button

5.6.1 Context Menu Output Preview

<table>
<thead>
<tr>
<th>Material Optimization</th>
<th>Change axis</th>
<th>Hor. Mirror</th>
<th>Vert. Mirror</th>
<th>Weed border</th>
<th>Group</th>
</tr>
</thead>
</table>

Fig. 5.6-1: Context menu of the output preview with weeding frame function

**Weed border**

This function creates a weeding frame around the *selected* objects in the output preview unlike the weed border option.

All other menu entries can be activated via the main menu.
6 Toolbars

6.1 The **Standard** Toolbar

The **standard** toolbar is switched on or off via the `window` menu. 

![Fig. 6.1-1: Freely placeable toolbar - Collection of standard tools](image1)

![Fig. 6.1-2: Fixed standard toolbar](image2)

**BUTTONS FROM 1 TO 15**

1. Create **New window**
2. **Open** job
3. **Save** job
4. **Save all**
5. Edit **job info**
6. **Cut to Clipboard**
7. **Copy to Clipboard**
8. **Paste from Clipboard**
9. **Print objects**
10. **Import file**
11. **Export objects**
12. **Scan image**
13. **Undo**
14. **Redo**
15. **Help**

6.2 The **Setup** Toolbar

The **setup** toolbar is switched on or off via the `window`-menu. 

![Fig. 6.2-1: Freely placeable setup toolbar](image3)

![Fig. 6.2-2: Fixed setup toolbar](image4)

**BUTTONS FROM 1 TO 5**

1. **Cross-hair** on / off
2. **Rulers** on / off
3. **Contour view** on / off
4. **Grid** on / off
5. **Setup working area**

*Indication: Alternatively the working area also can be defined by double clicking on shades of the working area!*

139
6.3 The Node Toolbar

Fig. 6.3-1: Freely placeable node toolbar - collection of node editing tools

**Indication:** The object parameters toolbar (shown below) is switched over to the node toolbar while activating node mode. This happens either by double clicking a node or by clicking node editing button in the common tools toolbar.

Fig. 6.3-2: Freely placeable toolbar - collection of all object parameters

**Tip:** The functions of the node edition that are used the most can be called up via the right mouse button. The allocation of the right mouse button changes, depending if one or several nodes are marked. In detail: please refer to 4.11.3: Context Menus Node Editing

**Indication:** You select several nodes by keeping pressed the SHIFT key and by clicking with the left mouse button on the nodes that you want to mark one after another.

*Round button*

Fig. 6.3-3: Round dialog of nodes

The following setting possibilities are available in the *round* dialog:

**Rounding Inside**

If this button is activated **only** the *selected nodes* or the *whole object* are rounded inside at the given radius depending on the option selected in the dialog.
Rounding Outside

If this button is activated only the selected nodes or the whole object are rounded outside at the given radius depending on the option selected in the dialog.

![Reduce nodes button]

Reduce nodes

If this button is activated in the node edition all redundant nodes are removed which means the object is reduced of those nodes whose removal does not influence the course of the curve.

Attention: The node reduction always refers to the whole object.

![Parameters for node reduction]

Fig. 6.3-4: Settings dialog for the node reduction

![Symmetric node button]

Symmetric node button

With the instruction symmetric node the tangents are created symmetrically which means that both tangents form a line and the check points on both ends have the same distance to the node dot.

![Sharp node button]

Sharp node button

With the instruction sharp node the symmetry and smoothing of a node is removed again. After that, each tangent can be modified. The display of the curve does not change at first.

![Smooth curve button]

Smooth curve button

With this option the tangents of a curve are modified in that way that they form a line. Always the minimum possible modification of the tangents is selected for this. At the position where a line passes into a curve this instruction adapts the tangent exactly to the line.
The advantage of the *smooth curve* instruction is that the transition from curves to lines and the course of the curve is done smoothly. When cutting later unaesthetic offsets are thus avoided.

**Indication:** If on both sides of the dot to be edited there are lines this instruction is not available. When moving tangents both tangents of a curve node loose their symmetric alignment to one another. With the smooth curve-instruction they are turned into a line again.

- **New origin button**

If you want to mill it is important for you to know where the milling cutter starts respectively where the tool first dips into the material to be edited. The origin nodes are marked by a square with an additional contour. This option moves the origin to the previously marked node dot.

- **Open node button**

This option creates open objects. Mark the node dot to be separated and then activate the open node button.

- **Join nodes button**

With this function you can combine open objects with each other. Click with the node cursor on the first node dot. Press the SHIFT key and mark now the second node dot. Marked node dots are / will be filled with black and the status row indicates how many objects are marked respective selected. At the end, activate the join nodes button and the object will be closed.

**Tip:** A second possibility for marking node dots is using the marking function. For marking, draw a frame around the wanted dots with the left mouse button pressed.

**Indication:** The connection is only possible if two nodes are marked that are both end points of an open object.

- **Delete nodes button**

This option deletes the node dot that was previously marked.

If it is an end point of an open object the two adjoining node dots are connected with a line if on one or both sides of the deleted node dots were curves. The node dots are connected to a line if on both sides of the deleted node were lines.

**Indication:** You delete a marked node dot the fastest with the DEL key on your keyboard.

- **Insert node button**

To insert node dots you move the node cursor to the spot on the wire frame of the object where the new node shall be inserted. Then you activate the insert node button.
6.3 The Node Toolbar

Indication: 🌈 **CTRL** - click inserts a node directly at the desired position.

**Connect with curve button** 🌈 K

This option changes lines to curves with tangents.

**Connect with line button** 🌈 G

This option changes curves to lines.

Indication: **All information of the curve is lost.**

**Start Tool Path inside button** 🌈

This option inserts a so called start tool path inside at the selected node. (Special function for routers and lasers).

**Start Tool Path outside button** 🌈

This option inserts a so called start tool path outside at the selected node. (Special function for routers and lasers).

**Align nodes horizontal button** 🌈 H

This option aligns the selected nodes in the horizontal. With a doubleclick on a node - gets red - can be determined by which node is to be aligned.

**Align nodes vertical button** 🌈 V

This option aligns the selected nodes in the vertikal. With a doubleclick on a node - gets red - can be determined by which node is to be aligned.

Alignment buttons

This function aligns the node dots horizontally or vertically accurately.

Mark at least two node dots that shall be aligned accurately and double click on the reference dot. The reference dot is the dot to which shall be aligned.

**Arrange horizontally button** 🌈 H

This function aligns node dots horizontally.

**Arrange vertically button** 🌈 V

This function aligns the node dots vertically.
6.3.1 Direct Input of Coordinates of Node Positions

**Orthogonalize button**

A further possibility to align nodes is to align corners. This function balances nodes that are almost vertical or horizontal to their predecessor or successor nodes. **Orthogonalize** is a combination of align horizontally and vertically. This way, *right angles* can be fast created.

![Fig. 6.3-5: Align corners - before / after](image)

The previous illustration shows the method of operation of the **orthogonalization**. In the left illustration you can see the square in the original state. The down left corner is selected, the *node* toolbar is opened by a double click on this corner. The marked node will be aligned horizontally and vertically to its adjoining nodes. This way, a right angle is created. The result can be seen in the right illustration.

6.3.1 Direct Input of Coordinates of Node Positions

**Position (mm) - horiz.(ontal) and vert.(ical)**

In the *node* toolbar section *position* node dots can be positioned through the input of their X or Y-coordinates. With this positioning you differentiate between *absolute* and *relative* values.

**Absolute values**

With the input of absolute values the entered values are allocated to the *selected* node.

**Relative values**

With the input of relative values the selected node is moved at the given coordinate value in horizontal and vertical direction *relative to the selected* node which means the entered and original coordinates are added.

**Method of operation:**

You first enter the wanted coordinates and keep pressed the SHIFT key while activating the *move* button.

**Horizontal / vertical restriction when drawing lines and curves**

With the CTRL key pressed lines can be restricted vertically or horizontally which means that the movement of the line is only possible in one direction.
When drawing curves the curve is deformed. The deformation depends on the selected contact point as you can see in the following illustration.

*Indication: The node attribute smooth is automatically saved if the selected and following nodes are a curve.*

*Tip: The zoom functions are also active in the node editing mode.*

Radius

In the window right next to the buttons mentioned above the *radius* with which the node or nodes shall be rounded can be set.

Narrow objects

Here, you can select between two options:

If the option *use smaller radius* is selected Stone Cut 2 calculates the radius that still is applicable for the rounding of this narrow object.

When selecting the *do not round* -option it is not rounded with narrow objects.
6.4 The **Object Tools** Toolbar

The **Object Tools** toolbar is switched on or off via the Window menu. 

**Indication:** Depending on the used EUROSYSTEMS software some of the listed tools can be missing.

---

**Fig. 6.4-1:** Freely placeable toolbar - collection of object tools

**Fig. 6.4-2:** Anchored toolbar

**BUTTONS FROM 1 TO 21**

1. **Delete Objects**
2. **Do Axis Change** with Objects
3. **Horizontal Mirror** of Selected Objects
4. **Vertical Mirror** of Selected Objects
5. **Group** Objects
6. **Ungroup** Objects
7. **Combine** Objects
8. **Release Combination** of Objects
9. **Generate** Block Shadow
10. **Align** Objects
11. **Close** Objects
12. **Open** Objects
13. **Round** Objects
14. **Delete Redundant Nodes**
15. **Vectorize** Objects
16. **Generate** Contour Line
17. **Start** Foil Optimization
18. **Set** Start Tool Paths
19. **Hatch** Objects
20. **Generate** Out- or Inlines
21. **Weld** Objects
6.5 The Object Parameter Toolbar

![Image of Object Parameter Toolbar]

Fig. 6.5-1: Freely placeable toolbar - collection of object parameters

![Image of Object Parameters Toolbar with Explanations]

Fig. 6.5-2: Object parameters toolbar with explanations

6.5.1 The Multi Copy Command

Definition: Multi Copy = Multiple copies of selected objects (Duplicates)

6.5.1.1 The Multi Copy Button

Pressing the button opens the following dialog:

![Image of Duplicate Dialog]

6.5.1.2 Copies X:

Using the or button the number of duplicates can be increased or decreased in increments of one. The alignment is done in the Main Direction. Alternatively, any integer value may be entered in the field.
6.5.1 The Multi Copy Command

6.5.1.3 Copies Y:

Using the \( \text{\textdagger} \) or \( \text{\textdaggerdbl} \)-button the number of duplicates can be increased or decreased in increments of one. The alignment is done in the \textit{Main Direction}. Alternatively, any integer value may be entered in the field.

6.5.1.4 Offset X:

This value determines the distance between the duplicates in X-Axis direction.

6.5.1.5 Offset Y:

This value determines the distance between the duplicates in Y-Axis direction.

6.5.1.6 The \textit{Select Objects} Option

If this option is enabled, all duplicates will be selected finally.

6.5.1.7 The \textit{Fill Working Area} Option

If this option is enabled, then the working sheet only and not the desktop is filled with duplicates.

\textit{Note: Enabling this option, de-activates the Copies X and Copies Y fields.}

6.5.1.8 The \textit{Create Clones} Option

If this option is enabled, then the selected object is uses as control object for cloning. All duplicates are generated as clone objects.

6.5.1.9 The \textit{Group Result} Option

Enabling this option groups all duplicates finally.

6.5.1.10 The \textit{Optimize Traverse Path} Option

If this option is enabled, duplicates are generated in meanders. This reduces the head movement of the output device and shortens the output process.

\textit{Note: The main direction option defines additionally, if meandering is done in X-Axis or Y-Axis direction.}

6.5.1.11 The \textit{Main Direction} Option

The \( \text{\textdagger} \) button sorts the duplicates in Y-Axis direction - "column by column". The \( \text{\textdaggerdbl} \)-button sorts the duplicates in Y-Axis direction - "line by line".
6.6 The Status Line **Object Info**

This status line informs about the properties and attributes of objects on the Stone Cut 2 desktop. This information comprises number, type of object, color model, color value and many other data important for the evaluation.

![Status line for the display of object properties, color spaces, etc. - free floating](image1)

![Status line for the display of object properties, color spaces, etc. - fixed](image2)

6.7 The Status Line **Element Info**

This status line indicates the current mouse cursor position in x/y-coordinates. In addition, in the left part next to the cursor coordinates subsidiary texts and additional texts from the layer info for example from the field *material name* are displayed. It is also possible to show driver information as for example the set tool depth for a particular layer.

![Status line element with subsidiary texts and element information, here coordinates](image3)

6.8 The **Preview Tools** Toolbar

**The Arrow Tool**

This mode allows you to *mark, move, group temporarily* (marking function) and *modify the size* of objects in the *output* preview.

**The Magnifying Glass+**

The button with the (+) plus sign increases parts of the output preview. Draw with the marking function a frame around the area that shall be increased. This function can be carried out successively several times until a beep reminds acoustically of the last possible step.

**The Magnifying Glass−**

The button with the (-) minus sign decreases *gradually* parts of the desktop or of the working area.

**The Sheet**

![Preview tools toolbar](image4)
6.8 The Preview Tools Toolbar

The button with the symbolic sheet of paper shows the material area increased to the maximum

**The Screen**

The button that symbolizes a screen displays all objects on the material area as big as possible. The section is thus selected that is it the biggest possible display with all objects visible.

**The Magnifying Glass for Selected Objects**

The „dotted loupe“ button displays all selected objects as big as possible.

**The Measure Tool**

This tool serves for the determination and the percental modification of object dimensions.

**The Output Command**

The activation of this button gives the data to the Plot-Manager for the output to the connected device.
6.9 The **Preview Object Parameters Toolbar**

The *preview object parameters* toolbar is activated with the following shortcut.

**Indication:** It is identical with not variable part of the object parameters toolbar in previous Stone Cut 2 versions.

![Object parameter toolbar](image)

Fig. 6.9-1: Object parameter toolbar with position, size, angle, multi copy, ...

**Note:** The display of the object parameters toolbar varies depending on how the object properties are set!
6.9 The Preview Object Parameters Toolbar
7 Tools

7.1 The Desktop

After starting Stone Cut 2 the desktop with the working area appears as follows:

![Stone Cut 2 Desktop](image)

The **working area** is marked by a black frame that has on the right and below a gray shade. The working area serves for the orientation and dimensioning.

The **rulers** can be freely positioned or completely switched off. The **layer** toolbar is integrated into the Sidebar. The **metric** (cm, mm, inch) can be directly changed via a button that is within the angle of the two rulers. Also ruler's origin can be changed. Following options are available: Set Origin to Absolute Coordinates, Move Origin, Reset Origin, Set Origin to Center of Page, Show Origin and Release Origin.

In the **status line** you find much information about the objects on the working area. For example the **wire frame**, **filling**, **object dimensions**, **-number**, **combination** or **grouping** are displayed.
### 7.1.1 Cursor forms on the working area and their meaning

<table>
<thead>
<tr>
<th>Cursor form</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>no object marked or selected</td>
<td></td>
</tr>
</tbody>
</table>

*Indication:* You mark objects by positioning the mouse cursor above the object and pressing the left mouse button.

<table>
<thead>
<tr>
<th>Cursor form</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move objects</td>
<td></td>
</tr>
</tbody>
</table>

*Indication:* This cursor is only active if the cursor is within the range of the inner part of the object or in the range between the 8 black squares on the wire frame line. The object must be marked.

<table>
<thead>
<tr>
<th>Cursor form</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase object vertically</td>
<td></td>
</tr>
<tr>
<td>Increase object horizontally</td>
<td></td>
</tr>
<tr>
<td>Increase object diagonally</td>
<td></td>
</tr>
</tbody>
</table>

*Indication:* The cursors for the modification of the object size are only active if the cursor is within the range of the 8 black squares on the wire frame line of the object. You switch to the skewing-/rotation-mode by clicking with the left mouse button with active cross cursor (see above move objects).

<table>
<thead>
<tr>
<th>Cursor form</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object in the skew/rotate-mode</td>
<td></td>
</tr>
<tr>
<td>Rotate object</td>
<td></td>
</tr>
<tr>
<td>Skew object (set tilted horizontally/vertically)</td>
<td></td>
</tr>
</tbody>
</table>
7.2 The Outline Function

This function is activated via the button in the variable part of the object toolbar or via the tools menu, menu entry Outline…

The outline function creates contours in a freely definable distance around graphical and text objects.

Fig. 7.2-1: Outline parameter window

Type Area

Outline

The option Outline creates a contour line to the outside around the selected objects.

Note: If there are objects within other objects, then an inline from the inner object is created.

Inline

The option Inline creates a contour line inside the selected objects.
7.2 The Outline Function

_in_/Outline

The _In / Outline_ option creates a contour line outwards and inwards around the selected objects.

Corners Area

The _corner treatment_ can be influenced by three additional options. The preview shows how the selected option affects the contours.

_Do not change_

The option _do not modify corners_ creates the mathematical accurate dot on the outline to each corner dot. This leads to the fact that in pointed corners the outline is extended endlessly which often leads to unaesthetic results. Therefore the option _cut corners_ is pre-defined as default. This option shortens the extension up to the value that is entered in the field _tolerance_.

_Cut off_

This option truncates the extension up to the value entered in the _Tolerance_ field.

_Round_

Rounding corners converts the corner point into a rounded curve. The field _Tolerance_ indicates, in which distance of the corner point is rounded off.

_Spacing_

The desired value for the distance of the inner or outer contour from the original object is entered in the _Spacing_ field.

_Number of copies_

The _Number of copies_ option specifies how many Inlines or Outlines are to be created simultaneously during a function call.

_Min. Object size_

This value defines from which object size a contour is generated. It prevents the creation of small parts that can not be weeded.

_Tolerance_

The field _Tolerance_ indicates how much is cut off or rounded off. The value 1 equates approximately the spacing value.

_Options_
**Automatic welding**

*Automatic welding* means that all overlappings of the generated contour lines will be removed.

**Delete original**

If the button *Delete original* is activated, the original object is deleted after creating the contours.

**Do not create interior elements**

This option suppresses the automatic generation of an inner contour.

**Node reduction**

If this option is activated, the number of nodes required for the contour line will be reduced as much as possible without losing accuracy.

**Create parallel at open objects**

If this option is activated, parallel lines will be created next to the selected open object instead of a closed outline.

**Target layer**

The *target layer* option allows the preselection of the layer into which the contour lines are laid.

*Note: It is possible to pre-select the tool since the layers can be preconfigured with a tool.*
7.3 The Undo Redo Stack

The undo redo stack is activated via following key combination:

SHIFT+F5 or SHIFT+F6

These functions can undo or redo all object-related actions.

**Indication:** Actions that refer for example to the working area, the desktop or the layer-toolbar are not taken into the stack.

The pre-settings in the settings menu, submenu miscellaneous

The **Undo Redo** stack related settings as for example the number of stack actions is carried out in the following setup dialog.

**Indication:** The maximum number of the undo steps can only be modified with no objects on the working area.

---

![Setup - Miscellaneous](image)

**Fig. 7.3-1:** The parameter of the undo stack (here: marked in red)
The area **undo function** comprises the settings that effect the undo stack.

![Undo Stack Diagram](image)

Fig. 7.3-2: Undo stack with preview window and working area

In the left stack the action can be selected up to which you want to go back. The preview window shows the status of the working area and of the objects on the working area at the moment of the action.

The **redo** stack operates in the same way.
7.4 The Alignment Function

This function aligns two or more marked objects to each other or to the working area.

Objects can be aligned horizontally or vertically. A centered alignment is also possible as the selection of the same distance between the marked objects. The type of alignment is illustrated by icons. Setting can be stored by pressing the **Save settings** button.

*Indication: The last marked or drawn object serves for alignment as reference object, that means that all others are aligned in the same way. If alignment is not ‘Align to Page’, then alignment will refer to the last selection.*
7.5 The **Sort with Simulation...** Tool

This tool serves for the *sortation of objects* and the *determination of sequences* before the output at the connected device. A simulation with or without complete path of the device tools facilitates the estimation of the results.

![Sort with Simulation Tool](image)

**Fig. 7.5-1:** Object-sortation with preview-window and simulation option

### 7.5.1 Zone A1 - Object Position, Color Bar, ...

**Object Position and Rotation**

The *object position* column indicates the *object number* and the *coordinates of the objects on the work surface in the X / Y direction*. The *rotation* column indicates whether the object contour is rotated *clockwise ""* or *counterclockwise """"*.

**Color Bar**

A click on the wanted color bar selects the respective color layer.
7.5.1 Zone A1 - Object Position, Color Bar, …

The **Select All Button**

Clicking on this button selects all objects in the list.

The **Deselect all Button**

Clicking on this button deselects all objects of the list.

The **Toggle rotation Button**

This option modifies the orientation from clockwise (right) to counterclockwise (left) and vice versa.

**Connect / close objects with "OK" Option**

This option ensures that open objects are automatically closed when the dialog is closed with the "OK" button.

**View selection Option**

Shows the selected objects in the preview window

**Single selection Option**

In the list only one object can be selected; the multi-selection (standard) is deactivated.

**View complete path Option**

A blue dashed line shows the track that the tool head covers.

**Don’t sort at output Option**

This option prevents object sorting at output.

**7.5.1.1 Layer-dependent Sorting**

**All Layer Option**

This option will include all layers in the sort if layer-dependent sorting is enabled.

*Note: This option is disabled in the output preview, depending on the driver setting.*

**Selected Layer Option**

This option only applies the selected layer to the sort, if layer-dependent sorting has been activated.
7.5.2 Zone A2 - The Simulator

The simulator is used to test and evaluate all settings before output. The operation of the simulator is similar to a DVD-player.

*Lo* (low) up to *Hi* (high) regulates the speed of the simulation display.

*Indication: Before simulation, in addition to orientation, you have to do sorting by clicking on the sort button.*

![Option View complete path activated (blue dashed lines)](image)

7.5.3 Zone A3

7.5.3.1 Options

*By Main Direction*

If this option is activated, the main direction (area) is visible.

*By Nearest Object*

If this option is activated, the **nearest object (area)** becomes visible.
7.5.3 Zone A3

**Reposition origins to**

In this option the start point is set: Possible settings are: unchanged, lower left, upper left, lower right, upper right.

### 7.5.3.2 Zone A3.1 - Main Direction (Area)

**Main Direction**

16 methods can be activated as main direction for the sortation. The icon shows with a red arrow where sortation begins.

**Max. deviation in ... mm**

In the input field can be entered the value for the maximum deviation of the imaginary vertical respective horizontal line that an object may have in order to be sorted.

### 7.5.3.3 Zone A3.2 - Nearest Object (Area)

**Optimize origin of objects Option**

The aim of this option is to minimize empty runs. Enabling this option checks, which node of the following object is closest to the first start point. The first is established; Then it is examined which node of the following object is closest to the start point.

The simulator can be used to check whether the desired optimization is achieved. Usually the variant, which has the shortest travel distance, is to be regarded as optimal. In
individual cases, however, other criteria can also be decisive.

*Note: If this option is active, the "Reposition origins to" option in the Options (area) is disabled.*

**Begin with object at Option**

This option determines which start object is taken into account during sorting. Possible choices: lower left, upper left, upper right, lower right.

**Focus: Simulation with start point optimization**

In addition to the other traverse path optimizations, the starting point of the objects can be moved automatically so that the tool head shifts as little as possible. The figure on the right shows the starting points of the contour objects, represented by an arrow, before and after the optimization. The direction of the arrow shows the orientation - clockwise or counterclockwise.

![Fig. 7.5-4: Before origin optimization](image1)

![Fig. 7.5-5: After origin optimization](image2)

**7.5.4 Zone A4 - Sorting, Settings, …**

**Path length Field**

This field displays the realistic traverse path length of the tool measured during the simulation.

The **Sort Button**

Only the Sort button activates the object sorting. You can then check in the simulation whether the sorting meets your requirements.

The **Reset Button**

Resets the objects in the sort-list to the initial values
7.5.4 Zone A4 - Sorting, Settings, …

The **Apply settings for output Button**

This option saves the changes made in the **Sorting with simulation dialog**.

The **Settings for output Button**

Clicking on the **Settings for output button** opens the following dialog:

*Note: The settings made here are job-spanning and are the default settings for output.*

▶ please refer to 3.5.3: Start Output from the Stone Cut 2 Working Surface

7.5.4.1 The **Sort Settings Tab**

![Fig. 7.5-6: Sort settings tab with main direction (Area) active](image)

7.5.4.2 Options (Area)

**Main direction Option**

If this option is activated, the **main direction (area)** is visible. The desired main direction is selected via mouse click. (See figure above)

**Next object Option**

If this option is activated, the **nearest object (area)** becomes visible.
Nearest object (Area)

*Start point optimization Option*

See above: Focus: Simulation with start point optimization

*Start object Option*

In this option the start point is defined: Possible settings are: unchanged, lower left, upper left, upper right, lower right.

*Note: The selection of the starting point has an effect on the traverse path length. In the simulator, the shortest path can be evaluated.*

7.5.4.3 Main direction (Area)

In this area, all possible preferential directions are displayed graphically. The desired preferential direction is selected by mouse click. The icon shows a red arrow where the sorting is started.

*Max. deviation in ... mm*

In the input field can be entered the value for the maximum deviation of the imaginary vertical respective horizontal line that an object may have in order to be sorted.
7.6 The Welding Tool

This function is activated via the button in the variable part of the object toolbar or via the tools menu, menu entry welding...

This function welds two or more vector objects with each other to a combination. Depending on the number and the form of the selected objects you can choose between the following options: manually, automatically, trim (cuts objects with lines or curves), open trimming, fill, by color, full area or screen printing.

Fig. 7.6-1: Tools menu - welding submenu

Dialog...

The activation of this submenu opens the following dialog

![Welding dialog]

Fig. 7.6-2: Welding dialog

Manually

Manually separates all intersections that occur because of the overlapping of outlines and creates object parts. With the arrow-function you mark the object parts that you want to remove. With the DEL-button the selected object parts are deleted. Overlapping-free
object parts are kept and can later be further edited. The original color of the object parts are kept with the manual welding.

**Automatically**

**Automatically** calculates the common areas of the objects. All overlapping parts are combined, transparent interior elements are considered.

*Indication: With this option, objects of different colors are welded to a combination object.*

If the object colors shall be considered please select the options **by color, full area** or **screen printing**.

The option **automatically** is especially suitable for the welding of serifs with scripts. The serif of the previous letter overlaps often with the successive character. The material would be slit at these positions without welding. The automatic welding eliminates this overlapping and takes care of a cuttable transition in the serifs.

*Tip: If single parts are missing after the automatic welding, then reduce the character spacing in the text editor from 100% to 99%. This causes that identical node dots that lie on top of each other are misplaced so that they are recognized also as single nodes and the welding routine is carried out properly.*

**Trimming**

**Trimming** means that you cut through closed objects with lines or curve objects and that the object parts that are thus being created are automatically closed afterwards. Depending on your request you can lay one or more objects over the objects to be slit like a "knife". If you want to work with several "knives" these objects must be allocated to the same layer or be combined. Then, by means of the **trimming**-option, the objects lying underneath are cut alongside the "knives". Also cutting in several "tilings" is possible without problems as the knifes can overlap at discretion. The parts having thus being created are then sorted according to their position and combined to single groups.

**Open trimming**

The **open trimming** works like the trimming with the difference that cut-off points of the cut objects are not closed automatically but kept as open objects.

**Fill**

Fill provides objects that consist of arbitrary many other objects with a fill consisting of the other objects. Depending on your choice, the topmost object or objects of a layer are filled with the ones underneath.

*Indication: Please pay attention that the objects to be filled must be closed. Only this way you limit an area that can be filled.*
7.6.1 Mask

By color

*By color* removes all areas that are hidden by colors lying above. It does not matter how many objects and colors you select. If open objects are also selected they can be closed or provided with a line weight.

Full area

The option *full area* underfills objects of one color whose areas hide those of another. To do this, the partially hidden objects are modified so that they underlay completely the ones lying above. Here, you can also proceed with the open objects as described under *automatically*.

*Tip: The mostly used field of application is the showcase labeling where the by color-option is often too laborious to be pasted over. With 2 maximum 3 foil colors you take the full surface option where the single foil colors are pasted above the other.*

Screen printing

The welding option *screen printing* is an especially efficient tool for the screen printer. At first, the overlappings of the single coatings are removed. Then, the colors are layered according to the sequence in the field *color sequence*. At the end, a small bar is inserted at the *seams* between the single color layers as overlapping.

*The color stack with the screen printing-welding*

*Modification of the color stack:* With the screen printing, the printing sequence is from bright to dark. Brighter colors are printed before the darker colors. By mouse click a coating is grabbed and drawn to the wanted position. The color stack reflects the position of the layers above the medium. The output sequence considers the modifications of the color stack.

Delete original

With the checkbox *delete original* you set if the initial objects shall be deleted after the welding process or not.

7.6.1 Mask

Topmost object

If this option is activated the *topmost object* can be defined as welding object with the welding functions *trim, open trim* and *fill*.

Topmost color

If this option is activated all objects of the above lying color can be defined as welding object with the welding functions *trim, open trim* and *fill*.
Provide open objects with contour … mm

If open objects are amongst the selected you can indicate with the option *provide open objects with contour …* which thickness the created closed object shall have.

Do not correct appearance of combinations

With this option combinations are treated that they are welded as displayed in the full surface mode. Overlays in combinations remain transparent.

Join same colors

It can happen that the same color reappears in different group- or combination objects. Then, select the option *join same colors* so that those merge to one color layer.

*Indication: This is especially important with the creation of screen printing templates as with the screen printing process the darkest color is always spread at last in order to prevent possible white gap that might occur while mounting the single colors.*

Remove identical lines

With this option all vectors that are identical are removed but one.

7.6.2 Seams

Underlap - Offset

These options can only be activated with *by color*. In the field *overlay* you can enter the value for the *underlap* or the offset.

Overlay … mm

If the option *screen printing* is activated you can enter here the value for the *overlay* of the colors in mm.

Complete overlay up to:

Here, you can additionally enter the limit up to which width it shall be completely overlaid.
7.7 The Contour (Line) Function

With the **contour line** function the outer edge of arbitrary many objects is calculated and provided with a wire frame line. Contrary to the outline you can contour also bitmaps with this tool. In addition, not every single object is outlined. Instead, it is tried to possibly find one contour that comprises all selected objects. This function is therefore especially suited for the creation of cutting lines around labels. The objects of the label can be arranged arbitrarily.

Then the wire frame of the object is calculated in the wanted distance with the tool described here. The contour line thus created can be used later for cutting out the printed label.

First select the objects that you want to contour / outline. Then select **contour...** in the **tool** menu.

The following dialog for the creation of the parameters appears:

![Contour Line Dialog](image)

**Fig. 7.7-1: Parameter dialog for the creation of contour lines**

**Find contour**

With the fields in the dialog group **find contour** you can influence the calculation of the wire frame line. Generally, all objects that are not white are considered with the contour finding. Ideally, the background of the graphic to be contoured should therefore be white. But especially bitmaps contain often light gray spots that can occur when scanning.

**Maximum gray scale**

With the option **maximum gray scale** you can determine that gray spots above the selected intensity are **not** contoured. You can enter values between 50 and 99% or set them with the roll bar. 50% correspond to a relatively dark gray and 99% to an almost white color.
Accuracy

In the field **accuracy** you can select between three options. The low accuracy works the fastest. If the result is not satisfying with this setting, select the middle or a higher accuracy. The calculation of the contour line then takes a little bit longer.

*Indication: The field accuracy is not activated if only a single bitmap was selected.*

Keep interior elements

If the option **keep interior elements** is activated, possibly created interior elements are not deleted. This way you have the possibility to cut out parts of the graphic by applying a brighter "plaster".

Look at the following illustration for this:

![Fig. 7.7-2: Option: keep interior elements](image)

On the left side you see the two initial objects. A smaller white circle is put onto the black circle. On the right, the calculated contour line is displayed. The option **keep interior elements** was active, also the inner circle was considered at the contour finding. With the dialog field switched off, only the outer contour would have been created.

*Indication: As default, keep interior elements should be switched off.*

Distance and line guidance

In the second dialog group **distance and line guidance** you can influence the appearance of the contour line.

Contour offset

With **contour offset** you determine how far away the wire frame line shall be from the graphic. If you enter here the value "0" a contour line is created that directly is attached to the edge of the selected objects. With values smaller than 0 the contour line goes into the contoured objects.

Corner shape

The option **corner shape** determines how the contour line acts at salient corners.

Normal creates the mathematical exact dot on the contour to every corner dot. The contour line can thus be lengthened very far at sharp corners, which often leads to unaesthetic results. The options **cut off** and **round** lead to more satisfying results in such cases.
7.7 The Contour (Line) Function

**Cut off**

Cut off shortens the contour at the indicated distance and cuts off the corner by a section.

**Round**

Round leads the corner dot to a rounded curve.

**Color**

On the right side of the dialog you can see a color selection field. A click on the *change button* opens the *color selection* dialog. With this dialog you can allocate colors to contours.

**Destination Layer**

This Field determines in which color layer - in doing so indirectly, with which tool - the contour line is processed.

*Note: The contour line color can be different in the full surface mode (print) and the contour mode (output).*
7.8 The **Job Info**

The job info can be opened in three ways:

1. Via the *edit* menu / menu item *job info*...
2. Automatically when saving a new job
3. Via the so named menu item in the context sensitive menu (right mouse button)

![Job info main window](image)

**Fig. 7.8-1: Job info main window**

With the job info you have the possibility to save additional information to each job. This information can be printed and used for the invoicing or as accompanying ticket to jobs. If the job info is printed, also the complete path in which the job was saved is printed.

Besides information as for example *order number* and *company* address the job info gives information about the used *materials, duration of the production, number* of cut / printed jobs as well as the intended or calculated *price*. In the *memo* field keyword comments can be saved.

In the *settings* menu / menu item *standard settings* / menu item *job info*... the job info can be extended by arbitrary many fields.

**Indication:** *The information under the field media are only inserted automatically, if you have given these information to the respective color layer in the layer settings dialog and selected the adequate palettes at the design. Further information about*
7.8 The Job Info

This can be found here: please refer to 8.3.6: II. Layer Settings Color Setup

Tip: The switch between the single fields is done the fastest way with the TABULATOR key.

To each job following restrictions can be added:

**No output**

This job cannot be output.

**No export**

This job cannot be exported and thus cannot be converted to another format.

**No printing**

This job cannot be printed.

**No saving**

This job cannot be saved.

**Password protection**

In addition to the restrictions described above, a password can be given to each Stone Cut 2 job. This way, the unauthorized access to these job data is not possible.
Fig. 7.8-3: Dialog for the determination of a job password
7.9 The Plot Manager

The Plot Manager has the following tasks:

7.9.1 Creation And Modification of Device Configurations

With the Plot Manager it is possible to create a device configuration or short, to create an output device. In a device all information necessary for the output of the data as for example driver and ports are summarized.

In Stone Cut 2, these devices then can be used for the output of the graphics. It is possible, to output simultaneously at several devices.

7.9.2 Monitoring the Output Processes of the Jobs

The outputs to the respective devices can be monitored with the Plot Manager, for example the output can be broken or aborted and the sequence of the jobs can be changed retroactively.

7.9.3 Output of Data to Local Ports

The serial and parallel ports of the computer are identified and can be used for the file output.

7.9.4 Administration of Hotfolders

A function independent of Stone Cut 2 is the administration of Hotfolder. A Hotfolder is a directory monitored by the Plot Manager. If a file is copied to this directory the Plot Manager carries out automatically certain configurable functions.

7.9.5 Plot Server Function

The Plot Manager can enable devices so that other Plot Managers can use these enabled devices. This allows separating design and output working places.

Important note: You start the Plot Manager with a double click on the icon that is down right of the screen in the task bar.
7.9.6 Devices Folder

Each device possesses three device folders in which the jobs are shown:

*Indication: with jobs, also those output actions are meant that are carried out by Hotfolders or on local ports.*

**Devices Folder 1**

*Active Jobs*

All jobs that shall be output as soon as the device is ready are collected in this folder. If a job has been output completely, the next job is output. If the option „show message window before output of a job“ is active, a notification dialog is shown before each output.

**Devices Folder 2**

*Passive Jobs*

If the output device is broken, all jobs to be output are moved to this folder.

**Devices Folder 3**

*Saved Jobs*

Here, all jobs that have been output are saved. The number of the saved jobs can be indicated in the options dialog of the device. If the number of the saved jobs is reached the
7.9.6 Devices Folder

next one to be saved replaces the oldest existing job.

Job Functions

The functions differ according to device folder, device type and job status.

_Indication: The functions can be carried out via a context menu._

7.9.6.1 Jobs at local devices

**Active Jobs**
If the job is being output:

*Pause*
The output of the data is paused. The job is marked with the ⚪ symbol.

*Paused Jobs*

*Continue*
The output is continued.

*Set Job to passive*
The job is removed from the list of the active jobs and added to the folder of the passive jobs.

*Delete Job*
The job is deleted.

**Passive Jobs**

*Activate Job*
The job is removed from the list of the passive jobs and added to the folder of the active jobs.

*Delete Job*
The job is deleted.

*User message:* to this job, a notification text can be entered. This information is shown if the job shall be output respective if it is selected.

**Saved Jobs**

*Activate Job*
The job is removed from the list of the output jobs and added to the folders of the passive or active jobs depending on the setup device.

*Delete Job*
The job is deleted.

*Plot to File*
Here you can determine if the job shall be output to a file.
Save as
Save job data into file before cut data processing.

### 7.9.6.2 Jobs at Plot Servers

**Active Jobs**
No functions

**Passive Jobs**

*Activate Job*
The job is removed from the list of the passive jobs and added to the folder of the active jobs.

*Delete Job*
The job is deleted.

*User message:* To this job, a notification text can be entered. This information is shown if the job shall be output respective if it is selected.

**Saved Jobs**

*Activate Job*
The job is removed from the list of the output jobs and added to the folder of the passive or active jobs depending to the setup device.

*Delete job*
The job is deleted.

*Save as*
Save job data into file before cut data processing.

### 7.9.6.3 Jobs at Hotfolders

**Active Jobs**
No functions

**Passive Jobs**

*Activate Job*
The job is removed from the list of the passive jobs and added to the folder of the active jobs.

*Delete Job*
The job is deleted.

*User message:* To this job, a notification text can be entered. This information is shown if the job shall be output respective if it is selected.
7.9.6 Devices Folder

**Saved Jobs**

**Activate Job**
The job is removed from the list of the output jobs and added to the folder of the passive or active jobs depending to the setup device.

**Delete Job**
The job is deleted.

**Save as**
Save job data into file before cut data processing.

7.9.6.4 Jobs at local ports

**Active Jobs**
If the job is being output:

**Pause**
The output of the data is broken. The job is marked with the ● symbol.

**Paused Jobs**

**Continue**
The output is continued.

**Set Job to passive**
The job is removed from the list of the active jobs and added to the folder of the passive jobs.

**Delete Job**
The job is deleted.

**Passive Jobs**

**Activate Job**
The job is removed from the list of the passive jobs and added to the folder of the active jobs.

**Delete Job**
The job is deleted.

**Notification:** To this job, a notification text can be entered. This information is shown if the job shall be output respective if it is selected.

**Saved Jobs**

**Activate Job**
The job is removed from the list of the output jobs and added to the folder of the passive or active jobs depending to the setup device.
Delete Job
The job is deleted.

Plot to File
Here you can determine if the job shall be output to a file.

Save as
Save job data into file before cut data processing.

7.9.7 Settings of the Plot Manager

![Settings dialog]

Fig. 7.9-2: Optional parameters for the Plot-Manager

If the option is activated *Plot Manager always on top*, the Plot Manager window remains always in the foreground.

If the option *tooltips* is activated, a short description to a dialog element is shown if the mouse pointer remains above the dialog element.

If the option *view job preview* is activated a preview of the output data is shown.

Command line parameters

If the Plot-Manager is started without parameters it checks all devices if there are jobs for processing.
If a job was found it is carried out. It stops if no jobs were found or if all jobs have been processed.

If, when calling up the parameter *!SPOOL!* is given, the Plot Manager remains active. It then has to be terminated manually with a right mouse click onto the symbol in the taskbar.

Hotfolder

With a Hotfolder a directory can be monitored. If a file is copied to the directory to be monitored one of the following actions is carried out automatically depending on the settings:
7.9.7 Settings of the Plot Manager

Fig. 7.9-3: Example for setup devices of a Hotfolder

**Settings**

*Hotfolder name:* here you have to enter the name of the Hotfolder

*File mask:* here, the file name ending are given, that shall be considered, for example *.plt.

*Hotfolder directory:* here, it is determined which directory the Hotfolder shall monitor.

**Output**

*COM/LPT:* the file is output to a local serial respective parallel port.

*USB:* the file is output to a USB device. A USB device is only shown if it is connected with the computer.

*TCP/IP:* the file is send to a TCP/IP address. With some addresses, you additionally have to enter the right port number.

*Spooller:* the file is output via a printer driver.

*File:* the file is copied to the output directory. An existing file with the same name is overwritten.
After having carried out the action, the input file is deleted.

*Indication: if "file" is set as output, the application is started after the copy. In all other cases, the application is started before the output.*

**Extended Settings**

*Start application if Hotfolder becomes active:* in addition, another application can be started that shall further process the input file to be processed. The file name is marked with %s.

*RIP:* only necessary if Pjannto RIP uses this Hotfolder as RIP Hotfolder.

*Mask:* formatting of the output file name: %File file name; date/time: %Y-%d_%H-%M-%S year/month/day: hour/second/minute

*Change defaults:* prevents that the user modifies the output parameters accidentally.

**7.9.7.1 Device Options**

In the **Device Options** window you can set - for each device which is listed in the Plot Manager - the following device options.

*Note: This window will be enabled by clicking with the right mouse button on a device item and selecting the Options menu item.*

Fig. 7.9-4: Additional options for each device

**Maximal number of saved output files**

The registered value of this option limits the number of saved output jobs for this device in the history of stored files.

**Number of outputs (of a Job)**

The registered value of this option defines how often active Jobs will be given out.
7.9.7 Settings of the Plot Manager

**Inform user before output**

If this option is enabled, then a message window will be shown, before the outputting of each Job. This gives the user the opportunity to prepare the machine before the data output.

![Process job window](image)

**Plot to File**

If this option is enabled, then the output is redirected to a file. Before writing the file to the **Job Save As** dialog is enabled.

**Activate Sound Signal**

If this option is enabled, then an individual sound signal will be given out before each output of a Job, in order to draw attention to the user. A sound file in the WAV file format can be selected using the ![Movement... button](image).

**The Movement... Button**

![Tool Movements window](image)

Fig. 7.9-5: Distances of the used tools

This feature tracks the distance (tool motion), from every tool of the activated output device in meters. In addition to the distance, date and time of each output are given.
7.10 The PhotoCUT Function

PhotoCUT creates vectors out of bitmaps. PhotoCUT calculates from Windows bitmap files (*.BMP, *.PCX, *.TIF) raster strips or patterns that can be output with a cutting plotter. The picture is divided in logical pixel and the average gray value detected for each of these logical pixel. A picture is created that has fewer pixels than the original. Then, horizontal or vertical strips, circles, squares, ... are created from this picture whose width is proportional to the gray value at the respective position.

7.10.1 The PhotoCUT Dialog

Open the PhotoCUT dialog by selecting the so named menu item in the tools menu.

![PhotoCUT Dialog](image)

Fig. 7.10-1: Dialog with parameter-setup

**General settings**

**Pixel in X-direction**

In this field, enter the number of pixel that shall be combined to a logical pixel in X-direction. The smaller the value in this field, the better the output quality of the “picture”.
7.10.1 The PhotoCUT Dialog

Pixel in Y-direction

In this field, enter the number of pixel that shall be combined to a logical pixel in **Y-orientation**. The smaller the value in this field, the better the output quality of the "picture".

Remaining width

This value determines the remaining width of a strip (only with strips) in mm of the line respective column size.

Excursion: contrast (adjust via image menu contrast)

Because of the division of the bitmaps into logical pixel the line respective column size is determined. The width of a strip depends on the set gray value and the contrast. The maximum width is line respective column size minus the value of the remaining width.

Corresponding to the contrast value the width of the strip is identified by the average shade of gray. The contrast is the proportion between white and black in %, which means with 100% contrast the 100% black is mapped on the maximum and 100% white on the minimum width of the stripe. If the contrast is reduced, the 100% black is only calculated with for example 50% of the maximum width of the stripe.

Minimum gray value

The **Minimum gray value** is a limit for the shade of gray. You can for example remove a constant gray bitmap background.

*Indication: This value is only relevant if a graphic is darker than its background.*

For all examples the following picture serves as template: (Standard path: C:\Program Files\Stone Cut\Stone Cut 2\Bitmaps\photo.bmp)

![Template for all following result examples](photo.bmp)

Fig. 7.10-2: Template for all following result examples
Negative

The range of value of the shades of gray is reversed which means that 100% black become 0% white and vice versa.

Reverse direction (only with stripes)

If this option is activated, the width of the stripe is aligned downwards.

Fig. 7.10-3: Example for the reversion of the range of value

Fig. 7.10-4: Example for the reversion of the width of stripe
7.10.1 The PhotoCUT Dialog

Cut out

<table>
<thead>
<tr>
<th>Width of stripe upwards</th>
<th>Width of stripe downwards</th>
</tr>
</thead>
</table>

Double (only with stripes)

If this option is activated, the width of stripe is created up and down.

<table>
<thead>
<tr>
<th>Width of stripe up and down</th>
</tr>
</thead>
</table>

Fig. 7.10-5: Example for „double”

Horizontal or vertical

With the options horizontal or vertical the direction of the stripe is determined.

Bitmap

In the area named bitmap the file data of the template (of the picture) are shown. In the upper area the width and height of the picture in pixel are indicated and the resolution in dpi. Underneath, the width and height of the picture are shown in millimeters.

Depending on the functions in the area general settings different effects are created.

Example 1

Following values have been set:

- Pixel in X-direction = 1
- Pixel in Y-direction = 10
- Remaining width = 0
- Contrast = 80
- Minimum gray value = 0
- Orientation = horizontal
Negative = not active
Reverse direction = no active
Double = not active

Result

Fig. 7.10-6: Result from the value of example 1

Example 2

Following values have been set:

Pixel in X-direction = 3
Pixel in Y-direction = 15
Remaining width = 5
Contrast = 60
Minimum gray value = 0
Orientation = horizontal
Negative = not active
Reverse direction = not active
Double = not active
7.10.1 The PhotoCUT Dialog

Result

Fig. 7.10-7: Result from the value of example 2

With the 2 examples you can see that already small modifications of the values lead to big discrepancies with the result.

Weeding aid

Create weeding aid

The stripes at the ends are automatically thickened so that the result can be wed faster.

Stripes per strap

In this field the number of stripes that shall contain a strap can be set.

Width of strap

In this field you define the width of a strap.

For information, underneath these fields the estimated number of objects is shown. This is important to decide beforehand if the expenditure of time for the weeding is in a responsible relation to the complexity.
The different modi

In the PhotoCUT dialog you can select between following modi: stripes, rhombuses, circles, rectangles, single rhombuses, single circles, single rectangles.

With which mode you obtain the best and most attractive result depends strongly of the used template. Templates rich in contrast are usually better suited for optically interesting results.

*Tip:* The screen does not always show a view that enables a reliable evaluation of the results. Therefore, print the result on your printer. Now you can judge the result of the procedure relatively exactly and do not risk to waste expensive material!
7.10.1 The PhotoCUT Dialog
8 The Sidebar

The **Sidebar** is switched on or off via the **Window** menu.

8.1 Term Definition Sidebar

A "sidebar" means a lateral toolbar with tabs. It is comparable to the so-called docking bars in CorelDRAW. In summary, we find the layer editing (formerly Layerbox), the clip art manager, object manager, file manager, and the macros.

**Functionality of the Sidebar for the user:**

The Sidebar summarizes different tools. Previously distributed toolbars such as Layerbar, Clipart Manager were combined in a compact tab structure. The sidebar serves as a **central element of the object management.**

8.2 The Anchorage Control

![Fig. 8.2-1: Anchorage control with arrow and dotted line for moving and placing](image)

*Note: Only in the docked state, the Anchorage control is activated and visible.*

The **Collapse Button**

Pressing the **Collapse** button folds in the sidebar so that only the **tab bar** and the **Unfold** button stay visible on the right side.

The **Unfold Button**

Enabling the **Unfold** button folds out the sidebar to the previous set size.

The **Close Button**

Pressing the **Close** button removes the sidebar from the program user interface.

The **Dotted Line**

The **Dotted Line** is used to move the entire sidebar. While the **left mouse button is hold down**, the sidebar can be moved to any place. **Double-clicking on the dotted line** looses the sidebar as well. Double-clicking on the head or moving the mouse towards the right edge of the bar **anchors** the sidebar.
The Tab Bar

Fig. 8.2-2: Tab bar with activated layer tab

The selection is done by clicking on the appropriate tab.

*Note: The bar may include, depending on the program version more, less or other than those shown tabs.*
8.3 The **Layer Tab**

The **Sidebar** is switched on or off via the **Window** Menu. Selection using the **Layer** tab.

The **Layer** area serves for the coloring of objects, the definition of foil colors, the selection of objects that have a layer color, the locking and the hiding of color layers as well as the allocation of *output* tools.

### 8.3.1 A) The Layer Area

![Layer Tab Image](image.png)

**Fig. 8.3-1: The *New* button**

This option generates a new layer and opens the corresponding dialog.

**Fig. 8.3-2: The *Select* button**

This option selects the clicked Layer.

### 8.3.2 B) The Layer Options

**New**

**Sel**

This option selects the clicked Layer.
8.3.3 C) The Palettes Options

Layer numbers

The activation of this option switches on or off the numbering next to the color bar.

8.3.3.1 Layer Info Dialog

Layer Info...

opens the following Setup Layer dialog.

Fig. 8.3-3: Setup Layer Dialog

When mouse over layer, show following info,

the activated information is shown in so-called Tooltip.
In addition, the used part of color bar to this info %, number of visible layers can be defined and the window width of the layer toolbar can be changed interactively.

8.3.3.2 Layer Order Dialog

Fig. 8.3-4: The Change Layer Order Dialog

The sequence of the layers can be changed arbitrarily. To do so, please use the up, down, to top, to bottom button.

8.3.3.3 Only sel. layer visible

Only shows the objects that lie in the selected layer.

8.3.3.4 Del sel. layer

The activation of this option deletes the selected layer.

Note: This option can only be activated if no objects lie in this layer, if the layer is unused.

8.3.3.5 Delete unused layer

All layers that do not contain any objects (unused) are deleted.
8.3.3.6 New

This option generates a new color palette.

*Note: 6 base layers will always be created. Order and color can be changed anytime.*

8.3.3.7 Load

Previously defined palettes can be loaded.

8.3.3.8 Save

With this instruction a newly defined or modified palette is saved on your harddisk.

*Note: If a new or changed palette is named 'Default', this palette is used at every restart of Stone Cut 2.*

8.3.3.9 Save as

This instruction allows the renaming of a palette name and save the palette using the new name.

8.3.3.10 Default (History)

This instruction loads the color palette that is delivered as standard with Stone Cut 2. It is a Mactac foil table.

*History*

This function facilitates the loading of the last color palettes. At the end of the menu list the names of the last edited color palettes appear.

8.3.4 Status Indicator Layer

- Object in Layer color
- Layer not visible
- Layer is locked
- Tool assigned
- Layer is active and empty
- Object in active Layer

*Fig. 8.3-5: Layer status view*

**Object in layer color**

Is a layer marked with this symbol, it means that objects are in this color or layer assignment exists. The selection is easiest using the `Sel` button.
**Not visible layer**

Is a layer marked with this symbol, it means that objects in this color or layer assignments are not visible at present. They exist and can be switched visible if needed. In general layers are set to invisible, if they are obstructive while designing.

**Locked layer**

Is a layer marked with this symbol, it means that objects in this color or layer assignments are locked, thus can not be edited, moved or scaled.

**Tool assigned**

If a layer is marked with this symbol, this means that a tool from the selected device driver has been assigned to this layer. All objects that are in this layer are given out using this tool.

**Layer active but not occupied**

Is a layer marked with a frame, it means that no objects are available in this color or layer assignment, but the layer is active. Now, for example, objects can be filled with that color or contour and layer assignments can be done. The number indicates the layer number and the depth of arrangement.

*Note: The term depth of arrangement means that objects with a lower number are drawn before those with higher numbers. The layer order also has an influence on the drawing sequence.*

**Object in layer and active**

Is a layer marked with a frame and this symbol, it means that the layer is active and there are objects in that color (or layer assignments) on the desktop. The number indicates the layer number and the depth of arrangement.

*Note: The term depth of arrangement means that objects with a lower number are drawn before those with higher numbers. The layer order also has an influence on the drawing sequence.*
8.3.5 I. Layer Settings Output Setup

**Fig. 8.3-6:** Layer Settings dialog with toll / mode list - Output setup

*Note: Here the tool is assigned to the layer color - Red Cut Path - Tool TZ Cutting*
8.3.6 II. Layer Settings Color Setup

The following view appears after you press the color button.

Fig. 8.3-7: Layer - color, material name, color number and define properties - color setup

In the layer settings dialog the following three color models are available.

1. CMYK - Cyan, Magenta, Yellow, Kontrast
2. RGB - Red, Green, Blue
3. HSB - Hue, Saturation, Brightness

Layer button

Save
Insert
Delete
Save palette

Save

This instruction saves an additional layer containing individual settings.
8.3.6 II. Layer Settings Color Setup

**Insert**

Inserts a layer into the Layer toolbar.

**Delete**

This instruction deletes a layer from the Layer toolbar.

**Save palette**

This option saves all modifications in the corresponding palette file into the pal subfolder.

**Properties**

**Locked**

*Locked* means that objects which are in this color layer can not be marked or selected. In front of the locked layer appears symbolic a U-lock.

**Not visible**

*Not visible* lets disappear all objects from the desktop which are assigned to this layer. In front of the not visible layer appears symbolic a stroked eye.

*Note: Both functions can be undone at any time by activating the layer settings dialog using the right mouse button in the color bar. Now the resetting of properties is possible.*

**Color**

**Material name**

In the field *Material name* you can assign to a color layer an individual name.

**Color number**

In the field *color number* you can enter the name associated with this type of material or color number.

*Note: The advantage of the allocation of foil name and color number is that you can assign all materials to color layers - tailored to your stock. In designing these materials can be taken into account so that the assignment is visible during output. For each choice of films or types of materials a palette that is used in the design can be stored.*

**Output button**

The activation of the *output* button switches to the Output setup.

*Important note: This dialog is only enabled when this option was set in the driver! Only then the output button appears.*
8.3.7 Hotkeys in the Layer Processing

Spot color

The color name that is entered in this field is written into the output file if an EPS export is done.

*Note: Often, this option is used for the definition of cutting paths, or the spot color is treated as a special channel in Photoshop.*

Palette history

This function facilitates the loading of the last color palettes. At the end of the menu list the names of the last edited color palettes appear.

Sel button

![Sel](Fig. 8.3-8: Sel(ect) button)

If the *sel* button is pressed all objects which lie in the selected layer are marked.

8.3.7 Hotkeys in the Layer Processing

The following hotkeys are available in the layer processing.

Adjacent hotkey opens the *Layer Settings* dialog box

*Jump in the toolbar*

- **POS 1 key**: Jump to the first layer
- **END key**: Jump to the last layer
- **PgUp key**: Jump to 1/10 of the total layer number
- **CURSOR up / down**: Jump to the next layer

*Color assignment via the toolbar*

- **Double-click**: assigns the layer color to marked objects
- **Double-click + CTRL key**: assigns to marked objects a pen contour in the active layer color

*Movement of single layers / modification of the sequence*

1. Step: Position mouse cursor on wanted layer
2. Step: Press left mouse button and keep pressed
3. Step: Move layer to the wanted position
4. Step: Press once right mouse button
5. Result: The layer is at the new position
8.4 The Objects Tab

8.4.1 The Object Manager

The **Sidebar** is switched on or off via the **Window** menu. Selection is done using the **Objects Tab**.

8.4.1.1 Components Of The Object Manager

8.4.1.1.1 The Navigator

**Tasks**
- Object preview
- Navigation on the desktop and on the working sheet
- Zoom in and zoom out of the desktop and the working sheet
The Zoom Slider

The **Zoom Slider** serves to diminish or enlarge the desktop's view. Every click to the left or right of the slider button enlarges or shrinks the view. The button can also be slid using the mouse cursor. When the 100% view is exceeded a **red rectangle** appears additionally in the preview window. This rectangle can be moved using the mouse cursor.

The Drop-Out Menu

**Invert Selection**

Reverts the selection in the objects list, i.e. what was previously selected is deselected.

**Show Attributes**

Displays all of the selected options of the **Options** tab in the status bar.
8.4.1 The Object Manager

**Options...**

![Object List Settings](image)

Fig. 8.4-2: Restrictions for the object list in the Objekt Manager

**The Tree Buttons**

1. **Unfold** branches
2. **Collapse** branches

**The Zoom Buttons**

1. Show whole sheet - Hotkey B
2. Show all objects - Hotkey F4
3. Show selected objects - Hotkey SHIFT+F4

**8.4.1.1.2 The Color Bar**

![Color Bar](image)

Fig. 8.4-3: Section of the color bar of the object manager

**Tasks of the color bar**

- color variation and assignment (Layer)
8.4.1.3 The Area Object List - Object Tree

Selection with mouse click

1. One click selects
2. SHIFT+Click selects several in sequence
3. CTRL+Click selects several not immediately contiguous objects

A click on plus / minus opens or closes the tree (cf. Windows Explorer)

8.4.1.4 Object Type And Object List's Attributes Selection

Task: Definition of the objects which should be displayed in the object list.

8.4.1.5 The Name Field

Task: Define alias or field name
Purpose: Apply macros or scripts on field value e. g. substitute objects, properties, ...

Add To List Menu Item

Inserts the entry of the name field into the list.

Save With Attributes Menu Item

Saves additionally to the names the selected attributes (object properties).

Delete From List Menu Item

Deletes the selected entry from the list.

Select Objekts Menu Item

Selects all objects with this name that are located on the working sheet.

Assign Menu Item

Assigns name from the name field to all selected objects.
8.4.2 The Object Types Tab

8.4.2 The *Object Types* Tab

<table>
<thead>
<tr>
<th>Object types</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ All</td>
<td></td>
</tr>
<tr>
<td>☐ Vector objects</td>
<td></td>
</tr>
<tr>
<td>☐ Text objects</td>
<td></td>
</tr>
<tr>
<td>☐ Bitmaps</td>
<td></td>
</tr>
<tr>
<td>☐ Combinations</td>
<td></td>
</tr>
<tr>
<td>☐ Groups</td>
<td></td>
</tr>
<tr>
<td>☐ Container</td>
<td></td>
</tr>
<tr>
<td>☐ Register marks</td>
<td></td>
</tr>
<tr>
<td>☐ Drill holes</td>
<td></td>
</tr>
<tr>
<td>☐ Video marks</td>
<td></td>
</tr>
<tr>
<td>☐ Print marks</td>
<td></td>
</tr>
<tr>
<td>☐ Jog marks</td>
<td></td>
</tr>
</tbody>
</table>

*Note: Any selection or multiple selection of the restricting attributes is possible at any time.*

**All**

Shows all object types in the object list.

**Vector objects**

Shows all resp. only vector objects in the object list.

**Text objects**

Shows all resp. only text objects in the object list.

**Bitmaps**

Shows all resp. only bitmaps in the object list.

**Combinations**

Shows all resp. only combinations in the object list.

**Groups**

Shows all resp. only groups in the object list.

**Container**

Shows all resp. only containers in the object list.

**Register marks**

Shows all resp. only jog marks in the object list.
Drill holes

Shows all resp. only drill holes in the object list.

Video marks

Shows all resp. only video marks in the object list.

Print marks

Shows all resp. only print marks in the object list.

Jog marks

Shows all resp. only Jog marks in the object list.

Die Forward / Backward button

The button appears automatically if the column width gets to narrow to display all tabs at once. By means of the buttons can be scrolled back and forth between the tabs.

8.4.3 The Object Names Tab

The Object Names Tab list all defined names which were assigned to particular objects using the Name field. Names can be used in order to individualize objects and to apply macros.

<table>
<thead>
<tr>
<th>Object names</th>
<th>Object Types</th>
<th>At</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text (4)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contour 0.000 in [10]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image container (1)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fig. 8.4-5: List of all object names

The Forward / Backward Button

The button appears automatically if the column width gets to narrow to display all tabs at once. By means of the buttons can be scrolled back and forth between the tabs.
8.4.4 The Attributes Tab

The **Attributes** tab lists all restrictions, limitations that can be assign to an arbitrary object.

![Attributes Tab](image)

**Fig. 8.4-6: List of all possible object restrictions**

*Note: Any selection or multiple selection of the restricting attributes is possible at any time.*

**No output on device**

The **No output on device** option prohibits that the selected object is given out on a connected device (cutter, milling machine).

*Note: Device means in that coherence devices that can be controlled from the Plot Manager.*

**No output on printer**

The **No output on printer** option prohibits that the selected object is given out on a connected printer.

**No Export**

The **No Export** option prevents that the selected object is exported.

**Blocked**

The **Blocked** option prevents that the requested object can be selected. It will be marked with red handles.

**Do not move**

The **Do not move** option prevents that the selected object can be moved. The position is locked.

**Fixed size**

The **Fixed size** option prevents that the selected object can be scaled (enlarged or decreased). The size is locked.
8.4.4 The Attributes Tab

**Fixed size during output**

The *Fixed size during output* option prevents that the selected object was unintentional scaled (enlarged or decreased) before output.

**Text not editable**

The *Text not editable* option prevents that the selected object is unintentional edited. The Text is not changeable.

**Invisible**

The *Invisible* option makes that the selected object is not visible on the working sheet. This option is useful every time when there is a lack of clarity.

**Container**

The *Container* option transfers an object into a container or back into the generic object.

**Video mark**

Special attribute resp. object which is used when camera based recognition is used. The camera module drives the tool head with camera to the so marked objects.

**Register mark**

Special object which is outputted on a cutter - independently from a layer color - every time at the same position. The purpose is the subsequent, precision-fit assembly of the different colored materials.

**Drill hole**

Special attribute for milling applications. The object has no expansion and can not be scaled.

*Note: Drill holes can be drawn using the drawing tool*

**Print mark**

Print or cut marks are printed additionally to the print data while printing.

**Jog mark**

Special objects which are required while the output on cutters with optical sensors for a precise contour cutting. Each producer uses specific jog marks. The selection can be done using the *properties* menu.
8.4.4 The Attributes Tab

The forward / backward button

The button appears automatically if the column width gets to narrow to display all tabs at once. By means of the buttons can be scrolled back and forth between the tabs.
8.5 The *Cliparts* Tab

8.5.1 Clipart Management

The *Cliparts* tab is switched on or off via the *window* menu.

The *Cliparts* tab serves for the administration of your cliparts.

You can take these so-called cliparts from the wnate clipart group via drag & drop to the Stone Cut 2 working sheet and edit them further.

8.5.1.1 Definition Clipart

What is a *Clipart*? Cliparts are objects, parts of jobs or whole jobs that have been added to the cliparts tab. Cliparts serve primarily to direct and quick access to design elements. As clip art is therefore virtually everything that is needed for quick or frequent job generating, for example sign plates of different sizes, logos, design templates, and much more.

Cliparts are similar to jobs in the handling.

*Note: Aid lines are not saved.*

8.5.1.2 Add Cliparts

Cliparts can be added via drag & drop or right mouse button context menu activation submenu "Add Cliparts".

8.5.1.3 Delete Cliparts

Cliparts can be deleted from the group using the DEL key.

8.5.1.4 Definition Clipart Folder

Folder is the structural generic term. In a *Clipart Folder*, several *Clipart Groups* can be included.

8.5.1.5 Definition Clipart Groups

Group is the structural generic sub term. Individual cliparts are collected in *Clipart Groups*. 
8.5.1 Clipart Management

Fig. 8.5-1: Clipart area with control elements

Fig. 8.5-2: Clipart info window

The Clipart info window is displayed if the mouse cursor whiles a short period of time above the desired thumbnail.
8.5.1.6 Add Clipart Folder… Button

8.5.1.7 Settings Tab

Folder Field

The selected folder in the Folder field is added to the list of clip art management.

Monitor Folder Option

With this option, the directory monitoring is turned on, ie, whenever a new file is stored in this folder, a thumbnail is created.

With Subfolders Option

All subfolders are included in the monitoring if this option is also enabled.
8.5.1.8 Macro Assignments Tab

Using the **Macro Assignments** tab events (e.g. double-click or enter key) can be assigned to specific **functions**. The possible function assignments are listed in the **Available functions** area. Additionally functions can be added to the **context menu** via drag & drop. After this procedure they are listed in the **Current Functions** area.

8.5.1.9 Create New Clipart Group... Button

**Clipart Folder Field**

In this field the name of a new clipart group can be entered.
8.5.1.10 Rename Clipart Group Button

Clipart Folder Field

Clicking on the ... button allows the selection of the clipart folder that should be renamed.

8.5.1.11 Edit Clipart Folder… Button

Folder Field

The directory field in the selected directory can be edited.

Monitor Folder Option

With this option the folder monitoring is turned on that is, every time when a new file is stored in this directory a thumbnail is created.

With Subfolders Option

All subfolders are included in the monitoring if this option is also enabled.

8.5.1.12 Import Clipart Files… Button

By means of this function elder CLA files can be read. All previous versions of Stone Cut 2 used the cla file format when saving cliparts. This function converts them into the new format.
8.5.1.13 *Refresh Button*

Rereads the clipart group and generates up to date thumbnails.

8.5.1.14 *Save Changes Button*

Saves the current state of the clipart management.

8.5.1.15 *Diminish Presentation of Folder Levels… Button*

Shortens the visible path by one folder level. This provides clarity in a complex and widespread clipart folder structure.

8.5.1.16 *Increase Presentation of Folder Levels… Button*

The visible path is extended by one more folder level.

8.5.1.17 *Common Settings… Button*

![Common Settings Dialog](image)

Fig. 8.5-3: Setup dialog of the Clipart Manager

**Thumbnails Tab**
Compression

This option determines which compression rate will be used when generating preview images (Thumbnails).

Priority

This option adjusts, how the thumbnail creation behaves in relation to the main application. The higher the priority, the more CPU time the process gets assigned.

Other Settings

Prefer contour mode image option

Enabling this option displays the thumbnails in contour mode i.e. without color fill - analogous to the contour mode.

8.5.1.18 Number of Thumbnails per Line Button

8.5.1.19 Slider

The slider serves to determine the number of thumbnails that can be displayed in a line. This is based on the current width of the sidebar. Here there are 6 thumbnails that are displayed per line.

8.5.1.20 Show Name

This option shows in the activated state the name of the clipart file in addition to the thumbnail.

8.5.1.21 Thumbnail View / List View Button

8.5.1.22 Thumbnail View
8.5.1.23 List View

<table>
<thead>
<tr>
<th>Icon</th>
<th>File Name</th>
<th>Date</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>📁</td>
<td>EC Sign Symbols0</td>
<td>24.04.2009 15:49</td>
<td>3.48 KB</td>
</tr>
<tr>
<td>📁</td>
<td>EC Sign Symbols1</td>
<td>24.04.2009 15:49</td>
<td>0.64 KB</td>
</tr>
<tr>
<td>⚠</td>
<td>EC Sign Symbols1</td>
<td>24.04.2009 15:49</td>
<td>5.56 KB</td>
</tr>
<tr>
<td>⚠</td>
<td>EC Sign Symbols1</td>
<td>24.04.2009 15:49</td>
<td>1.33 KB</td>
</tr>
</tbody>
</table>

8.5.1.24 The Search Field

Search File name

8.5.1.25 Search by File Name

By default, is searched in the order of the letters, how they are entered.

*Note: Permitted are also wildcards such as * and ?.*

Example:

Be* - searches for all file names beginning with Be

B??ling - searches for all filenames that start with B, then have 2 characters in between and end up with ling, such as Billing

8.5.2 The Context Menus

8.5.2.1 Context Menu 1

- Add clipart directory...
- Edit clipart directory...
- Create clipart group...
- Rename clipart group...

Description of menu items: please refer to 8.5.1.6: Add Clipart Folder… Button ff

8.5.2.2 Context Menu 2

- Edit clipart directory...
- Reload
- Delete

Description of menu items: please refer to 8.5.1.6: Add Clipart Folder… Button ff

8.5.2.3 Context Menu 3 Search Field

Cut  Ctrl+X
Copy  Ctrl+C
Paste  Ctrl+V
### 8.5.2.4 Context Menu 4 Clipart

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate duplicates</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Change name</td>
<td></td>
</tr>
<tr>
<td>Reselect file</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
</tbody>
</table>
8.6 The Macros Tab

8.6.1 The Toolbar Area

8.6.1.1 The Toolbar

The **Open/Close Button**

A click on the *Open/Close button* opens and closes the complete toolbar.

---

8.6.1.2 The **Settings**… Button

Enabling the *Settings* button allows adjusting the controls to the requirements of the used screen. The following dialog shows the extent of the possible adjustments.
8.6.1.2.1 The Slider

It enlarges or reduces the control elements within the Macros tab.

*Note: This control is of particular benefit in the use of touch-screen monitors.*

8.6.1.2.1.1 Size

**Scaling**

This option determines how large the display should be within the macro list.

**Size of Run Button**

This option determines the size of the Run button for playing the macros. A size adjustment can be made especially for touch-sensitive monitors (touch screens).

**Number of Quicklayers**

This option determines how many Quick Layers should be displayed in the macro tab.

8.6.1.2.1.2 Display

*Don’t show if the macros are used in a tool box Option*

This option prevents a macro from being displayed twice.
8.6.1 The Toolbar Area

**Don’t show if the macro requires a file input** Option

This option only displays macros that do not require a file (*.job) as input.

**Enable Tool Tips** Option

The *Enable Tool Tips* option enables or disables the display of help texts in the Workflow Manager.

8.6.1.3 The **Load Online Macros...** Button

Enabling the **Load Online Macros...** button accesses the EUROSYSTEMS Web server and checks if online macros are available.

*Note: If no macros are available online no action is taken.*

8.6.1.4 Layer Selection and Assignment

The **Layer Selection** Button

Fig. 8.6-4:  
With this button **selected objects** can be related to any **layer** and **tool** (if assigned!).

The **Assign Layer** Button

Fig. 8.6-5:  
After clicking on the **Assign Layer** button the selected objects are **assigned in fact** to the chosen layer.

8.6.1.5 The **Save Changes...** Button

Enabling the **Save Changes...** button saves all changes within the **Macros** tab.

*Note: This button appears only on the toolbar when changes were made.*
8.6.2 The **Macro Player**

A double-click on a macro in the macro list opens an additional window (called the parameter view) or executes the macro directly.

---

**Fig. 8.6-6: Macro in Parameter View**

8.6.2.1 The Control Elements of an Active Macro

8.6.2.1.1 The **Cancel Process** Button

Pressing the cancel process button breaks the macro process.
8.6.2 The Macro Player

8.6.2.1.2 The Step Back Button

If the step back button is pressed, the macro jumps back to the last executed macro function.

8.6.2.1.3 The Execute Function Button

If the execute function button is pressed, the macro starts.

8.6.2.1.4 The Open View Button

Pressing the open view button opens the parameter view which allows entry of values and modes.

8.6.2.1.5 The Close View Button

Pressing the close view button closes the parameter view.
8.6.3 The Stone Cut 2 Macros

8.6.3.1 The Place Rhinestones Macro

General

Collision detection: The collision detection is performed by identifying the intersections of the generated Rhinestone objects. Depending on the preset values so-called Replace or Intersection objects are generated. This objects can be selected or assigned to a specific color layer using the objects tab.

8.6.3.1.1 The Undo Button

The Undo button cancels the last Rhinestone creation process.

8.6.3.1.2 The Execute Button

The Execute button starts the macro and creates Rhinestones taking into account the set parameters. The parameter view stays open.

8.6.3.1.3 Contour Mode

In the Contour Mode Rhinestone objects are placed on the vector contour. Object distance and type can be defined in the parameter view.
8.6.3 The Stone Cut 2 Macros

8.6.3.1.3.1 Placing Object

*Placing object* is name of the to be generated *rhinestone objects*.

**Object Distance:**

*Object Distance* defines the distance among the *rhinestones*.

**Tolerance in %**

The *tolerance* value should prevent empty sections. The range of values is from 0-100. At 50% tolerance over short distances, up to half the object distance, still *rhinestone* objects are generated.
Object Selection:

Circles
If this option is enabled, rhinestone objects are drawn and placed as circles.

Drill Holes
If this option is enabled, rhinestone objects are drawn and placed as drill holes.

Clipboard Objects
If this option is enabled, rhinestone objects are drawn and placed in the shape they had in the windows clipboard.

Squares
If this option is enabled, rhinestone objects are drawn and placed as squares.

D: (Diameter)
The D value defines the diameter of the rhinestone objects.

Layer
In the layer list the color is selected, in which the rhinestone objects are drawn.

Number of Outputs
The number of outputs value defines, how often job contours are cut.

Note: This function facilitates weeding of the foil, because the contours are cut identically" as often, as the value in the number of outputs field determines.

Use Original Color Option
If the use original color option is enabled, then rhinestone objects are generated with the color of the contour.

The Rhinestone Simulation Option
When this option is enabled all Rhinestones are displayed with hue and gradient fill in the Full Surface Mode. This Option serves a realistic presentation of the Rhinestones on the screen.

Extended:

8.6.3.1.3.2 Collision Detection Option
If this option is enabled, then the collision detection is switched on and the following parameter are considered.
Intersections

In the intersections color list the color is selected in which the colliding rhinestone objects are drawn or in which color layer they are placed.

Minimal Distance

In the minimal distance field is determined, how far the rhinestone objects are to be at least from another. This is the additional distance before they cross.

Percent

In the percent field is determined, how far the rhinestone objects are to be at least from another. This is the additional distance before they cross.

Attention:
Specify either minimal distance or percent value. The control element allows only one option.

8.6.3.1.3.3 Tool Correction Option

If this option is enabled, the diameter of the used tool (milling bit) is taken into account when calculating.

Note: Alle outputs are done with a milling tool.

Diameter

In this field the actual diameter of the used tool can be entered. Then the pathway for the milling tool is calculated using this value.

Pen Color

The selected pen color draws the contours with a contour pen in the thickness of the milling tool.

8.6.3.1.3.4 Generate Clones Option

If the generate clones option is enabled, the rhinestones objects are generated as clones. Clones are special objects whose properties are derived from one so-called control object. Changes on the attributes of the control object are transmitted to all other clones.
8.6.3.1.4 Mode Fill

In the Fill mode rhinestone objects are placed inside the vector contour as a fill. Object distance, type, and fill settings can be defined in the parameter view.

Fig. 8.6-9: Parameter view mode fill

8.6.3.1.4.1 Fill Settings
8.6.3 The Stone Cut 2 Macros

**Type Raster**

![Fill settings:](image)

**Angle**

The *angle* field defines raster's angle in the coordinate system.

**Margin Distance**

The *margin distance* field determines which distance the *rhinestone* objects should have from the contour.

**Type Hatch**

![Fill settings:](image)

**Angle**

The *angle* field determines the angle for the hatch in the coordinate system.

**Margin Distance**

The *margin distance* field determines which distance *rhinestone* objects should have from the contour.

**Type Random**

When *type random* is enabled, rhinestone object coordinates are generated and spread randomly. Afterwards the intersections are checked.

![Fill settings:](image)

**Number of Objects**

The value in the *number of objects* field determines the *exact* number of *rhinestone* objects which should be placed.
8.6.3.1.5 Mode Contour + Fill

In the **Contour + Fill** mode **rhinestone** objects are placed *inside and onto* the vector contour. Object distance, type, and fill settings can be defined in the **parameter** view.

![Parameter view contour and fill](image)

Fig. 8.6-10: Parameter view contour and fill
8.6.3 The Stone Cut 2 Macros

8.6.3.2 The *Remove Rhinestones* Macro

After clicking the *execute* button all previously generated rhinestones are deleted.

8.6.3.3 The *Convert to Rhinestone* Macro

Pressing the *Execute function* button assigns the Rhinestone object attribute to all selected objects. The *number of outputs* is set to the predefined value. Thereby the *optimized cutting* is activated.

*Note: This function is primarily useful for the conversion of circles when importing files from other programs.*

8.6.3.4 The *Replace Objects* Function

8.6.3.4.1 Replace Objects With Selected Type

All objects marked on the working are replaced with the selected object type.

![Replace dialog box](image)

*Fig. 8.6-11: Marked objects are replaced with the selected object type*

8.6.3.4.2 Replace with:

**Circle - D (diameter) in ... mm**

Replaces all selected objects with the object type *circle*. The value *D* indicates the wanted diameter of the circle.

**Drill hole**

Replaces all selected objects with the object type *drill hole*.

**Regmark**

Replaces all selected objects with the object type *regmark*. 
Clipbard

Replaces all selected objects with the content from the clipboard.

Layer

*Layer* indicates the target layer in which the replaced objects shall be put.

*Indication: Not active with the option clipboard.*

Group

If this option is active all replaced objects are combined to a *group - grouped.*

Delete original

If this option is activated the original is replaced with the replaced objects.
8.6.3 The Stone Cut 2 Macros
9 Tips & Tricks - Trouble Shooting

Often, it is just a bagatelle that makes the "implementation" of new software difficult. Similar to a new machine, there are questions and problems with new software that often can be explained and solved easily. Therefore, we have explained a selection of questions that occur daily at our hotline- and support routine more closely.

9.1 Code is not accepted with Windows 7, 8, 10 or Vista (No Dongle)

Error message: Invalid code or after each program start the code must be entered again

The program must be executed once with administrator rights. Click with the right mouse button in the program menu on Stone Cut 2 and select "Execute as administrator".

Note: Don’t change anything on the given activation data resp. license data.

9.2 Buffer Overflow Serial Port

The cutter cuts the first characters neatly and then starts to draw indefinable curves.

With serial activation of the cutter, this is a typical buffer overflow problem and occurs if the protocol for the serial transfer is not set correctly. Most cutters are activated with the following parameters with a serial data transfer: bits per second: 9600, data bits: 8, parity: none, stop bits: 1, protocol resp. flow control: hardware

9.3 Output Size Mimaki

The output size on a Mimaki cutter does not correspond with the configured size but is more than twice as big.

The Mimaki cutter of the CG series is delivered ex works with a plot resolution of 0.025 mm even if they can work with a resolution of 0.01 mm and do so internally. The drivers of Stone Cut 2 are set to these "device"-resolution because the cutters can be activated faster and more accurate.

For the adjustment of this plot resolution you switch on the cutter, press the < button at the control panel and after the cutter has measured the roll you press the function key until "interface" appears in the display. Then, you press the ENTER key until you reach the menu item "Stepsize" and then the ^-button. The display now shows „0.01“. Confirm the selection with ENTER and END.
9.4 Output Size Graphtec

The output size on my Graphtec cutter does not correspond with the configured size but is more than twice as big.

Setting the step size:

In the GP-GL mode it is possible to set the minimal distance of the cutting knife's path to one of the following widths: 0.01 mm, 0.025 mm, 0.05 mm or 0.1 mm. The default setting is 0.1 mm. This value must be changed, if your program's driver uses another step size.

Step 1: Switch into the command mode "GP-GL".

Step 2: Press the enter key; the menu step size appears.

Step 3: Press , key to select the desired value (0.100 mm, 0.050 mm, 0.025 mm, or 0.010 mm) and confirm with enter key. Press (NEXT) or (PREV.) to undo your selection.

Step 4: Press (PAUSE) key in order to cancel the PAUSE mode.

In the case of controlling the plotter from Stone Cut 2, the value of the step size must be set to 0.025. This is the resolution which is preconfigured in the drivers.

9.5 Calibration of the Output Size

Problem: The size entered in the software and the output size of the objects do not match.

Solution: Calibration must be performed on the connected cutter. Calibration means: checking and, if necessary, changing the values stored in the driver to the values you have measured.

Method:

Activate the following dialog in the Settings / Standard Settings / Output Devices... menu.
Clicking the *Calibrate* button opens the *Calibrate Device* dialog.
Now carry out the **calibration** step by step.

**Step 1:** Specify the size of the rectangle to be output. Get the cutter ready for output. Start the output by clicking on the *Rectangle* button.

**Step 2:** Weed the rectangle and measure it with a ruler. Enter the measured values in the *Length (X)* and *Width (Y)* fields under *Measure (Step 2)*. Then click on the *Calibrate* button. The new values are now entered into the driver.

*Note: You can repeat this process. The maximum accuracy to be achieved depends only on the connected device. Low-cost devices often only achieve an accuracy of +/- 0.5 mm. Professional vinyl cutters achieve an accuracy of ≥ +/- 0.1 mm.*

### 9.6 Computer without serial COM port

My computer provides no serial COM port, but a USB port. How can I connect my cutting plotter, which provides only a serial interface? In this case there is a computer accessory called - USB serial adapter- that provides one or more serial COM ports on one USB port.
Note: Not all adapters offered work properly, especially the use on 64-bit operating systems is sometimes not free from errors. It may be that different adapters must be tried.

9.7 Cutter Does Not Respond!

a. First check if you have selected the correct cutter driver and the correct port: for example <device name> at COM2 in the Stone Cut 2 cutting dialog

b. COM connection: Check if the parameters of the port are set correctly. To do so, call up the system control of Windows. In the device manager, select the corresponding connection, for example: COM.

Popular standard parameter are: Baud: 9600, data bits: 8, parity: none, stop bit: 1, protocol / flow control: hardware

The settings in the system control and at the cutter must be identical otherwise no or only faulty data transfer will take place.

c. USB connection: Check if the correct USB driver is installed for the device. The settings are in the Windows device manager under USB controller. The USB driver for the cutting cutter must be entered in this list otherwise no activation is possible.
If the USB driver does not appear there, install it from the delivered data carrier of your device.

d. Original cable: Check if you use the original cable recommended by the manufacturer. If this is not the case, there might be bigger problems during the data transfer. Stone Cut 2 „communicates” during the data transfer with the cutter so that missing or faulty connected data cable with the cutter lead to input or output errors.

9.8 Buffer Overflow

The cutter reports „buffer overflow” or does not cut the whole job

This is often because of an incorrect setting of the used protocol of the serial (COM) port. In most cases it is sufficient to set the protocol respective the flow control of the port to hardware.

9.9 Data Import From Apple Computers

Data import from Apple computers in Stone Cut 2

When exporting Apple data you have to pay attention to some settings to have a perfect data export. All popular Apple compatible illustration and graphic applications can export EPS data. (Illustrator, Freehand, …)
9.10 Typical Sources of Errors When Cutting

a) The foil is clamped too loose

**Consequence:** the knife moves the foil during the cutting and the contour is not closed completely.

**Remedy:** when inserting the foil pay attention that the foil is clamped evenly and does not undulate.

b) The speed is too high

**Consequence:** small foil parts especially serifs and counters are unscrewed.

**Remedy:** reduce speed and lower the pressure.

c) The tool pressure is too high

**Consequence:** the release paper is also carved, character parts are unscrewed and parts of the release material get stuck at the characters. The weeding of the foil gets more difficult.

**Remedy:** reduce pressure and correct the depth of the knife if necessary.

d) The tool pressure is too low

**Consequence:** foil and adhesive were only partly cut through. The weeding is possible only with difficulty or not at all.

**Remedy:** increase the pressure and correct the depth of the knife if necessary.

e) The knife is set too deep

**Consequence:** foil, adhesive and release material were cut. Foil cannot be used any more.

**Remedy:** correct the setting of the depth of your **cutting knife**.
f) The knife is used up

**Consequence:** only the foil and not the adhesive is cut through.

**Indication:** when using standard foil the using up of the knife is little. When using reflection or sandblast foil the using up is much higher.

**Remedy:** use new original knife.

g) The characters were unscrewed

**Consequence:** The weeding border is possible only with difficulty. The unscrewed parts stick to the foil and cannot be detached any more.

**Generally is presumed:** the smaller the font size the thinner the foil must be; the adhesive force of the gluten is higher.

**Remedy:** reduce the speed and if necessary the tool pressure until this effect does not occur any more.

h) The release paper is also cut

**Consequence:** the release material sticks to the foil. The weeding is possible only with difficulty or not at all.

**Remedy:** correct the setting of the depths of the cutting knife and also reduce if necessary the tool pressure.

### 9.11 Plotter Via USB Is Not Working!

**Error message:** Cannot open interface!

Check first, if your cutter is listed in the **Device Manager** (Control Panel / System / Device Manager). If not, reinstall the device driver as described in the plotter manual.

Check then, if the USB port for your cutter is selected in the Stone Cut 2 **Device Settings**. You’ll find the **Device Settings** window in the **Settings / Common Settings / Devices** menu.

**Note:** A **USB cable should be no longer than 5 m without booster.**

### 9.12 Summa Plotter Does Not Read Out!

**Error message:** Waiting for response... Cannot open interface...

Check, if your plotter is set on the device language DMPL. If the cutter is set to HPGL, read out via cable is not possible.
9.13 The Values for Cutting Pressure And Speed Are Not Saved

After changing the values it is often forgotten to confirm the values. Please press the button beside the Enter Material field and enable the Save Material Data option.

9.14 Error Message While Output into File

Error message: "Error for CreateFile"

This error message is given out, if the access right Write for the program folder of Stone Cut 2 is not set.

Relief: Enable write rights for the program folder.
### Annex

#### A Driver List

**Allen Datagraph**
- 824
- 848
- 830
- 836

**Anagraph**
- ANA Express AE-101
- ANA Express AE-120
- ANA Express AE-120e
- ANA Express AE-60
- ANA Express AE-60e
- ANA Express AE-70
- ANA Express AE-75e

**Aristo**
- AG 130 Signline
- AG 50 Offline
- AG 600
- AG 75 Signline
- AG 75 Signline ABS
- GL_TL

**Artsign**
- Artsign

**ASC365**
- ASC365

**Atlas**
- Atlas

**Automated Cutting Systems**
- ACS Design Studio Eagle

**Calcomp**
- Classic

**Cogi**
- CA 1300
- CA 730
- CP 630
- CT 1200
- CT 630
- E 1360
- E 720
- E 870

**Cole**
- CL1100
- CL1350
- CL720
- CL870

**COPAM**
- CP-2500
- CP-3050
- CP-3500
- CP-4050
- CP-4500
A Driver List

Creation
PCUT CR1080 PCUT CR1200 PCUT CR630
PCUT CR900 PCUT CS1080 PCUT CS1200
PCUT CS630 PCUT CS900 PCUT CT1000
PCUT CT1200 PCUT CT1300 PCUT CT1600
PCUT CT630 PCUT CT635 PCUT CT900
PCUT CTN1080E PCUT CTN1200E PCUT CTN1500
PCUT CTN630 PCUT CTN630E PCUT CTN900
PCUT CTN900E

Creation HK
King Cut KCUT A1200 King Cut KCUT A24 King Cut KCUT A36
King Cut KCUT A48 King Cut KCUT A900 King Cut KCUT B24
King Cut KCUT B48 King Cut KCUT B900 King Cut KCUT CT1200
King Cut KCUT CT24 King Cut KCUT CT36 King Cut KCUT CT48
King Cut KCUT CT630 King Cut KCUT CT760 King Cut KCUT CT900

DAS
SmartCutter 12 SmartCutter 24

DCS
DCS-F300

Desay
XP-300P XP-380P XP-450P
XP-540P XP-660P

DGI
Omega OM-100 Omega OM-130 Omega OM-150
Omega OM-40 Omega OM-60 Omega OM-70
Omega OM-80

Emblem
EC 120 EC 60

Encad
NovaCut Series

Foison
C12 C24 C48
CT-1200 CT-630 FS-24
FS-48 S24

GCC
AR 24 Bengal BN-60 Bobcat BI-60
Expert 24 Expert 24 LX Expert 52
Expert 52 LX Expert II 24 Expert II 24 LX
Expert II 52 Expert II 52 LX Expert Pro-132S
Expert Pro-60 i-Craft Jaguar II 101
Jaguar II 132 Jaguar II 61 Jaguar III 101
| Jaguar III 132 | Jaguar III 183 | Jaguar III 61 |
| Jaguar IV 101 | Jaguar IV 132 | Jaguar IV 183 |
| Jaguar IV 61 | Jaguar JG 101S | Jaguar JG 132S |
| Jaguar JG 61 | Jaguar JG 76S | Jaguar V 101 |
| Jaguar V 132 | Jaguar V 160 | Jaguar V 160 LX |
| Jaguar V 183 | Jaguar V 61 | Jaguar V LX 101 |
| Jaguar V LX 132 | Jaguar V LX 183 | Jaguar V LX 61 |
| Puma II 132 | Puma II 60 | Puma III 132 |
| Puma III 60 | Puma IV 132 | Puma IV 60 |
| Puma IV LX 132 | Puma IV LX 60 | Puma SP 132S |
| Puma SP 30 | Puma SP 60 | RX II-101S |
| RX II-132S | RX II-183S | RX II-61 |
| RX II-61-CR | RX-101S | RX-132S |
| RX-183S | Sable SB-60 |
| SignPal LYNX S-60 | Ultra GRC-101S | Ultra GRC-132S |
| Ultra GRC-50 | Ultra GRC-61 | Ultra GRC-76S |

**Gerber**
- EmbossTrack
  - Envision 375
  - Envision 750
- FasTrack
  - FasTrack 1300
  - FasTrack 550
- FasTrack 650
  - GS15
  - HS 15 / 750
- Odyssey
  - P2C 1200
  - P2C 1400
- P2C 1400 Tangential
  - P2C 1600
  - P2C 1600 Tangential
- P2C 600
  - Sprint/4B old
  - Sprint/4B Fastboard

**Grafityp**
- CSR
  - CSR Ecom 92
  - CSRTurboDMPL

**Graphtec**
- (HPGL) old
  - CE 1000-60 (HPGL)
  - CE 3000-120 (+USB)
  - CE 3000Mk2
- CE 3000-40 (+USB)
- CE 5000-120
  - CE 5000-60
  - CE 6000-60
- CE 6000-120
- Craft ROBO
  - Craft ROBO PRO II
  - FC Series (GPGL)
- FC4100-100 (HPGL)
  - FC4100-130 (HPGL)
  - FC4100-75 (HPGL)
- FC5100-100 (HPGL)
  - FC5100-130 (HPGL)
  - FC5100-75 (HPGL)
- FC7000-100
  - FC7000-130
  - FC7000-160
- FC7000-60
  - FC7000-75
  - FC8000-100
- FC8000-130
  - FC8000-160
  - FC8000-60
- FC8000-75
  - FC8600-100
  - FC8600-130
- FC8600-160
  - FC8600-60
  - FC8600-75
- JX 1060 (HPGL)
  - JX 1130 (HPGL)
  - w/o perforation old

**Helo**
- HSP 1360
- HSP 360
- HSP 720
Hengxing
Rabbit HX-1000  Rabbit HX-1120  Rabbit HX-1360
Rabbit HX-630  Rabbit HX-720   Rabbit HX-800
Rabbit HX-960

HobbyCut
ABH-1351  ABH-361  ABH-721

Houston
100C DMPL  69C DMPL

HP
Latex 54  Latex 54B  Latex 64

Ioline
Ioline  Artpro 3500  Artpro 3700
Artpro 4000  Classic  Signmaker 5000
SmarTrac I/S 110  SmarTrac I/S 130  SmarTrac I/S 60
SmarTrac I/S 85  Studio 7  Studio 8
Super 88

Jiachen
JC-1100DS  JC-1100E  JC-1100H
JC-1350DS  JC-1350E  JC-1350H
JC-720DS  JC-720E  JC-850DS
JC-850E  JC-850H

Kimoto
Freecut 130  Freecut 150  Freecut 60
Freecut 75

LG Palopoli
MLP-24

Liyu
HC 1201  HC 751  HC 901
MC 631  MC 801  SC 1261
SC 631  SC 801

Master
XP-300P  XP-380P  XP-450P
XP-540P  XP-660P

Masterplot
Masterplot

MAX
CM-200
<table>
<thead>
<tr>
<th>Mimaki</th>
</tr>
</thead>
<tbody>
<tr>
<td>CG-100</td>
</tr>
<tr>
<td>CG-100EX</td>
</tr>
<tr>
<td>CG-100Lx</td>
</tr>
<tr>
<td>CG-100SR II</td>
</tr>
<tr>
<td>CG-100SR III</td>
</tr>
<tr>
<td>CG-12</td>
</tr>
<tr>
<td>CG-121</td>
</tr>
<tr>
<td>CG-130 FX II</td>
</tr>
<tr>
<td>CG-130FX</td>
</tr>
<tr>
<td>CG-130Lx</td>
</tr>
<tr>
<td>CG-130SR II</td>
</tr>
<tr>
<td>CG-130SR III</td>
</tr>
<tr>
<td>CG-160 FX II</td>
</tr>
<tr>
<td>CG-160 FX II</td>
</tr>
<tr>
<td>CG-45</td>
</tr>
<tr>
<td>CG-5</td>
</tr>
<tr>
<td>CG-50</td>
</tr>
<tr>
<td>CG-51</td>
</tr>
<tr>
<td>CG-6</td>
</tr>
<tr>
<td>CG-60EX</td>
</tr>
<tr>
<td>CG-60i</td>
</tr>
<tr>
<td>CG-60SR</td>
</tr>
<tr>
<td>CG-60SR II</td>
</tr>
<tr>
<td>CG-60SR III</td>
</tr>
<tr>
<td>CG-61</td>
</tr>
<tr>
<td>CG-75 FX</td>
</tr>
<tr>
<td>CG-75 FX II</td>
</tr>
<tr>
<td>CG-9</td>
</tr>
<tr>
<td>CG-90i</td>
</tr>
<tr>
<td>CG-90SD</td>
</tr>
<tr>
<td>CJV-30-100</td>
</tr>
<tr>
<td>CJV-30-130</td>
</tr>
<tr>
<td>CJV-30SD</td>
</tr>
<tr>
<td>MY CUT</td>
</tr>
<tr>
<td>ME 500</td>
</tr>
<tr>
<td>ME 650</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mutoh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Junior 24</td>
</tr>
<tr>
<td>Kona 1400</td>
</tr>
<tr>
<td>Kona 1650</td>
</tr>
<tr>
<td>Kona 760</td>
</tr>
<tr>
<td>MC-1000</td>
</tr>
<tr>
<td>MC-1000S</td>
</tr>
<tr>
<td>MC-1300</td>
</tr>
<tr>
<td>MC-1300S</td>
</tr>
<tr>
<td>MC-650S</td>
</tr>
<tr>
<td>MC-750S</td>
</tr>
<tr>
<td>SC Series</td>
</tr>
<tr>
<td>SC-1000E</td>
</tr>
<tr>
<td>SC-1300E</td>
</tr>
<tr>
<td>SC-650E</td>
</tr>
<tr>
<td>SC-750E</td>
</tr>
<tr>
<td>TC-1300</td>
</tr>
<tr>
<td>TC-650</td>
</tr>
<tr>
<td>TC-750</td>
</tr>
<tr>
<td>Ultima SC 1400D</td>
</tr>
<tr>
<td>ValueCut VC-1300</td>
</tr>
<tr>
<td>ValueCut VC-1800</td>
</tr>
<tr>
<td>ValueCut VC-600</td>
</tr>
<tr>
<td>XP-1251C</td>
</tr>
<tr>
<td>XP-521C</td>
</tr>
<tr>
<td>XP-621C</td>
</tr>
<tr>
<td>XP-941C</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>New Star</th>
</tr>
</thead>
<tbody>
<tr>
<td>Omega OM-100</td>
</tr>
<tr>
<td>Omega OM-130</td>
</tr>
<tr>
<td>Omega OM-150</td>
</tr>
<tr>
<td>Omega OM-40</td>
</tr>
<tr>
<td>Omega OM-60</td>
</tr>
<tr>
<td>Omega OM-70</td>
</tr>
<tr>
<td>Omega OM-80</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ORXYZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elite</td>
</tr>
<tr>
<td>HX-Series</td>
</tr>
<tr>
<td>JML-Series</td>
</tr>
<tr>
<td>LX-Series</td>
</tr>
<tr>
<td>OR-Series</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pericut</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
</tr>
<tr>
<td>1000/1300 IT (Transfer)</td>
</tr>
<tr>
<td>1300</td>
</tr>
<tr>
<td>901</td>
</tr>
<tr>
<td>901/1000/1300</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PERITEC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000/1200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Redsail</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS1120C</td>
</tr>
<tr>
<td>RS1360C</td>
</tr>
<tr>
<td>RS720C</td>
</tr>
<tr>
<td>RS800C</td>
</tr>
</tbody>
</table>
# A Driver List

## Refine
- EH-1101
- EH-1351
- EH-721
- EH-871
- MH-1101
- MH-1351
- MH-721
- MH-871

## Roland
- CJ-500
- CM 300
- CX 12
- CX-400
- GR-420
- GS-24
- GX-400
- PC 50
- PNC 1100
- PNC 1410
- PNC 1860
- PNC 2700
- PNC 910
- SP-300 (USB)
- SP-540

## Secabo
- C120
- C60
- C60 II
- C40
- S120
- S60
- S160

## Seiki Tech
- SK-1100H
- SK-1350T
- SK-850H
- SK-1100T
- SK-720H
- SK-850T
- SK-720T

## Silhouette
- Cameo

## Summa
- S-Class 2 S120 D
- S-Class 2 S140 D
- S-Class 2 S160 D
- S-Class 2 S75 D
- S-Class S120 D
- S-Class S140 D
- S-Class S160 D
- S-Class S75 D
- SummaCut D1020
- SummaCut D1220
- SummaCut D15
- SummaCut D520
- SummaCut D60R FX
- SummaCut D760
- SummaCut D120 D
- SummaCut D140
- SummaCut D160R
- SummaCut D60 / D60 SE
- SummaCut D620
- SummaCut D75R
- SummaSign Pro D-Series
- SummaSign Pro D1010

---

252
| SummaSign Pro D1300 | SummaSign Pro D1400 | SummaSign Pro D1600 SL |
| SummaSign Pro D610 | SummaSign Pro D750 | SummaSign Pro T 750 |
| SummaSign Pro T-Series | SummaSign Pro T1010 | SummaSign Pro T1300 |
| SummaSign Pro T610 | SummaSign T 1400 Pro | SummaSign T 1600 Pro SL |
| SummaSign T1010A | SummaSign T600 |

**Summagraphics**
- D1000
- T1000

**Technoplot**
- Millennium T 610 Pro
- Millennium T 750 Pro

**Universal Drivers**
- DMPL 0.025
- HPGL 0.01
- HPGL 0.025
- HPGL 0.05
- HPGL/2

**USCutter**
- MH-1101
- MH-1351
- MH-721

**Vinyl Express**
- Bobcat
- Lynx
- Panther I 24
- Panther I 30
- Panther I 40
- Panther I 50
- Panther II 24
- Panther II 30
- Panther II 40
- Panther III 24
- Panther III 30
- Panther III 40
- Panther III 50
- Puma I
- Puma II
- Q Series 100
- Q Series 120
- Q Series 130
- Q Series 24
- Q Series 30
- Q Series 42
- Q Series 54
- Q Series 60
- Q Series 64
- Q Series 75
- Qe60
- Qe60+
- R Series 19
- R Series 24
- R Series 31
- R Series 39
- R Series 44
- R Series 53
- ULTRA 24
- ULTRA 50
- ULTRA 30

**VyTek**
- GEM40
- GEM54
# B Dictionary of Technical Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active and Passive Jobs</strong></td>
<td>Active jobs are those that are being cut. Passive jobs are waiting in the queue for output.</td>
</tr>
<tr>
<td><strong>Additional Programs</strong></td>
<td>Additional programs are program modules or stand-alone programs that are part of the delivery.</td>
</tr>
<tr>
<td><strong>Auto Import Plug-Ins</strong></td>
<td>Auto import plug-ins are used to automatically import data from other programs - without intermediate steps.</td>
</tr>
<tr>
<td><strong>Automatic Contour Pen Conversion</strong></td>
<td>This feature means that before the data is transferred the software 'looks' for objects with the attribute 'contour'. If so, the user can decide whether the contour is to be converted or not. If the contour should be converted, then a vector object with the width of the contour is automatically generated!</td>
</tr>
<tr>
<td><strong>Bitmap Functions</strong></td>
<td>Bitmaps are pixel images or photos. Bitmap functions means all functions which are not vector tools like node editing, and which are only applicable on bitmaps.</td>
</tr>
<tr>
<td><strong>By Color</strong></td>
<td>This is a welding function, which deletes all surfaces, which are covered by overlying colors.</td>
</tr>
<tr>
<td><strong>Bypass Cutting</strong></td>
<td>Direct cutting - without window - before output on the cutter.</td>
</tr>
<tr>
<td><strong>CMX Data Transfer</strong></td>
<td>CMX data transfer means the handing over of data using CorelDRAW's CMX data format. CorelDRAW had created this format in order to ensure the exchange of data within the Corel program families. CMX is a public data format and is used for the exchange of data. This has the advantage compared to EPS, that Corel specific types of data can be copied 1:1, without making a conversion of the format.</td>
</tr>
<tr>
<td><strong>Cap Height Setting</strong></td>
<td>Cap height is the typographical correct unit of capital letters. The text editor uses this unit by default when calculating the font size.</td>
</tr>
<tr>
<td><strong>Circular Text</strong></td>
<td>Is a special feature of the text editor with that text blocks can be placed on or in a circle.</td>
</tr>
<tr>
<td><strong>Clipart Tab</strong></td>
<td>Cliparts are job-similar files - often logos or patterns - which are useful for the design of an output job. The clipart tab is a sub-tab of the Sidebar, with that the cliparts can be managed.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Clone</td>
<td>This function is usually used when creating labels and series. Changes at the control object are transferred to all clone objects.</td>
</tr>
<tr>
<td>Close Objects (Automatically)</td>
<td>When importing DXF or HPGL data, many or all objects are not closed. On a cutter only closed objects can be processed reasonable. This function will automatically close all vector objects. In the basic settings the threshold for the closing of objects can be changed.</td>
</tr>
<tr>
<td>Contour Line (Print &amp; Cut)</td>
<td>Unlike the outline / inline bitmaps are here provided with a vector contour. This function is regularly needed in the creation of labels and stickers.</td>
</tr>
<tr>
<td>Create / Edit Text Block</td>
<td>Text blocks are blocks of text that can be used more frequently because they appear identical or similar in many jobs - such as your address. With the PhraseWriter arbitrary blocks of text can be created and modified as needed.</td>
</tr>
<tr>
<td>Cut Out Region</td>
<td>Is a bitmap function which provides the tracing of parts of a bitmap. You can cut out any vector form out of a bitmap.</td>
</tr>
<tr>
<td>Device Control</td>
<td>This section deals with device control functions on the output side.</td>
</tr>
<tr>
<td>Digitize Mode</td>
<td>This feature means a drawing tool, that similar to digitizing tablet with a magnifier, draws nodes on the working sheet.</td>
</tr>
<tr>
<td>Dongle Protection</td>
<td>A dongle is a hardware copy protection that is stuck on the USB port of the computer to make run the software. The dongle protects producers against unauthorized copying of its software and at the same time it protects the investment of the buyer, since its competitors do not get the software free of charge. Thus from dongle protection both sides benefit - producers and buyers.</td>
</tr>
<tr>
<td>Drill Holes</td>
<td>Drill holes is a special drawing tool, that marks the position of a drill hole, using a crosshair cursor. If the connected machine is capable of producing drill holes, then the position is transmitted to the device driver.</td>
</tr>
</tbody>
</table>
Files Tab
Is a sub-element of the Sidebar, with that Jobs can be managed. Job is the file extension, which is used from EuroCUT.

Flatbed Cutter
All cutters that have a flatbed as a cutting surface.

Folder Monitoring
This function means that the software monitors a selected folder on hard disk or network. Every time when a change in the monitored folder occurs - by saving or deleting of jobs - the thumbnail gets updated.

Fontmanager
The Fontmanager manages fonts in databases. The advantage of this method is that the database can be copied from one computer to another and thus the same set of fonts is available on both computers.

Full Surface
Is a welding function, which underfills objects in one color, whose surfaces overlap another. The partially hidden objects are treated in a way, that they are underlaying all overlying objects.

Hatching
In this milling method the area, which should be removed, is provided with a hatching. The area gets removed along the hatching using the milling tool.

Hotfolder Management
A folder can be defined as a so-called hot folder. All output jobs that are stored in this directory are supplied to the output.

Job Calculation
The Job Calculation means a function with that preliminary costing can be done easily. This function is particularly well suited for calculating charges of material costs.

Job Info
The Job Info can - referring to each job - save additional information such as order number, customer address, material, time spent, a. s. o..

Job Rerun
Any job that is still in the job history can be cut again identically. The actual to the machine transmitted data is stored. All parameters are given out into the output file.

Laser Engraver
Name for all devices which don't use an engraving needle but a laser unit.

Layer Tab
Is a sub-element of the Sidebar, with that layers can be managed. Layers are color levels which determine and
control output order and tool parameters - besides object position.

**Material Display**
Each color layer can be assigned a specific material with an exact material description. The assigned material is displayed before the output in the Job Calculation, Job Info and the layer itself.

**Milling & Engraving**
This rubric lists the specific functions and tools which were implemented for milling and engraving.

**Monitor Output Process**
With monitoring, we mean that the output process can be suspended, stopped and continued. Active jobs can be switched to passive and if necessary be re-activated.

**Multi Inline**
In this milling method the area, which should be removed, is provided with multiple Inlines. The area gets removed along the inlines - from outside to inside.

**Multi Port Support**
With this we mean that all ports on a given computer - which are suitable for the issue - can be used. Typically, these are all COM and USB ports.

**Multi User Versions Available**
For every main license multi-user version can be purchased. The additional versions here have the same serial number as the main license.

**Multi-functional Cutter**
Multi-functional cutters are devices which can use various tool heads beside a cutting tool head. They are, for example, oscillating knives, spindles, and hemming tools.

**Multiple Cutting**
Option to cut easier thick and resistant materials

**Node Editing**
Main tool for the creation and editing of vector objects.

**Objects Tab**
Is an sub-element of the Sidebar with that objects can be managed. A large number of object attributes such as visible / invisible, do not output, do not print, can be individually defined for each object.

**Open Trimming**
Is a welding function, which creates open vector objects, after they were separated at their intersections.

**Optimization**
Targets of the optimization are: diminishing of rejection rate, material saving, time saving, optimization and shortening of job preparation. The optimizing of objects can be done on the working sheet or in the output.
preview. The objects are sorted so that the material consumption, without nesting of objects, is minimized.

Outline / Inline
Outline is a special function, where vector object is contoured automatically with a contour in a predefined distance. In contrast to the contour line, the outline creates - in case of internal objects - so called Inlines.

Parallel Device Output
This function can simultaneously provide data on multiple machines, which are connected to a computer, if sufficient computing power on the PC is given.

PhotoCUT
PhotoCUT is a program module which can convert halftone drafts into vector stripes. The so generated vector stripes can be cutted on each usual cutting plotter and, generate - with the appropriate viewing distance - one photo-like effect.

PhraseWriter
The PhraseWriter is a program module for the management and use of text blocks. It is automatically started at startup and is accessible at any time using the right mouse button context menu. The specified text block is selected and then inserted and displayed on the desktop.

Plot Manager
The Plot Manager is a separate program module, which 'background' controls and monitors the output of the data on the selected device.

Plot Server Function (TCP/IP)
A computer at which multiple output devices are connected can act as a plot server. The data transfer can take place via the network using TCP / IP. Assuming the appropriate licenses, any number of client computers can give out on the plot server devices.

Plot to File
The output of the plot data can be redirected to a file. The user only has to activate the appropriate option in the output dialog.

Posterize
Posterize is a bitmap function which performs a reduction on any number of color hues per color layer.

Preview *.CDR and *.CMX
The files tab can display besides *.JOB also contents of *.CDR and *.CMX files (CorelDRAW formats).

Productivity Tools
Productivity tools are special tools, which - because of their workings - enhance the productivity of sign making processes. These are usually such tools, which distinguish a cutting software from illustration programs.
such as Illustrator and CorelDRAW.

**Program Type**

This section summarizes certain criteria which characterize the use of the program.

**Reference Job (*.JRF)**

In a so-called Reference Job the environment, the tool parameters and the device drivers are stored. In this way, it is possible to output the job in an identical manner as many times as wished.

**Register Mark**

Is a special drawing tool, with that marks, for the making of multi-colored foil signages, are drawn. This register marks can consist of a cut-through or a filled square and are positioned by the user to the desired position on the output job. While the output these registration marks are always cutted at the same position on the vinyl (layer independently), so then the precise assembly of various colors is possible.

**Roll Cutter**

Roll cutter means all cutting plotters, which can only handle material rolls.

**Screen Printing**

Is a welding function, which allows the changing of the color stack. Thus, the order of the colored vinyls can be re-sorted - interactively - from light to dark.

**Segmentation with Overlap**

Segmentation is always necessary when the job is larger i.e. longer or wider than the connected device is able to plot. The overlap is necessary when the individual segments are to be completed to a whole again. Joining otherwise would lead to undesired white gaps.

**Sidebar**

Sidebar means a movable control element that can be made visible on the desktop. The individual sub-elements are activated by clicking so-called ‘tabs’.

**Sort with Simulation**

In this function, all objects are sorted according to a certain criterion. For some output devices such as lasers or milling machines the sequential processing of the objects is important. Therefore, the output can be simulated and the collation can be adapted to the requirements of the output device.

**Space (1/1, 1/2, 1/4, 1/8)**

Special function with that micro-typographical-correct spaces (keyword: em quad) and thus word / letter spacing can be generated. These special spaces can be directly entered via the keyboard.
**Spool Function**

When the Plot Manager is activated with the parameter !SPOOL!, it runs independently without starting the main program. Output data can be activated and given out via Drag & Drop.

**Spot Colors Definable**

Spot colors are color layers, which are defined in a way that color values are additionally given out. Some hybrid devices and RIPs use spot color values for the control of output processes. When printing the corresponding color plates are given out.

**Stacking**

Stacking means that at first as many objects are positioned adjacent as will fit on the material. The following objects are then positioned above it. This process is repeated until all objects are positioned on the material.

**Stand-alone Software**

"Stand-alone" means that this program can be used without any other so-called host program. It has all the tools that are needed for the design, layout, and the output of jobs.

**Start Tool Paths**

When milling and laser engraving it often happens that immersion traces are visible at the start point of an object. To ensure that the quality of the objects which are milled is not affected, the start point can be laid outside the object. This task is performed by so-called start tool paths.

**Status Display Material Consumption**

In the output preview at the bottom of the window is a status line where the material consumption of the job is displayed in square meters. Since this happens before the output, this feature can also be used to order exactly as much of a material as is required currently for the job.

**Symmetrical Object**

This is a tool that can create stars and polygons. With it the initial shape (circle, ellipse) and the number of edges can be specified. With its own drawing tool then the symmetric objects on the desktop are drawn.

**Templates (*.JTP)**

Templates or patterns are jobs which have no name (untitled) when opened. Templates can always be created if they can serve as an example for other similar jobs. The advantage is that the working sheet and layout are predefined.

**Test Run**

Before the actual output a so-called test drive can be carried out to examine whether, for example, the material
is sufficient. During the test run the raised tool head moves along the vectors.

**Text Editor**

Text editor means program functions that include all the tools necessary for professional capturing and editing texts. Typographic special tools that are essential for signmaking were implemented.

**Text Import (*.TXT, *.RTF, *.ECT)**

External texts can be imported directly into the so-called text box, with the above formats being used. For formatted text the RTF format must be used. It can be saved from every professional word processing program.

**Thumbnail Preview**

Thumbnails are small low-resolution pixel previews of file contents. All in the selected folder located files will be - by means of the thumbnail preview - visible and manageable.

**Tool Parametrization**

Means that specific settings for a tool can be done by the user. This can be values for speed, drive, depth, angle, pressure, acceleration or other parameters. The device driver provides the parameter fields. The user can edit corresponding parameter values before the output on the device.

**Tool Assignment**

To each color layer a specific tool can be assigned. This makes creation and processing of jobs much easier. The selected device driver provides all possible tools. The assignment itself can be done by the user individually.

**Track Logging**

For each tool the distance will be recorded. In addition, the date, time and device names are stored.

**Trimming**

Is a welding function, which separates closed vector objects using lines or curves. The resulting partial objects are re-closed then automatically.

**TrueType, OpenType, Type 1, BE Fonts**

These 4 font formats can be managed with the Fontmanager i. e. add, enable and disable.

**URW BE Fonts**

The BE-type format was created by the company URW. The BE-format is a vector font format that was shipped with SIGNUS systems.

**Vectorization, Tracing**

Vectorization means the conversion of bitmaps (pixel images) to vector contours.

**Video Marks (Print & Cut)**

Video marks are marks that can be detected by cutters with optical sensors or cameras to compensate for
inaccuracies of the print result. In the print and cut process they are used also for the contouring of print objects.

**Wait After Segment**
If a job has to be segmented, then the user receives this option with the ability to re-equip the machine before the next segment is processed. By means of a message window the process can be continued at any time.

**Weed-Ex Driver Option**
It is a specially laminated flex or flock material of Witpac GmbH. First, the actual vector lines are cut. In the second step, the components that need to be weeded, are cut out in a way, that they 'fall out' automatically at the end. So you have already reached the entire plot result after peeling off the medium and you don't have to weed manually.

**Weeding Lines horiz. / vert.**
In addition to the global weeding frame, which is generated around the entire output job, individual weeding lines can be added horizontally or vertically in the output preview. Large, bulky jobs can thus be divided.

**Welding**
Welding functions are needed for the treatment of overlapping of layers or vinyls. These functions are in the signmaking and screen printing department essential for the processing of vinyls.
**C Glossary**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additive color system</td>
<td>The ~ is based on mixing the additive, luminous spectral colors red, green and blue (RGB), for example in color TVs or color monitors.</td>
</tr>
<tr>
<td>Adjustment</td>
<td>Modification of the distance between two adjacent characters so that a harmonic type face is being created. This is reached by correcting the character - or word distance. With distances below 100% you speak of kerning and with values above 100% of spacing out.</td>
</tr>
<tr>
<td>Adjustment handles</td>
<td>~ are the 9 black squares that are drawn around the object and in the middle when marking objects.</td>
</tr>
<tr>
<td>Antialiasing</td>
<td>Edge smoothing with bitmaps</td>
</tr>
<tr>
<td>Application tape</td>
<td>Foil that is used to apply the cut foil after the weeding on the lettering area. The adhesive force must be strong enough so that the text - even the tiniest letters - can be released from the substrate without problems. After application, the ~ must also be released without problems.</td>
</tr>
<tr>
<td>Ascender</td>
<td>Term for the part of a character that extends above the middle length.</td>
</tr>
<tr>
<td>Backup</td>
<td>Data backup</td>
</tr>
</tbody>
</table>
| Bit-depth also shade          | ~ is the mathematically possible number of colors with a specific number of bits, for example:  

| 1 bit color depth = 2^1 = 2 possible colors (black/white)  
| 8 bit color depth = 2^8 = 256 possible colors/shades of gray  
| 24 bit color depth = 2^24 = 16.8 millions possible colors |
| Bitmap                        | Pixel-graphic                                                            |
| Bold                          | Font that a bit thicker than the standard typeface.                      |
| Byte                          | Smallest addressable unit in the computer memory, consisting of 8 bits.  |
| Calibration                   | Adaptation of printer, monitor, cutter or adaptation to desired values.  |
| Cap height                    | This is the height of the capital letters, the capitals. As measurement usually the height of the letter „H“ from the font line to the top edge of the character is used. |
| Center justification          | A break justification where the text block is justified at the same time on the left and on the right side. To do this, the word space within a text line is varied (usually extended) so that on |

263
the left and right side a clean text edge is created. This is not only applied for the the last line of a break.
compare also: forced block

Clipart(s) ~ are jobs or job parts that were added to the Clipart toolbar. They are saved in a separate directory. (C:\Program Files\Stone Cut\Stone Cut 2\CLIP)

Clipboard ~ is used for temporary storage in Windows. The ~ is used to exchange data fast between applications.

CMYK Cyan, magenta, yellow, contrast (key, black) Standard colors for the four-color printing.

CMYK-color area ~ is the total number of colors that can be displayed by the colors used when printing (CMYK).

Color depth ~ is the number of possible color tones that can be recognized by a scanner or reproduced on a color monitor.

Container A container - more exactly an image or text container - is a vector object, that similar to a real container can take up arbitrary image data or texts. In conjunction with macro scripts contents can be exchanged semi-automatically or automatically.

Context menu Context menus are called so because the structure adapts and changes depending on the number and type of the selected objects (context). Context menus are always activated with the right mouse button. They serve for the faster access to important functions and tools and also to those functions that cannot be activated via the main menu.

Contrast Contrast; range of brightness between bright and dark parts of a picture.

Cursor ~ is the blinking, vertical line in an editable field.

Decoration Accentuation of text parts by modification of the text attributes, for example bold, italic.

Descender This is the part of a character that protrudes below the font line.

Desktop The area besides the working surface that can be used for the draft. It is comparable to a desk on which are the tools.

Digitalization Conversion of a picture template into a digital form. The capture is done point for point or line by line by means of a digitalization tablet or by reading the template with a scanner.

Dongle
Means the copyright that is part of the scope of delivery of Stone Cut 2. It is inserted in the USB interface of your computer. Without it the software cannot be started.

**Download**

Downloading applications or files from the internet to your computer.

**DPI**

Acronym for Dots Per Inch; resolution fineness (1 inch = 2.54 cm)

**EPS**

Acronym for Encapsulated Postscript Format. In this file format the text and picture information is saved in the page description language postscript. This format also contains besides text and raster data also a preview bitmap which allows displaying a copy of the data on the screen.

**Foil**

Two production processes are common: calendaring and casting. Cast foil is created without drawing frame and thus has a lesser shrinking tendency. The costs are usually higher than with calendared foil. Calendared is cheaper, has a shorter period of usage and shrinks more.

Cutting foils are built in three layers:
1. Substrate; the lowest layer
2. Gluten layer; is between the foil and the substrate
3. the foil itself.

**Font**

Type cut within a type face in digital form. Most type faces have the fonts normal, bold, italic and bold-italic. Often, the font is used for the same type face. Correct would be that each cut is a separate font.

**Font line**

is a thought line on which the characters of a row are standing. Even if different font types and font sizes are used in a row, all characters must stand on a common font line.

**Font size**

is the size of a font. It corresponds to the block height, which means it also comprises the ascender and descender as well as a certain space above and below the characters.

**Forced justification**

Justification where all text lines - also the last- are adapted to the width of the column or the working area. In Stone Cut 2 this justification is called „force justification”.

**Gamma correction**

The is a method for the correction of color graduation considering the perception of the human eye if there are two adjoining areas of different color.

**Group**

Combination of arbitrarily many objects to a group. The position of the objects itself does not change any more within the group.
Halftone image(s) ~ are pictures which contain shades of gray or hues. The tonal value between pure white and pure black is called halftone.

Hotfolder A Hotfolder is a directory monitored by the Plot-Manager. If a file is copied into this directory, the Plot-Manager carries out automatically specific configurable functions.

Inch Measurement unit for the length
1 Inch = 2.54 cm

Job File-ending of Stone Cut 2; name for Stone Cut 2 file

Justification Alignment of a text block on the working area. Stone Cut 2 offers justification left-aligned, right-aligned, centered, center justification, forced center justification and adjust cap height.

Kerning If two characters stand closer together than it would correspond to their standard thickness, you speak of ~. With character combinations as for example „Te“ you have a balanced type face.

Laminating Covering with transparent plastic films.

Live-Update Updating of software via the internet.

Macro A ~ automates program flows. The automation can thereby be realized with the program's own commands or a macro language.

Marking function ~ means marking objects by keeping pressed the left mouse button, then drawing a frame around the objects to be marked and letting go the mouse button only if all objects to be marked are completely within the frame.

Process colors Printing scale of colors for four-color-printing with cyan, yellow, magenta and black (key). By mixing these colors, it is possible to print all colors.

Profile The appearance of program surfaces is called ~. The shown tools and menu items can be individually adjusted to the user. Intention is to simplify the user interface.

Raster Image Processor short: RIP - Software that rasterizes vector data and controls the printing on a large format printer.

Resolution Number of pixels per track unit. It is indicated in dpi (dots per inch). Laser printers have a resolution from 600 to 1200 dpi.

Scan resolution Fineness of the resolution when scanning analogue images

**Formula:**
Resolution (in DPI) = printing length (L/cm) x 2 (quality factor) x 266
<table>
<thead>
<tr>
<th><strong>enlargement factor x 2.54</strong> (when converting from cm into inch)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subsidiary line</strong></td>
</tr>
<tr>
<td><strong>Superscript</strong></td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
</tr>
<tr>
<td><strong>Trapping</strong></td>
</tr>
<tr>
<td><strong>Upload</strong></td>
</tr>
<tr>
<td><strong>Weeding</strong></td>
</tr>
<tr>
<td><strong>White gaps</strong></td>
</tr>
<tr>
<td><strong>x-height</strong></td>
</tr>
</tbody>
</table>
Index

A
Access rights  50, 51
Active Jobs  118, 137, 179, 180, 181, 182, 185, 254, 257
Align  81, 143, 144, 160
Always print black  67
Attributes tab  212
Auto import plug-ins  254
AutoCAD  1, 19
Automatic welding  157, 169
Automation  266
Autosave  73

B
Backup  1, 263
Block shadow  146
BMP  27, 48, 86, 187
Break combination  81
Break group  80
Brightness  264

C
Cap height  254, 263, 266
CDR  100, 101, 102, 104, 258
CDT  101
Character spacing  169
Circular Text 123, 254
Clipart 82, 125, 195, 215, 216, 217, 218, 219, 220, 221, 222, 223, 254, 264
Clipart group 82, 215, 218, 219, 220
Clipart tab 82, 254
Clockwise 161, 162, 165
Clone 80, 122, 123, 124, 130, 148, 255
Close objects 98, 146, 162
CMX 16, 48, 101, 254, 258
CMYK 107, 203, 264
Color graduation 38, 124, 265
Color palette 96, 107, 108, 200
Combine 80, 81, 97, 124, 142, 146
Contour cutting 213
Contour line 5, 51, 53, 54, 86, 123, 146, 155, 156, 157, 172, 173, 174, 255, 258
Contour pen 86, 254
Contrast 188, 193, 258, 264
CorelDRAW 1, 3, 5, 14, 16, 20, 21, 195, 254, 258, 259
CoRUN 19, 20, 21, 119, 137, 138
Counterclockwise 161, 162, 165
Cut region 123

Delete nodes 142
Device driver 21, 22, 31, 37, 38, 94, 201, 245, 255, 261
Device Options 185
Device Options 185
Digitize mode 122, 255
Dimensioning 153
Drag & Drop 215, 218, 260
Drill holes 5, 211, 213, 231, 255
Driver 17, 21, 22, 25, 30, 31, 33, 35, 36, 37, 38, 40, 43, 44, 65, 92, 93, 94, 134, 135, 149, 162, 178, 184, 201, 204, 240, 242, 243, 245, 247, 255, 261, 262
Duplicate 79, 80, 89, 98
DXF 27, 102, 255

E
EMF 27
Encrypt document 50
EPS 48, 99, 205, 243, 244, 254, 265

F
File formats 74, 94, 95, 126
Files tab 256
Fills 21
Foil optimization 56, 57, 61, 133, 134, 146
Font size 245, 254, 265, 267
Fontmanager 256, 261
Forward one 84
Freehand 1, 19, 122, 243, 244
Full surface 51, 53, 54, 170, 171, 174, 231, 256

G
Gamma correction 265
GIF 27
Gradient fill 231

Grid 110, 111, 115, 139

Grouping 56, 80, 84, 153

GTP 27, 102

Hairline 53, 124, 244

Hatch 5, 123, 234

Hatching 256

Horizontal mirror 79, 133, 146

Hot folder 256

HPGL 27, 48, 102, 245, 249, 253, 255

HSB 203

IK 27

Illustrator 1, 14, 15, 19, 21, 243, 244, 259

Import 5, 21, 27, 28, 29, 94, 95, 96, 98, 97, 99, 100, 101, 102, 103, 124, 126, 139, 219, 243, 254, 261

Import filter 29, 94, 95, 99, 100, 101, 102, 103

Inline 52, 86, 155, 255, 257, 258

Inner circle 173

Insert program 75

Invert 207

Invisible 77, 111, 113, 115, 121, 201, 213, 257
J
Job info 73, 77, 139, 175, 256
Job-calculation 124
Join nodes 142
Justification 110, 263, 265, 266

K
Keep reference point 93
Kerning 263, 266

L
Laser 51, 127, 256, 260, 266
Last version 73
Local device 35, 38

M
Macro 5, 97, 99, 218, 225, 226, 227, 228, 229, 236, 264, 266
Macros 21, 97, 99, 195, 209, 211, 224, 225, 226, 229
Macros Tab 224, 225, 226
Magnifying glass 149, 150
Margins 25, 26
Mask bitmap 123
Material consumption 56, 257, 260
Maximum optimization 57
Measure 150, 242
Memo field 77, 175
Metric 100, 102, 110, 153
M
Milling 16, 24, 35, 55, 93, 109, 127, 142, 212, 213, 232, 256, 257, 259, 260

N
Navigator 206, 207
New origin 43, 93, 142
Node editing 80, 122, 123, 126, 140, 145, 254, 257
Node editing tool 80
Not visible 201, 204, 213
Number of copies 67, 156
Number of outputs 185, 231, 236

O
Object list 208, 209, 210, 211
Object names 211
Object preview 206
Object tree 209
Offset 42, 49, 78, 89, 110, 171, 173
Open Job 139
Open trimming 87, 168, 169, 257
OpenType 261
OPI 48
Optical sensor 14, 17
Optimization 56, 57, 60, 61, 133, 134, 146, 164, 165, 167, 257
Orientation 4, 25, 26, 65, 89, 110, 111, 114, 153, 162, 163, 165
Orthogonalize 144
Outline 16, 18, 19, 51, 52, 53, 86, 124, 155, 156, 157, 172, 255, 258
Output preview 41, 44, 55, 59, 122, 133, 134, 135, 138, 149, 162, 257, 260, 262
Overlap 61, 94, 169, 256, 259

P

Passive Jobs 179, 180, 181, 182, 254
Password Protection 50, 176
Password protection 50, 176
PCX 27, 48, 86, 187
PDF 16, 27, 28, 50, 102, 103
Pen thickness 38
PhotoCUT 86, 187, 193, 258
PhraseWriter 123, 255, 258
Plot Manager 36, 38, 44, 45, 74, 93, 178, 179, 183, 185, 212, 258, 260
Plot server 36, 38, 178, 258
Plot to file 42, 93, 180, 183, 186, 258
PLT 48, 184
Positioning 64, 80, 110, 114, 144, 154
Positioning assistance 110
Posterize 123, 258
Print & Cut 14, 53, 252, 255, 261
Print area 64, 70
Print to file 67
Producer 1, 213

Q

Queue 254
R

Read out 93, 245
Recalculate 122, 134
Rectangle 41, 207, 242
Redo 76, 90, 114, 124, 139, 158, 159
Redo 76, 90, 114, 124, 139, 158, 159
Reduce colors 123
Reduce nodes 82, 123, 126, 130, 141
Reference Job 259
Reference Point 42, 93, 110
Reference point 42, 93, 110
Refresh screen 85, 124, 125
Register mark 213, 259
Register marks 14, 45, 259
Registration marks 259
Relief 246
Revectorize 123
Reverse cutting 61
RGB 26, 107, 203, 263
Round edges 126, 131
Rounding 82, 131, 140, 141, 145, 156
Ruler 112, 113, 115, 120, 121, 242

S

Save as 74, 133, 181, 182, 183, 186, 200
Scan 75, 139, 266
Screen printing  61, 87, 168, 169, 170, 171, 259, 262
Segment  41, 42, 60, 61, 62, 93, 94, 122, 262
Segment optimization  60
Segmentation  42, 60, 61, 62, 259
Separate  59, 81, 97, 111, 258, 264, 265
Shades of gray  189, 266
Sharp node  141
Sharpen edges  126, 131
Smooth  3, 128, 141, 142, 145
Smooth curve  141, 142
Special characters  50
Spooler  37, 184
Spot color  16, 205
Stack  41, 45, 84, 93, 94, 158, 159, 170, 259
Stack distance  94
Stack processing  93
Stack spacing  94
Start tool paths  127, 146, 260
Step by Step  242
Subsidiary lines  67, 114, 115, 267
Superscript  267
Symmetric node  141
Symmetric node  141
Symmetric objects  260
T

Template 5, 46, 47, 61, 73, 96, 188, 190, 193, 264

Test drive 44, 135, 260

Text editor 123, 169, 254, 261

Text in curves 244

Thumbnail 216, 217, 219, 221, 256, 261

Thumbnails 220, 221, 261

TIF 27, 48, 86

Tiling 67, 69

To back 84

To front 83

Tool assignment 31, 33, 41, 93, 94

Tool parameters 259

Trim 168, 170

TrueType 261

Type 1 261

Typeface 263

U

Undo 76, 90, 114, 124, 139, 158, 159, 229

V

Vectorization 261

Vectorization 261

Vertical mirror 133, 146

Video marks 41, 98, 211, 261
W

Wait after segment  93
Weed border distance  41, 56
Weeding frame  44, 58, 59, 94, 122, 134, 135, 138, 262
Weeding lines  57, 58, 59, 122, 134, 135, 262
Welding  16, 17, 52, 53, 87, 157, 168, 169, 170, 254, 256, 257, 259, 261, 262
WMF  27

Z

Zoom functions  145